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Libero SoC Introduction

Welcome to Microsemi's Libero® SoC v11.7 SP1

Libero® System-on-Chip (SoC) is a comprehensive and powerful FPGA design and development software
available from Microsemi, providing start-to-finish design flow guidance and support for novice and
experienced users alike. Libero SoC combines Microsemi SoC Products Group tools with such EDA
powerhouses as Synplify Pro® and ModelSim®.

Libero SoC v11.7 SP1 includes enhancements to RTG4 timing data, and adds RTG4 Dynamic CCC
configuration support. In addition, the Lock Bit Configuration tool is introduced, enabling certain design
security use models.

Use Libero SoC v11.7 SP1 for designing with Microsemi's RTG4 Rad-Tolerant FPGAs, SmartFusion2 and
SmartFusion SoC FPGASs, and IGLOO2, IGLOO, ProASIC3, and Fusion FPGA families.

What's New in Libero SoC v11.7 SP1

HDL Language Mode Unification — HDL language mode selections have been centralized in Libero
SoC Project Settings.

Configure Register Lock Bits Tool — Allows users to protect the MSS/HPMS, FDDR, and SERDES
configurations for SmartFusion2 and IGLOO2 devices.

Synthesis Tcl Flow — Users can now specify advanced Synplify options in Libero SoC using the Synthesis
tool Configure Options dialog box. Libero passes the options in the Tcl file to Synplify Pro for processing.

RTG4 Dynamic CCC Solution — RTG4 devices now support dynamic configuration of the CCC, via a
dedicated APB interface.

RTG4 RAM Tie-off — Enhancements have been made to improve power in the radiation environment.
System Verilog Support — Libero can now process Verilog files that contain System Verilog constructs.
SET Mitigation — SET Mitigation per flipflop instance is supported for RTG4.

Enhanced Constraint Flow — A number of enhancements have been made for this release, including:

e SmartFusion2/IGLOO2 - CoreConfig/CoreReset constraint flow enhancements to improve timing
closure

e RTG4 EPCS constraint generation

e RTG4 XAUI constraint generation

e Encrypted VHDL flow support

e Constraint coverage reporting enhancements

More Information

e Libero — Learn more about Libero SoC including 11.7 SP1 Release Notes, a complete list of
devices/packages, and timing and power versions supported in this release.

e Programming — Learn more about Programming Solutions

e Power Calculators — Find XLS-based estimators for device families

e Development Kits — Learn more about development kits to accelerate your design

e Licensing — Learn more about Libero licensing

Libero SoC Design Flow (Enhanced Constraint Flow) - SmartFusion2, IGLOO2, RTG4

The Libero SoC Enhanced Constraint Design Flow is shown in the figure below.
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Figure 1 - Libero SoC Enhanced Constraint Design Flow for SmartFusion2, IGLOO2, and RTG4 Devices

The Libero SoC Place and Route button o enables you to proceed from Synthesis to Place and Route in
one click (using default settings).

Create Design
Create your design with any or all of the following design capture tools:
e System Builder
e Create SmartDesign
e Create HDL
e Create SmartDesign Testbench (optional, for simulation only)
e Create HDL Testbench (optional, for simulation only)
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After the design is created, click the o button, and the Libero SoC software executes the design flow
from Synthesis (for HDL flow) or Compile Netlist (for EDIF flow) through Place and Route with default
settings.

Constraint Manager

Create Design Constraints

SmartFusion2 I/O constraint PDC files are separate from Floorplan constraint PDC files. The I/O constraints
and Floorplan constraints must be in separate files.

e |/O Constraints - To add an I/O constraint, in the Design Flow window, double-click Manage
Constraints. Choose the I/O Attributes tab and click:

New — to create new I/O constraints in a *.pdc file.

Import — to import an 1/0O constraints into the project. The imported I/O constraints file is copied into the
project’s constraints folder.

Link — to create a link from the project to an existing 1/0 constraint file located and maintained outside the
Libero project.

New I/O constraint files have the *.pdc file extension and are stored in the
<project_location>\constraints\io folder.

e Timing Constraints — In the Constraint Manager, click Timing to add Timing SDC files into the project
New — to create new timing constraints in an *.sdc file.

Import — to import a timing constraint *.sdc file into the project. The imported timing constraint *.sdc file is
copied into the project’s constraints folder.

Link — to create a link from the project to an existing timing constraint *.sdc file located and maintained
outside the Libero project.

New timing constraint files have the *.sdc file extension and are stored in the
<project_location>\constraints folder.

e Floorplan Constraints — In the Constraint Manager, click Floor Planner to add Floorplanning *.pdc
files into the project.

New — to create new floorplanning constraints in a *.pdc file.

Import — to import a floorplanning constraint *.pdc file into the project. The imported floorplanning
constraint *.pdc file is copied into the <project_location>\constraints\fp folder.

Link — to create a link from the project to an existing floorplanning constraint *.pdc file located and
maintained outside the Libero project.

New floorplanning constraint files have the *.pdc file extension and are stored in the
<project_location>\constraints\fp folder.

e Netlist Attributes Constraints
New — to create new Netlist Attribute constraints file.

Import — to import a Netlist Attribute constraints file into the project. The imported Netlist Attribute file is
copied into the <project_location>\constraints folder.

Link — to create a link from the project to an existing Netlist Attribute constraint file located and maintained
outside the Libero project.

New Netlist Attributes constraint files have the *.fdc (for Synplify Netlist Constraint file) or *.ndc (for
Compile Netlist Constraint file) extension and are stored in the <project_location>\constraints folder.

Edit Constraints with the Constraint Manager

1/0 constraints, Timing Constraints, and Floorplanning Constraints are editable from the Constraint Manager
tabs.

Libero SoC User's Guide 9
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1/0 Constraints — From the Constraint Manager, click the 1/O Attributes tab. Click Edit with I/O Editor.
The 1/0 Editor opens and loads all I/O Constraint PDC files which you have associated with Place and
Route. Use the I/O Editor to view, sort, select, edit, change Output Load, lock and unlock assigned
attributes. When you make changes and save the changes in the 1/O Editor, the modified 1/O constraints are
written back to the original I/O Constraint PDC file(s).

Timing Constraints — From the Constraint Manager, click the Timing tab. From the pull-down menu, select
any one of the following to open and load the Timing Constraints Editor:

e Edit Synthesis Constraints — The Constraint Editor opens and loads the SDC Constraint file(s) you
have associated with Synthesis.

e Edit Place and Route Constraints — The Constraint Editor opens and loads the SDC Constraint
file(s) you have associated with Place and Route.

e Edit Timing Verifications Constraints — The Constraint Editor opens and loads the SDC Constraint
file(s) you have associated with Timing Verifications.

When you make changes and save the changes in the Constraint Editor, the modified constraints are written
back to the original SDC file(s).

Floorplan Constraints - From the Constraint Manager, click the Floor Planner tab. Click Edit with Floor
Planner. Chip Planner opens and loads the Floorplanning PDC constraint file(s) you have associated with
Place and Route. When you make and save changes in Chip Planner, the modified floorplanning PDC
constraint(s) are written back to the original floorplanning PDC file(s).

Implement

e Synthesize

Double-click Synthesize to run synthesis on your design with the default settings. The constraints
associated with Synthesis in the Constraint Manager are passed to Synplify.

¢ Place and Route
Place and Route takes the design constraints from the Constraint Manager and runs with default

settings. This is the last step in the push-button o design flow execution.

Program and Debug Design

Generate Bitstream

The design flow process initiated by the o button ends after Place and Route. Click Generate Bitstream
to generate the bitstream file for programming.

Programming

You do not have to open FlashPro or FlashPoint to program your SmartFusion2 device. All programming
functionality is available from within the Design Flow window, including:

Programming Connectivity and Interface - Organizes your programmer(s) and devices.

Programmer Settings - Opens your programmer settings; use if you wish to program using settings other
than default.

Device I/O States During Programming - Sets your device I/O states during programming; use if your
design requires that you change the default I/O states.

Security Policy Manager - Enables you to set your Secured Programming Use Model, User Key Entry and
Security Policies for your design.

See Also
Constraint Manager

New Project Wizard to import/link design constraints when creating new projects

10
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Enhanced Constraint Flow and Design Sources

The Enhanced Constraint Flow supports HDL and EDIF design sources. The Libero SoC Design Flow
window and the Constraint Manager are context-sensitive to the type of design sources: HDL or EDIF.

Enhanced Constraint Flow for HDL designs

When the design source is HDL, the Design Flow window displays Synthesis as a design step. The
Constraint Manager also makes available Synthesis as a target to receive timing constraints and netlist
attribute constraints. The options to promote or demote global resources of the chip are set in the Synthesis
options.

Enhanced Constraint Flow for EDIF designs

When the design source is EDIF/EDN, the Design Flow window displays Compile Netlist as a design step.
Timing constraints can be passed to Place and Route and Timing Verification only.

The options to promote or demote global resources of the chip are set in the Compile Netlist options.
The HDL flow versus the EDIF Flow is compared and contrasted below.

HDL Flow EDIF Flow
f 1
Dresign Flow Design Flow
1 countls -ﬂj
countls g Q I"T_ q (= > = G
Toal Toaol
* P Create Design + ¥ Create Design
+£ ¢ Constraints + F Constraints
» = P implament Design = ¥ Implament Dasign
v T Synthesire # B \erify Post-Synthesis iImplementation
& F Verity Post-Synthesls Implementation i’ Compile Netlist
« | Configure Flash*Freere e Configure Flash*Freeze
v % Place and Route ‘il Place and Route
= F Edit Constralnts # F Edit Constraints
= ¥k Verify Post Layoul lmplementation ¢ Werlfy Post Layout Implementation
# F Program and Debug Design + b Program and Debug Design
+ # Handoff Design for Production + ¥ Handoff Design for Production
+ ¥ Handofl Design for Firmware Development + ¥ Handoff Deslgn for Firmware Developmant
+ ¢ Handof Design for Debugging + F Handof Design for Debugging
Design Flow Window Design Flow Window
! 1
[ Ririeutes  Trmeng '\ Fioor Manner 1/ Wetis MirGules {0 Metributes  Trming '\ Fioar Parser \ Metiat Mirbubes |
Pirm Impoit Lk st with Constrmint Edibor :- Chick = | Derive Coratranis L mpo Link Eist with Consizaent Editor v]| Check fr
Symkhesis Pace and Foul Tming Verficabion Piace el Rpube Timing Visrificatiion
constraintiuser sdo | Target | o o P ey - -
P il cansirsskimy2 s =
Constraint Manager Constraint Manager
I 1
{10 Attriutes | Tirming |/ Fioor Panner | Netlist Actributes | {0 Attriwtes W Timing W Floor Manner ) Netlist Attrbtes |
New [v| Import Link Check |  Help Wew ||| Impert Link Check [ |  Heip
Check Synplify Netlist Constraint (FDC) Check Comapile Metlist Constraing (NDC)
constramtimynde. ndt Check Complle Netlist Constraint (NDC) tonstrankimynd ¥
Constraint Manager - Check *.fdc and *.ndc Constraint Manager - Check *.ndc only
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Microsemi License Utility

The Microsemi SoC Products Group LicenseTroubleshooting Guide answers the most common licensing-
related frequently asked questions.

The Microsemi License Utility enables you to check and update your license settings for the Libero SoC
software. It displays your current license settings, the license host-id for the current host, and allows you to
add a new license file to your settings.

To start the Microsemi License Utility, run it from Start > All Programs > Microsemi Libero SoC vx.xx>
Microsemi License Utility.

To request a license, click Request License to go to the Microsemi license website. You can select and
copy (right-click, Copy) the disk volume value displayed in the window and paste the value into the
Microsemi license web form.

When you have received your license file, follow the instructions and save the license to your local disk. In
the Microsemi License Utility window, click Add License File and browse/select the license file from your
disk. If you are using a floating license, click Add License Server and enter the Port Number and Name of
the license server host.

The list of features for which you are licensed will show all versions, but your license must have a version
equal to or greater than your design tools release version in order for the libero.exe and designer.exe tools
to run.

The list at the lower right shows the order in which the license files are read, with the first file read at the top
of the list.
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Click Write Report File to view and/or print the Microsemi Tools Licenses Report, or to save it as a TXT file.

- |
€ Microsemi License Utility == X
B write ReportFile...
|valid License Feat.|version erm |Expiration Quantity Host HostID |source |Comment
Platinum (ACTEL_t[99.95 Permanent naone 200 users sage a0d3c11847ab 1702@sage
|
< i b
Host name: 515000120 [lf Add License File...] [+ Add License Server...
Disk volume: 7053a3e4
Network card(s)™: a0d3c11847ab  [5eqence for searching license sources
1702
4 Request License (web) @sage
1717 @sage
*Multiple network cards may be listed; use 1800@sage
only one network card identifier when
requesting a license.

Figure 2 - Microsemi License Utility

Supported Families (Enhanced Constraint Flow)
Microsemi's Libero SoC software supports the following families of devices in Enhanced Constraint Flow:
e SmartFusion2
o [GLOO2
o RTG4
When we specify a family name, we refer to the device family and all its derivatives, unless otherwise
specified. See the table below for a list of supported device families and their derivatives:
Table 1 - Product Families and Derivatives

Device Family Description
Family Derivatives
SmartFusion2 N/A Address fundamental requirements for advanced

security, high reliability and low power in critical
industrial, military, aviation, communications and
medical applications.

IGLOO2 N/A Low-power mixed-signal programmable solution
RTG4 N/A Microsemi's new RTG4 family of radiation-tolerant
FPGAs
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File Types in Libero SoC

When you create a new project in the Libero SoC it automatically creates new directories and project files.
Your project directory contains all of your local project files. When you import files from outside your current
project, the files are copied into your local project folder.

The Project Manager enables you to manage your files as you import them. If you want to store and
maintain your design source files and design constraint files in a central location outside the Project location,
Libero gives you the option to link them to your Libero project folders when you first create your project.
These linked files are not copied but rather linked to your project folder.

Depending on your project preferences and the version of Libero SoC you installed, the software creates
directories for your project.

The top level directory (<project_name>) contains your PRJ file; only one PRJ file is enabled for each Libero
SoC project.

component directory - Stores your SmartDesign components (SDB and CXF files) for your Libero SoC
project.

constraint directory - All your constraint files (SDC, PDC)

designer directory - ADB files (Microsemi Designer project files), -_ba.SDF, _ba.v(hd), STP, PRB (for
Silicon Explorer), TCL (used to run designer), impl.prj_des (local project file relative to revision), designer.log
(logfile)

Note: The Microsemi ADB file memory requirement is equivalent to 2x the size of the ADB file. If
your computer does not have 2x the size of your ADB file's memory available, please make
memory available on your hard drive.

hdl directory - all hdl sources. *.vhd if VHDL, *.v and *.h if Verilog

simulation directory - meminit.dat, modelsim.ini files, BFM files

smartgen directory - GEN files and LOG files from generated cores

stimulus directory - BTIM, Verilog, and VHDL stimulus files

synthesis directory - *.edn, *_syn.prj (Synplify log file), *.psp (Precision project file), *.srr (Synplify lodfile),

precision.log (Precision logdfile), *.tcl (used to run synthesis) and many other files generated by the tools (not
managed by Libero SoC)

viewdraw directory - viewdraw.ini files

Software Tools - Libero SoC

The Libero SoC integrates design tools, streamlines your design flow, manages design and log files, and
passes design data between tools.

For more information on Libero SoC tools, please visit:
http://www.microsemi.com/products/fpga-soc/design-resources/design-software/libero-soc#overview

Function Tool Company
Project Manager, HDL Editor, Core Generation Libero SoC Microsemi
SoC
Synthesis Synglify® Pro | Synopsys
ME
Simulation ModelSim® | Mentor
ME Graphics
Timing/Constraints, Power Analysis, NetlistViewer, Libero SoC Microsemi
Floorplanning, Package Editing, Place-and-Route, SoC
Debugging
Programming Software FlashPro Microsemi
SoC
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Function Tool Company
Programming Software FlashPro Microsemi
Express SoC

Project Manager, HDL Editor targets the creation of HDL code. HDL Editor supports VHDL and Verilog
with color, highlighting keywords for both HDL languages.

Synplify Pro ME from Synopsys is integrated as part of the design package, enabling designers to target
HDL code to specific devices.

Microsemi SoC software package includes:
e Chip Planner displays I/0 and logic macros in your design for floorplanning
e NetlistViewer design schematic viewer
e SmartPower power analysis tool
e SmartTime static timing analysis and constraints editor

ModelSim ME from Mentor Graphics enables source level verification so designers can verify HDL code line
by line. Designers can perform simulation at all levels: behavioral (or pre-synthesis), structural (or post-
synthesis), and back-annotated (post-layout), dynamic simulation. (ModelSim is supported in Libero Gold
and Platinum only.)

Frequently Asked Questions - Libero SoC
How do | set my Multi-Pass place and route options?

For SmartFusion2, IGLOO2, RTG4: In the Design Flow window, expand Implement Design, right-click
Place and Route and choose Configure Options. When the Layout Options dialog box appears, check the
Use Multiple Passes option and click Configure. When the Multi-Pass configuration dialog box appears,
set your Multi-Pass options.

How do | set FlashPro security options?

In the Libero SoC Design Flow window, expand Program Design, right-click Program Device and choose
Open Interactively. FlashPro opens and enables you to set/change your security options. See the FlashPro
help for more information.

How do | instantiate my HDL in SmartDesign?

Import your HDL file into the Libero SoC (File > Import Files). After you do this, your HDL module appears in
the Project Manager Hierarchy. Then, drag-and-drop it from the Hierarchy onto your SmartDesign Canvas.

How do | add a bus interface to my HDL code and then add it to SmartDesign?

If you want to add a bus interface to your HDL code and then add it to SmartDesign, see the Adding or
Modifying Bus Interfaces in SmartDesign topic.

I don't see any DirectCore IP's in the Catalog but | have both Libero IDE 9.1 and Libero SoC 10.0
installed. Where are the DirectCore IP's?

Make sure the vault location is correct. Click the Catalog Options button to open the Catalog Options dialog
box. Then check and, if necessary, update your vault location.

How do | make sure that my design is using the latest driver(s)?
In the Design Flow tab, expand Create Design and double-click View/Configure Firmware Cores to view
the DESIGN_FIRMWARE tab. The Firmware table lists the compatible firmware and drivers based on the

hardware peripherals that you have used in your design. Use the Version drop down menus to check for the
latest firmware and firmware drivers.

How do | write a testbench?

You can write or edit a testbench manually using the HDL editor, or you can create a new HDL testbench
and automatically populate it with all your design information with Create New HDL Testbench in Libero
SoC. Create New HDL Testbench is in the Design Flow window under Create Design.

Testbench file are generated automatically when you generate a SmartDesign. You can find them in your
Files window in Libero SoC (View > Window > Files).
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Firmware Cores Frequently Asked Questions
Where are the firmware files generated?

The firmware files are generated to the firmware working directory <project>\firmware. Your software IDE
workspace is generated to <project>\<software IDE tool chain>.

Why are some firmware in italics?

This indicates the firmware is in the IP repository but not in your local IP vault. You must download it to your
local IP vault so that the Libero SoC will generate the firmware files.

Why am | getting the following error on generation? "Error: '‘Missing Core Definition': Core
'Actel:Firmware:MSS_SPI_Driver:2.0.101 ' is missing from the vault."?

This happens when a firmware that is in your design but the VLNV definition could not be found in your IP
vault. This can happen if you:

e Changed your vault settings to point to another vault
e Opened a project that was created on another machine
Why is my firmware view empty?
Check that you are pointing to the proper firmware repository:
www.actel-ip.com/repositories/Firmware

Check with your network administrator to make sure you can communicate with Microsemi's IP repository
URL.

Why are there multiple firmware instances of the same type?

Some firmware cores have configurable options, and in certain cases you will have two peripherals of the
same firmware VLNV. In this situation, you may want to configure each peripheral driver separately.

Software IDE Integration

Libero SoC simplifies the task of transitioning between designing your FPGA to developing your embedded
firmware.

Libero SoC manages the firmware for your FPGA hardware design, including:
e Firmware hardware abstraction layers required for your processor
e Firmware drivers for the processor peripherals that you use in your FPGA design.
e Sample application projects are available for drivers that illustrate the proper usage of the APIs

You can see which firmware drivers Libero SoC has found to be compatible with your design by opening the
Firmware View. From this view, you can change the configuration of your firmware, change to a different
version, read driver documentation, and generate any sample projects for each driver.

Libero SoC manages the integration of your firmware with your preferred Software Development
Environment, including SoftConsole, Keil, and IAR Embedded Workbench. The projects and workspaces for
your selected development environment are automatically generated with the proper settings and flags so
that you can immediately begin writing your application.

See Also
Exporting Firmware and the Software IDE Workspace
Libero SoC Frequently Asked Questions
Running Libero SoC from your Software Tool Chain

View/Configure Firmware Cores

Libero Design Flow Using Enhanced Constraint Flow for
SmartFusion2, IGLOOZ2, and RTG4

When creating a new project, follow the directions in the New Project Wizard to create an Enhanced
Constraint Flow project.
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If you do not create or open an Enhanced Constraint Flow project for SmartFusion2, IGLOO2, and RTG4,
please refer to the generic Libero SoC User Guide [ed -- insert link]

Starting the Libero GUI

When starting Libero SoC GUI, the user will be presented with the option of either creating a new project, or
opening an old one.

rG\- Libero 2 =k e

Project File Edit View Design Tools Help
~ —

LDEWax@03

| StartPage

|

2

Recent Projects L I be @\

System-on-Chip

4

m

Libero SoC Interface

Description
Welcome to Libero SoC o

] ) The Libero SoC interface enables a push-button design flow via
Libero SoC Quickstart several tabs and an expanded work area.

Libere SoC Interface Description

m

Work Window - Displays the SmartDesign Canvas, HDL editor
Libero SoC Release Notes on the Web or Report view. Click the Maximize/Restore Work Area button to

Libero Tutorials show/hide the other interface elements.

Product Tutorials Design Hierarchy Tab - Lists Components and Modules in your
-| design. Use it to manage your design files. =

Temicina 180l ook,

Log 5 X

QErrors 1, Warnings 0Inf0

Log Message

Fam: |Part:

b R

e Clicking on Omev ... opens an already existing Libero SoC project.

e Clicking on Neo... starts the New Project Wizard. Upon completion of the wizard, a new Libero SoC
project is created and opened.

Having opened a project, the Libero SoC GUI presents a Design Flow window on the left hand side, a log
and message window at the bottom, and project information windows on the right. Below we see the GUI of
a newly created project targeting the Fusion family with only the top level Design Flow Window steps visible.

Libero SoC User's Guide 17



& Microsemi

NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

r = = ~ ~ e - B
(® Libero - U:w19_newcons\F\F.prjx = |
Project File Edit VMiew Design Tools Help
~ o o
DS W ™% 0
Design Flow Reports @ X StartPage & X -
Please select a root 4 Project Summary &3 0Errors 4, 0warnings i} 0 Info
Flog
Tool Project Name: F
{¥ Create Design L::atlcni U:\newcons\F
- i Description:
M b ¥ Constrain Design Preferred HDL Type: Verilog
b Implement Design
> # Program Design #
» Debug Design Dewvice Details
> » Handoff Design for Production N
P Develop Firmware Bart Number : AFS090-1FGE256
Family : Fusion
Die : AFS090
Package : 256 FBGR
Speed : -1
Core Voltage : 1.5
Range : COM
4| I *
Design F.. | Design Hierar. Stimulus Hierar. | Catalog I Files |
Log -4
& Errors i, warnings i Info
The F project was opened.
|
Log Message
Fam: Fusion | Part: AFS090-1FG256 | vierilog

The Design Flow Window

The Design Flow Window for each technology family may be slightly different. The Constraint Flow choice
made during new project creation may also affect the exact elements of design flow. However, all flows
include some version of the following design steps:

e Create

e Constrain

e Implement

e Program and Debug
e Handoff

Design Report

The Design Report Tab lists all the reports available for your design, and displays the selected report.

Reports are added automatically as you move through design development. For example Timing reports are
added when you run timing analysis on your design. The reports are updated each time you run timing
analysis.

If the Report Tab is not visible, you may expose it at any time by clicking on the main menu item Design >
Reports

If a report is not yet listed, you may have to create it manually. For example, you must invoke Verify Power
manually before it's report will be available.

Reports for the following steps are available for viewing here:
e Project Summary
e Synthesize
e Place and Route
e Verify Timin
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Libero Design Flow Using Enhanced Constraint Flow for SmartFusion2, IGLOO2, and RTG4

o Verify Power

e Programming
e Generate FPGA Array Data
e Generate Bitstream

e Export
e Export Bitstream

e Export Pin Report
e Export IBIS Model

Using the Libero SoC New Project Wizard to Start an Enhanced Constraint Flow Project.

Libero SoC's Enhanced Constraint Flow provides a centralized user interface provided for you to better
manage design constraints (I/O Constraints, Floorplanning Constraints, Timing Constraints and Netlist
Constraints) throughout the design process. It also derives SDC Timing Constraints for IP cores, such as
CCC, SERDES, MSS, and OSC, based on the configuration of those cores and the component SDC. This
new feature is available for SmartFusion2, IGLOO2, and RTGA4.

Because this is the first release of the Enhanced Constraint Flow, it has the following limitations:

¢ block flow is not enabled

e The design separation methodology is not enabled
When you click Finish in the New Project Wizard at the end of project creation, the New Project Information
dialog box appears and gives you the following choices:

e Use Classic Constraint Flow

e Use Enhanced Constraint Flow

Libero SoC v11.7 ntroduces an enhanced constraint flow aimed at simplfying the management of all constraints for your design:
* [/0, timing, floor planning and netlist oplimization constraints can be created, imported, edited, checked and organized in & single view.

* Timing constraints can be entered using standard SDC fermat and the same set of constraints can be automatically applied to both Synopsys’ Synplify synthesis,

Tirming Driven Flace and Route and Timing Verification.
= A new SDC dock group constraint is also introduced and can be used to ease the specification of related and unrelated cocks.
# Timing constraints for known hardware blocks and IPs can be derived automatically; examples of such constraints are:
© SERDES-EPCS, MSS/HPMS and internal oscillator dock sources
@ Fabric COCs generated docks
o Fabric CCCs dock sources

o Corefesetf false paths
@ CoreConfigP false paths, min and max delay constraints
Mote that this first release of the enhanced constraint flow has the following limitations:
» The block flow is not enabled
# The design separation methadology s not enabled
The following screen shot shows the constraint management view and how to access it from the Design Flow window

Beson o & [ ——— v
= B OB G o e\ o fae \ et aboe
o a dem v | depent Lk Edit with 1O Edter Check, +| &
4 b Coeste Design e
& System Buddes constriatiichey. ot e v
& Configure M55 =
B3 Create SmaniDesign
B Creserion
i Create SrmanDesign Testhench F R Sartancs "
Remeniber my choice and da not show me agan, use Classs: Constrant Flow| | Use Enhanced Constrant Fiow |

Figure 3 - New Project Information Dialog Box
Click the Use Enhanced Constraint Flow button to activate this feature for the design flow.

Use the Remember my choice and do not show me again check-box to preserve your choice in your
Libero Design Flow Preferences.

New Project Creation Wizard — Project Details

You can create a Libero SoC project using the New Project Creation Wizard. You can use the pages in the
wizard to:
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e Specify the project name and location

e Select the device family and parts

e Set the I/O standards

e Use System Builder or MSS in your design project

e Import HDL source files and/or design constraint files into your project

) ¢® ... 2 T _ e
Progect Details
Soecty Project Detals
Project Details
Frogect Name: |
Project Locaton: o Erowse...
Device Selection
Cescription.
Device Settings f
Design Template Frefiered HOL Type: weriog v
Erable Bock Creaton
Add HDL Sources
Add Constraints
Libefo)
Sytemon Chip e
reg

Figure 4 - Libero SoC New Project Creation Wizard

Project

Project Name - Identifies your project name; do not use spaces or reserved Verilog or VHDL keywords.
Project Location — Identifies your project location on disk.

Description — General information about your design and project. The information entered appears in your
Datasheet Report View.

Preferred HDL type - Sets your HDL type: Verilog or VHDL. Libero-generated files (SmartDesigns,
SmartGen cores, etc.) are created in your specified HDL type. Libero SoC supports mixed-HDL designs.

Enable Block Creation - Enables you to build blocks for your design. These blocks can be assembled in
other designs, and may have already completed Layout and been optimized for timing and power
performance for a specific Microsemi device. Once optimized, the same block or blocks can be used in
multiple designs.

When you are finished, click Next to proceed to the next page.

See Also
New Project Creation Wizard - Device Selection

New Project Creation Wizard — Device Settings

New Project Creation Wizard — Design Template

New Project Creation Wizard - Add Constraints

New Project Creation Wizard — Add HDL Source Files

20 Libero SoC User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi
Libero Design Flow Using Enhanced Constraint Flow for SmartFusion2, IGLOO2, and RTG4

New Project Creation Wizard — Device Selection

The Device Selection page is where you specify the Microsemi device for your project. Use the filters and
drop-down lists to refine your search for the right part to use for your design.

This page contains a table of all parts with associated FPGA resource details generated as a result of a
value entered in a filter.

When a value is selected for a filter:

e The parts table is updated to reflect the result of the new filtered value.

o All other filters are updated, and only relevant items are available in the filter drop-down lists.
For example, when SmartFusion2 is selected in the Family filter:

e The parts table includes only SmartFusion2 parts.

e The Die filter includes only SmartFusion2 dies in the drop-down list for Die.

Pn:n;|-e|:|..-.'.,,.‘-lﬂ » [ o g
Device Selection
Select & pirt for your project Fom the Pact Number kst Selected Part: M2S158T-1FCHIS2M
Part Finer
Famly: | S fFuson = D (A ¥ Package: | Al L
Speedt (Al = | Core voltsge: Al - Aange: |al >
Rt Fiters
Device Settings Sewih Part: i
Pt Mumbsr Macvam Loge Ben Masimum Logc Elen Totsl User 1O SR 3K Bl LSRAM B8 Biocks Math Blocks (1838 Pllsar *
Design Template MZ5150-1FC5535 146124 14614 23 20 % 240 3 [l
S 501 FCSS3EL 148124 146124 3 240 % 240 ]
MI5150-1FCN484 145124 614 8 200 % M0 H
MISISO-IFCN4BAL 1481 161 M8 20 3% H ]
Add HOL Sources MZS150-FC1152 106124 146124 w4 0 3% 40 s
M25150-FC1152 145124 L4614 M 240 2% 40 8
MI5150-FCS538 M 614 53 0 3% M0 [
Add Constraints M550 FCS5361 145124 14614 3 240 % 0 ]
MZ5150-FOVASA 1451 146124 28 20 3% M0 8
WS 80 PO 145124 14E124 248 240 FE ) 240 L]
l MISISOT-IFCIIS2 L4614 L4614 M 200 % M0 H
- ¥ . \ MISISOT-IFCIASH 14614 61 7] 20 3% M0 8
leero MISISOT-DFCIASIM 146124 146124 171 240 2% M40 ]
temon Chp h =
Heip < Back hext Fesh Carcel

Figure 5 - New Project Creation Wizard - Device Selection Page
Family — Specify the Microsemi device family. Only devices belonging to the family are listed in the parts
table.
Die / Package / Speed - Set your device die, package, and speed grade, respectively. Only parts matching
the filtering option are listed in the parts table.
Core Voltage - Set the core voltage for your device. Wide range voltage for die voltage (VCCA) and VCCI is
available for ProASIC3L and 1.2V IGLOO devices. Two numbers separated by a "~" are shown if a wide
range voltage is supported. For example, 1.2~1.5 means that the device core voltage can vary between 1.2
and 1.5 volts.
Range - Define the voltage and temperature ranges a device may encounter in your application. Tools such
as SmartTime, SmartPower, timing-driven layout, power-driven layout, the timing report, and back-annotated
simulation are affected by operating conditions.
Supported ranges include:

e Commercial (COM) - Junction temperature is a function of ambient temperature, air flow, and power

consumption.

e Industrial (IND) - Junction temperature is a function of ambient temperature, air flow, and power
consumption.

e Military (MIL) - Junction temperature is a function of the case temperature, air flow, and power
consumption.

Note: Supported operating condition ranges vary according to your device and package.
Refer to your device datasheet to find your recommended temperature range.
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Set your 1/O operating voltages in Project Settings > Device 1/O Settings.
Reset Filters — Reset all filters to the default ALL option except Family.
Search Parts — Enter a character-by-character search for parts. Search results appear in the parts table.

New Project Creation Wizard — Device Settings

The Device Settings page is where you set the Device I/0 Technology, PLL Supply Voltage, Reserve pins
for Probes and activate the System Controller Suspended Mode.

= [y T
m‘“ Profect - .l ¥ Y " i
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10 Setings
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Design Template Mandmum Core Voltage Rl Ramp Up Time: | 100ms Minimus, -
Add HOL Sources Systen Controler Susperded Made
Add Constraints
Lib iy
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Help <hock | [ memt> | [ Foen Cancel
=

Figure 6 - New Project Creation Wizard — Device Settings Page

Default I/O Technology - Set all your I/Os to a default value. You can change the values for individual 1/0s
in the 1/O Attribute Editor. The I/O Technology available is family-dependent.

Reserve Pins for Probes (SmartFusion2, IGLOO2 and RTG4) - Reserve your pins for probing if you intend
to debug using SmartDebug.

Reserve Pins for SPI (RTG4 only) — Check this box to reserve pins for SPI functionality in Programming.
This option is displayed in the Compile Report when the compile process completes.

PLL Supply Voltage (V) (SmartFusion2, IGLOO2 only) - Set the voltage for the power supply that you plan
to connect to all the PLLs in your design, such as MDDR, FDDR, SERDES, and FCCC.

Maximum Core Voltage Rail Ramp Up Time (SmartFusion2, IGLOO?2 only) - Power-up management
circuitry is designed into every SmartFusion2 and IGLOO2 SoC FPGA. These circuits ensure easy transition
from the powered-off state to the powered-up state of the device. The SmartFusion2, IGLOO2, and RTG4
system controller is responsible for systematic power-on reset whenever the device is powered on or reset.
All I/Os are held in a high-impedance state by the system controller until all power supplies are at their
required levels and the system controller has completed the reset sequence.

The power-on reset circuitry in SmartFusion2 and IGLOO2 devices requires the VDD and VPP supplies to
ramp monotonically from 0 V to the minimum recommended operating voltage within a predefined time.
There is no sequencing requirement on VDD and VPP. Four ramp rate options are available during design
generation: 50 ys, 1 ms, 10 ms, and 100 ms. Each selection represents the maximum ramp rate to apply to

VDD and VPP.
Device information (such as Die, Package and Speed) can be modified later in the Project Settings dialog
box.

System Controller Suspended Mode (SmartFusion2, IGLOO?2 only) - Enables designers to suspend
operation of the System Controller. Enabling this bit instructs the System Controller to place itself in a reset
state when the device is powered up. This effectively suspends all system services from being performed.
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For a list of system services, refer to the SmartFusion2 or IGLOO2 System Controller User's Guide for your
device on the Microsemi website.

Device information (such as Die, Package and Speed) can be modified later in the Project Settings dialog
box.

New Project Creation Wizard — Design Template

The Design Template page is where you can use Libero SoC’s built-in template to automate your design
process. The template uses the System Builder tool for system-level design or the Microcontroller
Subsystem (MSS) in your design. Both will speed up your design process.

Project
L:o.:::p:;. template Selected Park M25154T-1FC1152H
Doesign Termpiates and Creators
Project Details & Hone
Creaie a System Bulder based design
Device Selection Create & Mcrocontraber (M55) based design
Device Settings I
|
Design Template
Dessigr Meadoiogy
Add HOL Sources Use Starctaionn Litization for MODR FDDR /SERDES Perphersis
Add Constraints
Sytem-onChip h—
| heo < Back Mot > Finsh | Cancel

Figure 7 - New Project Creation Wizard — Design Template Page
None- Select if you do not want to use a design template.
Create a System Builder based design (SmartFusion2 and IGLOO2 only) — Use System Builder to
generate your top-level design.
Create a Microcontroller (MSS) based design (SmartFusion2 and IGLOO2 only) — Instantiate a
Microcontroller (MSS) in your design. The version of the MSS cores available in your vault is displayed.
Select the version you desire.
Use Standalone Initialization for MDDR/FDDR/SERDES Peripherals (SmartFusion2 and IGLOO2 only) —
Check this box if you want to create your own peripheral initialization logic in SmartDesign for each of your
design peripherals (MDDR/FDDR/SERDES). When checked, System Builder does not build the peripherals
initialization logic for you. Standalone initialization is useful if you want to make the initialization logic of each
peripheral separate from and independent of each other.

New Project Creation Wizard — Add HDL Source Files

The Add HDL Source Files page is where you add HDL design source files to your Libero SoC project. The
HDL source files can be imported or linked to the Libero SoC Project.
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Figure 8 - New Project Creation Wizard - Add HDL Source Files Page

Import File —

Navigate to the disk location of the HDL source. Select the HDL file and click Open. The HDL

file is copied to the Libero Project in the <prj_folder>/hdl folder.

Link File — Navigate to the disk location of the HDL source. Select the HDL file and click Open. The HDL file
is linked to the Libero Project. Use this option if the HDL source file is located and maintained outside of the
Libero project.

Delete - Delete the selected HDL source file from your project. If the HDL source file is linked to the Libero
project, the link will be removed.

New Project Creation Wizard - Add Constraints

The Add Constraints page is where you add Timing constraints and Physical Constraints files to your Libero
SoC project. The constraints file can be imported or linked to the Libero SoC Project.
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Figure 9 - New Project Creation Wizard — Add Constraints Page
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Import File — Navigate to the disk location of the constraints file. Select the constraints file and click Open.
The constraints file is copied to the Libero Project in the <prj_folder>/constraint folder.

Link File — Navigate to the disk location of the constraints file. Select the constraints file and click Open.
The constraints file is linked to the Libero Project. Use this option if the constraint file is located and
maintained outside of the Libero project.

Delete - Remove the selected constraints file from your project. If the constraints file is linked to the Libero
project, the link will be removed.

Click Finish to complete New Project Creation.

The Reports tab displays the result of the New Project creation.

Reports @ X StartPage & X
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Figure 10 - Reports Tab

Create and Verify Design

System Builder

System Builder is a graphical design wizard that enables you to enter high-level design specifications for
SmartFusion2 or IGLOO2.

System Builder takes you through the following steps:
e Asks basic questions about your system architecture and peripherals
e Builds a correct-by-design complete system

System Builder automatically configures the silicon features you select. To complete the design, add your
custom logic or IP and connect them to your System Builder-generated design.

See the SmartFusion2 System Builder documentation or the |IGLOO2 System Builder documentation for a
complete family-specific explanation of the tool.

MSS - SmartFusion2 only

Instantiate a SmartFusion2 MSS in your Design

You can configure peripherals within the SmartFusion2 MSS, such as the ARM® Cortex™-M3, embedded
nonvolatile memory (eNVM), Ethernet MAC, timer, UART, and SPI to suit your needs. The MSS operates
standalone without any dependencies on other logic within the device; however, designs that require
functionality beyond a standalone MSS are handled by using SmartDesign to add user logic in the
SmartFusion2 FPGA fabric.
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You can instantiate a Microcontroller Subsystem into your design from the New Project Creation Wizard
when you start a new SmartFusion2 project, or from the Design Flow window after you have created a new
project.

To instantiate a SmartFusion2 MSS from the New Project Creation Wizard you must enable Use Design
Tool (under Design Templates and Creators) and click to select SmartFusion2 Microcontroller
Subsystem (MSS) from the list.

If you opted not to use a Design Tool when you created your project, in the Design Flow window expand
Create Design and double-click Configure MSS. This opens the Add Microcontroller Subsystem dialog
box. Enter your Desigh Name and click OK to continue. A SmartDesign Canvas appears with the MSS
added to your project; double-click the MSS to view and configure MSS components.

Configure the SmartFusion2 MSS

Documents for specific SmartFusion2 MSS peripherals are available on the Peripheral Documents web
page.

The SmartFusion2 Microcontroller Subsystem (MSS) Configurator (as shown in the figure below) contains
the elements listed below. Double-click any element in the MSS to configure it; click the checkbox (if
available) to enable or disable it in your design.

MSS ARM® Cortex™-M3

Peripherals
¢ MSS CAN
e MSS Peripheral DMA (PDMA)
e MSS GPIO
¢ MSSI2C

e MSS Ethernet MAC

e MSS DDR Controller (MDDR)

¢ MSS MMUART

e MSS Real Time Counter (RTC)

e MSS Embedded Nonvolatile Memory (eNVM)

e MSS SPI

¢ MSS USB

e MSS Watchdog Timer
Fabric Interfaces

e MSS Fabric Interface Controllers (FICs)
Additional Information

e MSS Cache Controller

e MSS DDR Bridge Controller

¢ MSS AHB Bus Matrix

e MSS Clocks Configurator (MSS CCC)

e MSS Interrupts Controller

e MSS Reset Controller

e MSS SECDED Configurator

e MSS Security Configurator

The MSS generates a component that is instantiated into your top-level design.
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Figure 11 - Microcontroller Subsystem Configurator

Generate SmartFusion2 MSS Files

See the MSS Configurator help for more information on generating SmartFusion2 MSS files.
Click the Generate Component button - = to create your SmartFusion2 MSS files.
The MSS Configurator generates the following files:

e HDL files for the MSS components, including timing shells for synthesis - HDL files are automatically
managed by the Libero SoC and passed to the Synthesis and Simulation tools.

e EFC File: Contains your eNVM client data - The EFC content is included in your final programming file.

e Firmware drivers and memory maps are exported into the <project>\firmware\ directory - Libero SoC
automatically generates a Software IDE project that includes your Firmware drivers. If you are not
using a software project automatically created by Libero, you can import this directory into your
Software IDE project.

e Testbench HDL and BFM script for the MSS design: These files are managed by Libero SoC and
automatically passed to the Simulation tool.

e PDC files for the MSS and the top-level design: These files are managed by Libero SoC and
automatically integrated during Compile and Layout.

SmartDesign

About SmartDesign

SmartDesign is a visual block-based design creation tool for instantiation, configuration and connection of
Microsemi IP, user-generated IP, custom/glue-logic HDL modules. The final result is a design-rule-checked
and automatically abstracted synthesis-ready HDL file. A generated SmartDesign can be the entire FPGA
design or a component subsystem of a larger design.

Instantiate IP cores, macros and HDL modules by dragging them from the Catalog onto the Canvas, where
they are viewed as blocks in a functional block diagram. From the Canvas you can:
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e Configure your blocks
e Make connections between your blocks
e Generate your SmartDesign

e This step generates the HDL and testbench files required to proceed with
Synthesis and Simulation.

o View a Memory Map / Datasheet - The datasheet reports the memory map of
the different subsystems of your design, where a subsystem is any
independent bus structure with a Master and Slave peripheral attached.

SmartDesign Design Flow

SmartDesign enables you to stitch together design blocks of different types (HDL, IP, etc ) and generate a
top-level design. The Files tab lists your SmartDesign files in alphabetical order.

You can build your design using SmartDesign with the following steps:

Step One — Instantiating components: In this step you add one or more building blocks, HDL modules,

components, and schematic modules from the project manager to your design. The components can be
blocks, cores generated from the core Catalog, and IP cores.

Step Two — Connecting bus interfaces: In this step, you can add connectivity via standard bus interfaces
to your design. This step is optional and can be skipped if you prefer manual connections. Components
generated from the Catalog may include pre-defined interfaces that allow for automatic connectivity and
design rule checking when used in a design.

Step Three — Connecting instances: The Canvas enables you to create manual connections between
ports of the instances in your design. Unused ports can be tied off to GND or VCC (disabled); input buses
can be tied to a constant, and you can leave an output open by marking it as unused.

Step Four — Generating the SmartDesign component: In this step, you generate a top-level (Top)
component and its corresponding HDL file. This component can be used by downstream processes, such as
synthesis and simulation, or you can add your SmartDesign HDL into another SmartDesign.

When you generate your SmartDesign the Design Rules Check verifies the connectivity of your design; this
feature adds information to your report; design errors and warnings are organized by type and message and
displayed in your Datasheet / Report.

You can save your SmartDesign at any time.

Using Existing Projects with SmartDesign

You can use existing Libero SoC projects with available building blocks in the project to assemble a new
SmartDesign design component. You do not have to migrate existing top-level designs to SmartDesign and
there is no automatic conversion of the existing design blocks to the SmartDesign format.

SmartDesign Frequently Asked Questions

General Questions

What is SmartDesign?

SmartDesign is a design entry tool. It's the first tool in the industry that can be used for designing System on
a Chip designs, custom FPGA designs or a mixture of both types in the same design. A SmartDesign can be
the entire FPGA design, part of a larger SmartDesign, or a user created IP that can be stored and reused
multiple times. It's a simple, intuitive tool with powerful features that enables you to work at the abstraction
level at which you are most comfortable.

It can connect blocks together from a variety of sources, verify your design for errors, manage your memory
map, and generate all the necessary files to allow you to simulate, synthesize, and compile your design.
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How do | create my first SmartDesign?

In the Libero SoC Project Manager Design Flow window, under Create Design, double-click Create
SmartDesign.

Instantiating Into Your SmartDesign
Where is the list of Cores that | can instantiate into my SmartDesign?

The list of available cores is displayed in the Project Manager Catalog. This catalog contains all DirectCore
IP, Design Block cores, and macros.

How do | instantiate cores into my SmartDesign?

Drag and drop the core from the Catalog onto your SmartDesign Canvas. An instance of your Core appears
on the Canvas; double-click to configure it.
| have a block that | wrote in VHDL ( or Verilog ), can | use that in my SmartDesign?
Yes! Import your HDL file into the Project Manager (File > Import Files). After you do this, your HDL module
will appear in the Project Manager Hierarchy. Then, drag-and-drop it from the Hierarchy onto your
SmartDesign Canvas.
My HDL module has Verilog parameters or VHDL generics declared, how can | configure those in
SmartDesign?

If your HDL module contains configurable parameters, you must create a ‘core’ from your HDL before using
it in SmartDesign. Once your HDL module is in the Project Manager Design Hierarchy, right-click it and
choose Create Core from HDL. You will then be allowed to add bus interfaces to your module if necessary.
Once this is complete, you can drag your new HDL+ into the SmartDesign Canvas and configure your
parameters by double-clicking it.

Working in SmartDesign

How do | make connections?
Let SmartDesign do it for you. Right-click the Canvas and choose Auto Connect.
Auto Connect didn’t connect everything for me, how do | make manual connections?

Enter Connection Mode and click and drag from one pin to another. Click the Connection Mode button in
the Canvas to enter Connection Mode.

Alternatively:
1. Select the pins you want connected by using the mouse and the CTRL key.
2. Right-click one of the selected pins and choose Connect.
How do | connect a pin to the top level?

Right-click the pin and choose Promote to Top Level. You can even do this for multiple pins at a time, just
select all the pins you want to promote, right-click one of the pins and choose Promote to Top Level. All
your selected pins will be promoted to the top level.

Oops, | just made a connection mistake. How do | disconnect two pins?
Use CTRL+Z to undo your last action. If you want to undo your ‘undo’, hit redo (CTRL+Y).
To disconnect pins you can:
¢ Right-click the pin you want to disconnect and choose Disconnect
e Select the net and hit the delete key
I need to apply some simple ‘glue’ logic between my cores. How do | do that?

For basic inversion of pins, you can right-click a pin and choose Invert. An inverter will be placed at this pin
when the design is generated. You can also right-click a pin and choose Tie Low or Tie High if you want to
connect the pin to either GND or VCC.
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To tie an input bus to a constant, right-click the bus and choose Tie to Constant. To mark an output pin as
unused, right-click the pin and choose Mark as Unused.

To clear these, just right-click on the pin again and choose Clear Attribute.
My logic is a bit more complex than inversion and tie offs - what else can 1 do?

You have full access to the library macros, including AND, OR, and XOR logic functions. These are located
in the Project Manager Catalog, listed under Macro Library. Drag the logic function you want onto your
SmartDesign Canvas.

How do | create a new top level port for my design?
Click the Add Port button in the Canvas toolbar
How do | rename one of my instances?

Double-click the instance name on the Canvas and it will become editable. The instance name is located
directly above the instance on the Canvas.

How do | rename my top level port?
Right-click the port you want to rename and choose Modify Port.

How do | rename my group pins?
Right-click the group pin you want to rename and choose Rename Group.

I need to reconfigure one of my Cores, can | just double-click the instance?
Yes.

| want more Canvas space to work with!

Maximize your workspace (CTRL-W), and your Canvas will maximize within the Project Manager. Hit CTRL-
W again if you need to see your Hierarchy or Catalog.

Working with Processor-Based Designs in SmartDesign

How do | connect my peripherals to the bus?

Click Auto Connect and it will help you build your bus structure based on the processor and peripherals that
you have instantiated.

But | need my peripheral at a specific address or slot.

Right-click the Canvas and choose Modify Memory Map to invoke the Modify Memory Map dialog that
enables you to set a peripheral to a specific address on the bus.

The bus core will show the slot numbers on the bus interface pins. These slot numbers correspond to a
memory address on the bus.

Verify that your peripheral is mapped to the right bus address by viewing your design’s Memory Map.
How do | view the Memory Map of my design?
Generate your project and open datasheet in the Report View.

The memory map section will also show the memory details of each peripheral, including any memory
mapped registers.

How do | simulate my processor design?

SmartDesign automatically generates the necessary Bus Functional Model (BFM) scripts required to
simulate your processor based design. A top level testbench for your SmartDesign is generated
automatically as well.

Create your processor design, generate it, and you will be able to simulate it in ModelSim.
I have my own HDL block that | want to connect as a peripheral on the AMBA bus. How can | do that?
SmartDesign supports automatic creation of data driven configurators based on HDL generics/parameters.

If your block has all the necessary signals to interface with the AMBA bus protocol ( ex: address, data,
control signals):

1. Right-click your custom HDL block and choose Create Core from HDL. The Libero SoC creates your
core and asks if you want to add bus interfaces.
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2. Click Yes to open the Edit Core Definition dialog box and add bus interfaces. Add the bus interfaces as
necessary.
3. Click OK to continue.
Now your instance has a proper AMBA bus interface on it. You can manually connect it to the bus or let Auto
Connect find a compatible connection. See the DirectCore Advanced Microcontroller Bus Architecture - Bus
Functional Model User's Guide for more information on CoreAMBA BFM commands.
How do | generate the firmware drivers for my design?
SmartDesign automatically finds all the compatible firmware drivers based on your peripherals and
processor. You can view the list of firmware drivers that the design found by going to the design flow and
choosing View/Configure Firmware Cores.
How do | start writing my application code for my design?
Libero SoC simplifies the embedded development process by automatically creating the workspace and
project files for the Software IDE that you specify in the Tools profile.
Once you have generated your design, the firmware and workspace files will automatically be created. Click
Write Application Code in the Design Flow tab and the Software IDE tool will open your design’s
workspace files.

VHDL Construct Support in SmartDesign

What VHDL constructs do you support?

VHDL types Record, Array, Array of Arrays, Integer and Unsigned are supported on entity ports of imported
VHDL files - these are treated as special types in Libero.

How can | import files with VHDL Special Types into SmartDesign?
To work with a VHDL file with Special Types you must:

1. Drag and drop the entity into SmartDesign and connect it just as you would with any other
SmartDesign instance.

2. Generate the Mapping File (meta.out):
Navigate to the Design Hierarchy view, under the current SmartDesign.
Right-click every VHDL file or every top hierarchical file and choose Create Mapping File (VHDL).

3. Generate the SmartDesign
4.  Continue with the Libero SoC Design Flow steps (Synthesis, Simulation, etc.)
If you do not generate the Mapping File, and try to Generate your SmartDesign, you will see the following

error in the log window:

Error: Select the HDL file in the Design Hierarchy and right-click the HDL file and
choose Create Mapping File(VHDL) because at least one entity port is of type Array or
Record.

The above is reported only if the entity port is of type Record, Array, Array of Array, or Unsigned.
What is the purpose of the mapping file?

The mapping file contains the mapping information between the SmartDesign ports and original user-
specified data types of ports in design files, and is used for type casting of signals during design generation.

Where will the mapping file meta.out be generated?
The file is generated in your $project_dir/hdl folder. This file will be used to during SmartDesign generation.
What are the VHDL special types that are not generated automatically?
The following types are not automatically generated from the right-click menu option Create Mapping
File(VHDL):
e Array of array is not supported
e Array of record is not supported
e Enum in range of array is not supported.
e Constants are not supported.
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e Buffer output ports are not supported
What do | do if  am using VHDL types that are not generated automatically?

You must manually write the mapping information in the meta.out file for unsupported types (types which are
not generated automatically) in the prescribed format. Click the link to see an example.

e Integer
e Unsigned

e Array and Array of Arrays

e Record
What is the meta.out file format?
See the meta.out file format topic for more information.

Making your Design Look Nice

Can the tool automatically place my instances on the Canvas to make it look nice?
Yes. Right-click the Canvas white space and choose Auto Arrange Instances.
My design has a lot of connections, and the nets are making my design hard to read. What do | do?

You can disable the display of the nets in the menu bar (RMC > Hide Nets). This automatically hides all the
nets in your design.

You can still see how pins are connected by selecting a connected pin, the net will automatically be visible
again.

You can also selectively show certain nets, so that they are always displayed, just right click on a connected
pin and choose Show Net.

My instance has too many pins on it; how can | minimize that?

Try grouping functional or unused pins together. For example, on the Corelnterrupt there are 8 FIQSource*
and 32 IRQSource* pins, group these together since they are similar in functionality.

To group pins: Select all the pins you want to group, then right-click one of the pins and choose Add pins to
group.

If a pin is in a group, you are still able to use it and form connections with it. Expand the group to gain
access to the pin.

Oops, | missed one pin that needs to be part of that group? How do | add a pin after | already have the
group?

Select the pin you want to add and the group pin, right-click and choose Add pins to <name> group.
I have a pin that | don’t want inside the group, how do | remove it?

Right-click the pin and choose Ungroup selected pins.
How can | better see my design on the Canvas?

There are zoom icons in the Canvas toolbar. Use them to Zoom in, Zoom out, Zoom to fit, and Zoom
selection. You can also maximize your workspace with CTRL-W.

Generating your Design

Ok, I'm done connecting my design, how do | ‘finish’ it so that | can proceed to synthesis?
In the Canvas toolbar, click the Generate Project icon .

| get a message saying it's unable to generate my SmartDesign due to errors, what do |1 do? What is the
Design Rules Check?

The Design Rules Check is included in your Report View. It lists all the errors and warnings in your design,

including unconnected input pins, required pin connections, configuration incompatibilities between cores,
etc.
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Errors are shown with a small red stop sign and must be corrected before you can generate; warnings may
be ignored.

What does this error mean? How do | fix it?

Review the Design Rules Check topic for an explanation of errors in the Design Rules Check and steps to
resolve them.

How do | generate my firmware?

In the Design Flow window, expand Handoff Design for Firmware Development and double-click
Configure Firmware Coresand Export Firmware.

Getting Started With SmartDesign

Creating a New SmartDesign Component

1. From the File menu, choose New > SmartDesign or in the Design Flow window double-click Create
SmartDesign. The Create New SmartDesign dialog box opens (see figure below).

I Create New SmartDesign

MNarne:
|

o | ]

Figure 12 - Create New SmartDesign Dialog Box

2. Enter a component name and click OK. The component appears in the Hierarchy tab of the Design
Explorer. Also, the main window displays the design Canvas.

Note: The component name must be unique in your project.

Opening an Existing SmartDesign Component

To open an existing component do one of the following:
Click the Design Hierarchy tab and double-click the component you want to open.
The main window displays the SmartDesign Canvas for the SmartDesign component.

Saving/Closing a SmartDesign Component

To save the current SmartDesign design component, from the File menu, choose Save
<component_name>. Saving a SmartDesign component only saves the current state of the design; to
generate the HDL for the design refer to Generating a SmartDesign component.

To close the current SmartDesign component without saving, from the File menu, choose Close. Select NO
when prompted to save.

To save the active SmartDesign component with a different name use Save As. From the File menu choose
Save SD_<filename> As. Enter a new name for your component and click OK.

Generating a SmartDesign Component

Before your SmartDesign component can be used by downstream processes, such as synthesis and

simulation, you must generate it.
——
=

Click the Generate button to generate a SmartDesign component.
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This will generate a HDL file in the directory <libero_project>/components/<library>/<yourdesign>.

Note: The generated HDL file will be deleted when your SmartDesign design is modified and
saved to ensure synchronization between your SmartDesign component and its generated
HDL file.

Generating a SmartDesign component may fail if there are any DRC errors. DRC errors must be corrected
before you generate your SmartDesign design.

Generating a Datasheet (SmartFusion, IGLOOe, ProASIC3L, ProASIC3E, Fusion)

If your SmartDesign is the root design in your project, then a Memory Map / Datasheet that contains your
design information is produced.

Generating Firmware and Software IDE Workspace (SmartFusion, IGLOOe, ProASIC3L, ProASIC3E,

Fusion)

If your SmartDesign is the root design in your project, then any compatible firmware drivers for your
peripherals are generated to <project>/firmware.

The datasheet provides all the specifics of the generated firmware drivers.

Importing a SmartDesign Component

From the File menu, choose Import and select the CXF file type.

Importing an existing SmartDesign component into a SmartDesign project will not automatically import the
sub-components of that imported SmartDesign component.

You must import each sub-component separately.

After importing the sub-components, you must open the SmartDesign component and replace each sub-
component so that it references the correct component in your project. .

Deleting a SmartDesign Component from the Libero SoC Project

To delete a SmartDesign component from the project:
1. Inthe Design Hierarchy tab, select the SmartDesign component that you want to delete.

2. Right-click the component name and select Delete from Project or Delete from Disk and Project, or
click the Delete key to delete from project.

Memory Maps / Data Sheet

If your design contains standard Bus Instances such as the DirectCore AMBA bus cores, CoreAPB or
CoreAHB, then you can view the Memory Map Configuration of your design in the Report View. To do so,
generate your top level design and click the Reports button in the toolbar.

The design’s memory map is determined by the connections made to the bus component. A bus component
is divided into multiple slots for slave peripherals or instances to plug into. Each slot represents a different
address location and range to the Master of the bus component.

The datasheet reports the memory map of the different subsystems of your design, where a subsystem is
any independent bus structure with a Master and Slave peripheral attached.

Connecting peripherals to busses can be accomplished using the normal SmartDesign connectivity options:

e Auto-Connect - the system creates a bus structure based on the peripherals that you have
instantiated and finds compatible bus interfaces and connects them together

e The Modify Memory Map dialog box
e Canvas - Make connections between your blocks.
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Your application and design requirements dictate which address location (or slots) is most suitable for your
bus peripherals. For example, the memory controller should be connected to Slot0 of the CoreAHB bus
because on Reset, the processor will begin code execution from the bottom of the memory map.

An example of the datasheet is shown in the figure below.

Data Sheet: SDTOP

Project Settings

FAM: Fusion

Die: AFSEBO0

Package: 256 FEGA

HDL: Yerllog

Location: C:/Documents and Settingsiarleyc/Desktopfarleyc_Actelpri_84My First SmanDesignfcomponenthwork/SDTORP

State: NOTREADY

Table of Contents

Cores
Memory Map
10%s
Port Name Direction Pin 110 Standard
VAREF INOUT - LWTTL
cl_W IM - LVTTL
cl N - LVTTL
Wl IN - LWTTL
- v : _.|—|

Figure 13 - Example Memory Map

Modify Memory Map Dialog Box

The Modify Memory Map dialog box (shown in the figure below) enables you to connect peripherals to buses
via a drop-down menu. To open the dialog box, right-click the bus instance and choose Modify Memory
Map.

This dialog simplifies connecting peripherals to specific base addresses on the bus. The dialog shows all the
busses in the design; select a bus in the left pane to assign or view the peripherals on a bus. Busses that
are bridged to other busses are shown beneath the bus in the hierarchy.
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Figure 14 - Modify Memory Map Dialog Box

Click the Peripheral drop-down menu to select the peripheral you wish to assign to each address. To
remove (unassign) a peripheral from an address, click the drop-down and select the empty element.

Click OK to create the connections between the busses and peripherals in the design.
Finding Ports/Nets/Instances in SmartDesign

Use the Find Window to search for ports, nets, or instances in SmartDesign.
Searching for ports / nets / instances in SmartDesign highlights the objects on the Canvas.

Canvas View

Canvas Overview

The SmartDesign Canvas is like a whiteboard where functional blocks from various sources can be
assembled and connected; interconnections between the blocks represent nets and busses in your design.

You can use the Canvas to manage connections, set attributes, add or remove components, etc. The
Canvas displays all the pins for each instance (as shown in the figure below).

The Canvas enables you to drag a component from the Design Hierarchy or a core from the Catalog and
add an instance of that component or core in the design. Some blocks (such as Basic Blocks) must be
configured and generated before they are added to your Canvas. When you add/generate a new component
it is automatically added to your Design Hierarchy.

To connect two pins on the Canvas, click the Connection Mode button to enable it and click and drag
between the two pins you want to connect. The Connection Mode button is disabled if you attempt to illegally
connect two pins.

Click the Maximize Work Area button to hide the other windows and show more of the Canvas. Click the
button again to return the work area to the original size.

The Canvas displays bus pins with a + sign (click to expand the list) or - (click to hide list). If you add a slice
on a bus the Canvas adds a + to the bus pin.

Components can be reconfigured any time by double-clicking the instance on the Canvas. You can also add
bus interfaces to instances using this view. In the Canvas view, you can add graphic objects and text to your
design.

Inputs and bi-directional pins are shown on the left of components, and output pins are shown on the right.
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Figure 15 - SmartDesign Canvas

See Also
Canvas Icons

Displaying Connections on the Canvas

The Canvas shows the instances and pins in your design (as shown in the figure below). Right-click the
Canvas and choose Show Net Names to display nets.
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Figure 16 - Components in SmartDesign

Pin and Attribute Icons

Unconnected pins that do not require a connection are gray. ’
Unconnected pins that require a connection are red.
Unconnected pins that have a default tie-off are pale green.

Connected pins are green. .

Right-click a pin to assign an attribute.

Pins assigned attributes are shown with an icon, as shown in the table below.
Table 2 - Pin Attribute Icons

Attribute Icon

Tie Low

s

a

Tie High
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Attribute

Icon

Invert

Mark as Unused

Tie to Constant

5] 4

See the Canvas Icons reference page for definitions for each element on the Canvas.

Each connection made using a bus interface is shown in a separate connection known as a bus-interface

net.

Move the mouse over a bus interface to display its details (as shown below).

Hover over a bus interface net to see details (as shown below).

Mame: |AHBmslavel

Role:  |mirroredSlaye

State: |Connected

Pin Map

Formal

Actual

HADDR.

HADDR_S1[31:0]

HTRAMNS

HTRAMNS_51[1:0]

HWRITE

HWRITE_S1

H3IZE

H5IZE_51[2:0]

HWDATA

HWDATA_S1[31:0]

H3ELx

HSEL_S1

HROATA

HRODATA_S1[31:0]

HREAD

HREADY_51

HMASTLOCK

HMASTLOCK _S1

HREADYOUT

HREADYCOUT_S1

HRESP

HRESP_S1[1:0]

HEURST

HEURST_51[2:0]

HPROT

HPROT_51[3:0]

smarkfusion

Scalar: smartfusion_project_MSS_D_FAB_CLK

Making Connections Using the Canvas

roject MSS_0)

Use the Canvas or Connectivity dialog box to make connections between instances.

You can use Connection Mode on the Canvas to quickly connect pins. Click the Connection Mode button to
start, then click and drag between any two pins to connect them. lllegal connections are disabled. Click the
Connection Mode button again to exit Connection Mode.

To connect two pins on the Canvas, select any two (Ctrl + click to select a pin), right-click one of the pins
you selected and choose Connect. lllegal connections are disabled; the Connect menu option is

unavailable.
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Promoting Ports to Top Level

To automatically promote a port to top level, select the port, right-click, and choose Promote To Top Level.
This automatically creates top-level ports of that name and connects the selected ports to them. If a port
name already exists, a choice is given to either connect to the existing ports or to create a new port with a
name <port name>_<i>where i =1...n.

Double-click a top-level port to rename it.

Bus slices cannot be automatically promoted to top level. You must create a top level port of the bus slice
width and then manually connect the bus slice to the newly created top level port.

Tying Off Input Pins

To tie off ports, select the port, right-click and choose Tie High or Tie Low.

Tying to Constant

To tie off bus ports to a constant value, select the port, right-click and choose Tie to a Constant. A dialog
appears (as shown in the figure below) and enables you to specify a hex value for the bus.

To remove the constant, right-click the pin and choose Clear Attribute or Disconnect.

@ Tie to Constant - RXD[3:0]

Enter a HEX walue: 0x |0

(00 ko 0xF)

[ Ik ] [ Cancel

Figure 17 - Tie to Constant Dialog Box

Making Driver and Bus Interface Pins Unused

Driver or bus interface pins can be marked unused (floating/dangling) if you do not intend to use them as a
driver in the design. If you mark a pin as unused the Design Rules Check does not return Floating Driver or
Unconnected Bus Interface messages on the pin.

Once a pin is explicitly marked as unused it cannot be used to drive any inputs. The unused attribute must
be explicitly removed from the pin in order to connect it later. To mark a driver or bus interface pin as
unused, right-click the driver or bus interface pin and choose Mark as Unused.

See Also
Show/Hide Bus Interface Pins

Simplifying the Display of Pins on an Instance using Pin Groups

The Canvas enables you to group and ungroup pins on a single instance to simplify the display. This feature
is useful when you have many pins in an instance, or if you want to group pins at the top level. Pin groups
are cosmetic and affect only the Canvas view; other SmartDesign views and the underlying design are not
affected by the pin groups.

Grouping pins enables you to:
e Hide pins that you have already connected
e Hide pins that you intend to work on later

40
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e Group pins with similar functionality
e Group unused pins
e Promote several pins to Top Level at once
To group pins:
1. Ctrl + click to select the pins you wish to group. If you try to click-and-drag inside the instance you will
move the instance on the Canvas instead of selecting pins.

2. Right-click and choose Add pins to group to create a group. Click + to expand a group. The icon
associated with the group indicates if the pins are connected, partially connected, or unconnected (as
shown in the figure below).

smartfusion_project_MSS_0

_ [ MES RESETN FAB_CLK
M2F_RESET_N
UART_IE
MAC_RMIT_PHY_MEMT_PADs
MAC_RMIT_DATA_PADSE]
MAC_R¥D[1:0]
MRC_TAD[1:0]
MAC _CRSDY
MAT_RXER
MRC_THEN

MES_IMASTER_AHE_LITE

gF I,

&

Figure 18 - Groups in an Instance on the Canvas
To add a pin to a group, Ctrl + click to select both the pin and the group, right-click and choose Add pin to
group.
To name a group:
To name a group, right-click the port name and choose Rename Group.

To ungroup pins:

1. Click + to expand the group.

2. Right-click the pin you wish to remove from the group and choose Ungroup selected pins. Ctrl + click
to select and remove more than one pin in a group.

A group remains in your instance after you remove all the pins. It has no effect on the instance; you can
leave it if you wish to add pins to the group later, or you can right-click the group and choose Delete Group
to remove it from your instance.

If you delete a group from your instance any pins still in the group are unaffected.

To promote a group to Top level:

1. Create a group of pins.
2. Right-click the group and choose Promote to Top Level.

Bus Instances

Bus Components in the Core Catalog, such as CoreAHB or CoreAPB, implement an on-chip bus fabric.
When these components are instantiated into your canvas they are displayed as horizontal or vertical lines.
Double-click the bus interfaces of your component to edit the connections.
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Figure 19 - Bus Instance in SmartDesign
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Adding Graphic Objects

You can document your design by adding comments and notations directly on the Canvas.

The Canvas toolbar enables you to add and modify decorative graphic objects, such as shapes, labels and
lines on the Canvas.

Adding and Deleting Lines and Shapes

To add aline or a shape:

1. Select the line or shape button.
2. Click, drag and release on the Canvas. The table below provides a description of each button.

Button Description

\ Line

Rectangle

O

Note: Hold the Shift key to constrain line and arrow to 45 degree increments or constrain the
proportions of the rectangle (square).
To change the line and fill properties:
1. Select the element(s), right-click it, and choose Properties.
e Select Line to modify the color, style and width of the line.
e Select Fill to modify the crosshatch and the foreground and background colors.
2. Click OK.
To delete a line or shape, select the object and press Delete.

Adding Text

To add text, select the text tool and click the Canvas to create a text box. To modify the text, double-click the
text box and then type.
To modify the text box properties:

1. Select the text box, right-click it, and choose Properties.

e Select Text to modify the text alignment.

e Select Line to modify the color, style and width of the line.

e Select Fill to modify the crosshatch and the foreground and background colors.

e Select Font to modify the font properties.

2. Click OK.

42 Libero SoC User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi
Create and Verify Design

Editing Properties for Graphic Objects on the Canvas

Right-click any graphic object to update properties, such as Fill, and Line properties for shapes and lines, or
Font options for text properties.

Auto-Arranging Instances

Right-click the Canvas and choose Auto Arrange Instances from the right-click menu to auto-arrange the
instances on the Canvas.

Locking Instance and Top Level Port Positions

You can lock the placement of instances on the Canvas. Right-click the instance or Top-level port and
choose Lock to lock the placement. When you lock placement you can click and drag to move the instance
manually but the Auto Arrange Instances menu option has no effect on the instance.

To unlock an instance, right-click the instance and choose Unlock.
Right-click a top level port and choose Unlock Position to return it to its default position.

See Also
Bus Instances
Simplifying the Display of Pins on an Instance using Pin Groups

Replace Component for Instance

You can use the Replace Component for Instance dialog box (shown in the figure below) to restore or
update version instances on your Canvas without creating a new instance and losing your connections.

Replace Component for Instance(s) HE

Instanceis)

Mame: RAM_SAVE_O

Current Component File
RAM_SAVE Ci\Documents and Set.. AM_SAVEIRAM_SAYE. cxf

Choose an entry from the list of possible replacements for component 'RAM_SAVE":

Component File =

socuments and Setting...gn2ismartgentASELAS

COMP_AE Ci\Documents and Settin...gent COMP_ABYCOMP_AR. cxf

FME Ci\Documents and Setting...gn2ismartgent FRBYFIME, cxf
MEMUXBLE Ci\Documents and Settin.. mMGMUXBLKAMGMUXBLE cxf ||
RAM_SAVE CiDocuments and Settin.. miRAM_SAVEIRAM_SAYE. cxf
RCOSCELE CiDocuments and Settin.. mRCOSCELKARCOSCELK, cxf
SD_ClockBlock Ci\Documents and Settings.. ckBlocklSD_ClockBlock, cxf
WREBLK Ci\Documents and Setting.. smartgenYRELK\YRELK, cxf LI

Help | OF I Cancel |

Figure 20 - Replace Component for Instance Dialog Box

To change the version of an instance:

1. From the right-click menu choose Replace Component for Instance. The Replace Component for
Instance dialog box appears.

2. Select a component and choose a new version from the list. Click OK.
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Replace Instance Version

The Replace Instance Version dialog box enables you to replace an IP instance with another version. You
can restore or replace your IP instance without creating a new instance or losing your connections.

Ml Replace Instance Yersion EHE
Instance: CORE1O100_0
Core Name Yendor Library ¥Yersion | Change to Yersion
COREL0100 Actel DirectCore 40143 | 33 ¢

Help | OF I Cancel |

Figure 21 - Replace Instance Version Dialog Box

To replace an instance version:
1. Rightclick any IP instance and choose Replace Instance Version. The dialog box appears.

2. Choose the version you wish to use from the Change to Version dropdown menu (as shown in the
figure above) and click OK to continue.

Slicing
Bus ports can be sliced or split using Slicing. Once a slice is created, other bus ports or slices of compatible
size can be connected to it.
The Edit Slices dialog box enables you to automatically create bus slices of a specified width.

To create a slice:

1. Select a bus port, right-click, and choose Edit Slice. This brings up the Edit Slices dialog box (see
figure below).

Il Edit Slices - HRDATA[31:0]

Create |32 :l slices of width |1 V| [ &dd Slices ]
x
HRDATA[31:0] <3] Left Right S
1 0 ]
2 1 1
3 Z z
4 3 3
5 4 4
& 5 5
7 o] [
g 7 7
g g & il
% oo

Figure 22 - Edit Slices Dialog Box

2. Enter the parameters for the slice and click Add Slices. You can also create individual slices and
specify their bus dimensions manually.

3. Click OK to continue.
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Note: Overlapping slices cannot be created for IN and INOUT ports on instances or top-level OUT
ports.

To remove a slice, select the slice, right-click, and choose Delete Slice.

Rename Net

To rename a net:
1. Right-click the net on the Canvas and choose Rename Net. This opens the Rename Net dialog box.
2. Type in a new name for the net.

Note: The system automatically assigns net names to nets if they are not explicitly specified.
Once you have specified a name for a net, that name will not be over-written by the system.

Automatic Names of Nets

Nets are automatically assigned names by the tool according to the following rules:
In order of priority
1. If user named then name = user name

2. If netis connected to top-level port then name = port name; if connected to multiple ports then pick first
port

3. If the net has no driver, then name = net_]i]
4. If the net has a driver, name = instanceName_driverpinName
Slices

For slices, name = instanceName_driverpinName_sliceRange; for example
u0_outl_4to6.

GND and VCC Nets

The default name for GND/VCC nets is net_GND and net_VCC.

Expanded Nets for Bus Interface Connections

Expanded nets for bus interface connections are named businterfaceNetName_<i>_driverPinName.

Organizing Your Design on the Canvas

You may find it easier to create and navigate your SmartDesign if you organize and label the instances and
busses on the Canvas.

You can show and hide nets, lock instances, rotate busses, group and ungroup pins, rename instances /
groups / pins, and auto-arrange instances.

To organize your design:

1. Right-click the Canvas and choose Auto Arrange Instances from to automatically arrange instances.
SmartDesign's auto-arrange feature optimizes instance location according to connections and instance
size.

2. Right-click any instance and choose Lock Location to fix the placement. Auto-Arrange will not move
any instances that are locked.

3. Click Auto-Arrange again to further organize any unlocked instances. Continue arranging and locking
your instances until you are satisfied with the layout on the Canvas.

If your design becomes cluttered, group your pins. It may help to group pins that are functionally similar, or
to group pins that are already connected or will be unused in your design.

To further customize your design's appearance:

Double-click the names of instances to add custom names. For example, it may be useful to rename an
instance based on a value you have set in the instance: the purpose of an instance named
‘array_adder_bus_width_5'is easier to remember than ‘array_adder_0'.
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Adding Components and Modules (Instantiating)

SmartDesign components, Design Block cores, IP cores, and HDL modules are displayed in the Design
Hierarchy and Files tabs.

To add a component, do either of the following:

e Select the component in the Design Hierarchy tab or Catalog and drag it to the Canvas.

¢ Right-click a component in the Design Hierarchy tab or Catalog and choose Instantiate in
<SmartDesign name>.

The component is instantiated in the design.

SmartDesign creates a default instance name. To rename the instance, double-click the instance name in
the Canvas.

Adding a SmartDesign Component
SmartDesign components can be instantiated into another SmartDesign component.

Once a SmartDesign is generated, the exported netlist can be instantiated into HDL like any other HDL
module.

Note: HDL modules with syntax errors cannot be instantiated in SmartDesign. However, since
SmartDesign requires only the port definitions, the logic causing syntax errors can be
temporarily commented out to allow instantiation of the component.

Adding or Modifying Top Level Ports
You can add ports to, and/or rename ports in your SmartDesign.
Add Prefixes to Bus Interface / Group Names on Top-level Ports:

Bus Interfaces and Groups are composed of other ports. On the top level, you can add prefixes to the group
or bus interface port name to the sub-port names. To do so, right-click the group or bus interface port and
choose Prefix <name> to Port Names.

Adding/Renaming Ports

To add ports:
1. From the SmartDesign menu, choose Add port. The Add Port dialog box appears (as shown below).
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Figure 23 - Add New Port Dialog Box

2. Specify the name of the port you wish to add. You can specify a bus port by indicating the bus width
directly into the name using brackets [ ], such as mybus[3:0].

3. Select the direction of the port.
To remove a port from the top level, right-click the port and choose Delete Top Level Port.

Modify Port

To rename a top-level port, right-click the top-level port and choose Modify Top Level Port. You can
rename the port, change the bus width (if the port is a bus), and change the port direction.

Right-click a top-level port and choose Modify Port to change the name and/or direction (if available).

See Also
Top Level Connections

Connecting Instances
Automatic Connections

Using automatic connections (as shown in the figure below) enables the software to connect your design
efficiently, reducing time required for manual connections and the possibility of introducing errors.

Auto Connect also constructs your bus structure if you have a processor with peripherals instantiated. Based
on the type of processor and peripherals, the proper busses and bridges are added to your design.

To auto connect the bus interfaces in your design, right-click the design Canvas and select Auto Connect,
or from the SmartDesign menu, choose Auto Connect.

SmartDesign searches your design and connects all compatible bus interfaces.

SmartDesign will also form known connections for any SoC systems such as the processor CLK and RESET
signals.

If there are multiple potential interfaces for a particular bus interface, Auto Connect will not attempt to make
a connection; you must connect manually. You can use the Canvas to make the manual connections.
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Figure 24 - Auto-Connected Cores

QuickConnect

The QuickConnect dialog box enables you to make connections in your design without using the Canvas. It
is useful if you have a large design and know the names of the pins you wish to connect. Connections are
reflected in the Canvas as you make them in the dialog box; error messages appear in the Log window

immediately. It may be useful to resize the QuickConnect dialog box so that you can view the Log window or
Canvas while you make connections.
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To connect pins using QuickConnect:

1. Find the Instance Pin you want to connect and click to select it.

2. InPins to Connect, find the pin you wish to connect, right-click and choose Connect. If necessary,
use the Search field to narrow down the list of pins displayed in Pins to Connect.

Note: If the connection is invalid, Connect is grayed out.

If you wish to invert or tie a pin high, low or Mark Unused:
1. Find the Instance Pin you want to invert or tie high/low
2. Right-click Connection and choose Invert, Tie High, Tie Low or Mark Unused.
If you wish to promote a pin to the top level of your design:
1. Find the Instance Pin you want to promote.
2. Right-click the pin and choose Promote to Top.

You can perform all connectivity actions that are available in the Canvas, including: slicing bus pins, tying
bus pins to a constant value, exposing pins from a bus interface pins and disconnecting pins. All actions are
accessible from the right-click context menu on the pin.

Instance Pins lists all the available instance pins in your design and their connection (if any). Use the drop-
down list to view only unconnected pins, or to view the pins and connections for specific elements in your
design.

Pins to Connect lists the instances and pins in your design. Use the Search field to find a specific instance
or pin. The default wildcard search is *.*'. Wildcard searches for CLK pins (*.*C*L*K) and RESET pins
(*.*R*S*T) are also included.

Here are some of the sample searches that you may find useful:
e *UART*.*: show all pins of any instances that contain UART in the name
e MyUART_O0.*: only show the pins of the “MyUART_0" instance
e *.p: show all pins in the design that contain the letter ‘p’

Double-click an instance in Pins to Connect to expand or collapse it.

The pin letters and icons in the QuickConnect dialog box are the same as the Canvas icons and
communicate information about the pin. Inputs, Outputs and I/Os are indicted by I, O, and /O, respectively.

Additional information is communicated by the color:
¢ Red - Mandatory connection, unconnected
e Green - Connected
e Grey - Optional, unconnected pin
e Brown - Pad
e Light Green - Connected to a default connection on generation
e Blue - Driver pin
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Figure 25 - QuickConnect Dialog Box

Manual Connections

You can use Connection Mode to click and drag and connect pins. Click the Connection Mode button to
toggle it, and click and drag between any two pins to connect them. lllegal connections will not be allowed.

To make manual connections between to pins on the Canvas, select both pins (use CTRL + click), right-click
either pin and choose Connect. If the pins cannot be legally connected the connection will fail.

Deleting Connections

To delete a net connection on the Canvas, click to select the net and press the Delete key, or right-click and
choose Delete.

To remove all connections from one or more instances on the Canvas, select the instances on the Canvas,
right-click and choose Clear all Connections. This disconnects all connections that can be disconnected
legally.

Certain connections to ports with PAD properties cannot be disconnected. PAD ports must be connected to
a design’s top level port. PAD ports will eventually be assigned to a package pin. In SmartDesign, these
ports are automatically promoted to the top level and cannot be modified or disconnected.

50
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Top-Level Connections

Connections between instances of your design normally require an OUTPUT (Driver Pin) on one instance to
one or more INPUT(s) on other instances. This is the basic connection rule that is applied when connecting.

However, directions of ports at the top level are specified from an external viewpoint of that module. For
example, an INPUT on the top level is actually sending (‘driving’) signals to instances of components in your
design. An OUTPUT on the top level is receiving (‘sinking’) data from a Driver Pin on an internal component
instance in your SmartDesign design.

The implied direction is essentially reversed at the top-level. Making connections from an OUTPUT of a
component instance to an OUTPUT of top-level is legal.

This same concept applies for bus interfaces; with normal instance to instance connections, a MASTER
drives a SLAVE interface. However, they go through a similar reversal on the top-level.

Bus Interfaces
About Bus Interfaces

A bus interface is a standard mechanism for specifying the interconnect rules between components or
instances in a design. A bus definition consists of the roles, signals, and rules that define that bus type. A
bus interface is the instantiation of that bus definition onto a component or instance.

The available roles of a bus definition are master, slave, and system.
A master is the bus interface that initiates a transaction (such as read or write) on a bus.
A slave is the bus interface that terminates/consumes a transaction initiated by a master interface.

A system is the bus interface that does not have a simple input/output relationship on both master/slave.
This could include signals that only drive the master interface, or only drive the slave interface, or drive both
the master and slave interfaces. A bus definition can have zero or more system roles. Each system role is
further defined by a group name. For example, you may have a system role for your arbitration logic, and
another for your clock and reset signals.

Mirror roles are for bus interfaces that are on a bus core, such as CoreAHB or CoreAPB. They are
equivalent in signal definition to their respective non-mirror version except that the signal directions are
reversed.

The diagram below is a conceptual view of a bus definition.
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Figure 26 - Bus Definition

See Also:
Using bus interfaces in SmartDesign

Using Bus Interfaces in SmartDesign

Adding bus interfaces to your design enables SmartDesign to do the following:
¢ Auto connect compatible interfaces
e Enforce DRC rules between instances in your design

e Search for compatible components in the project

The Catalog in the Project Manager contains a list of Microsemi SoC-specific and industry standard bus
definitions, such as AMBA.

You can add bus interfaces to your design by dragging the bus definitions from the Bus Interfaces tab in the
Catalog onto your instances inside SmartDesign.

SmartDesign supports automatic creation of data driven configurators based on HDL generics/parameters.

If your block has all the necessary signals to interface with the AMBA bus protocol ( ex: address, data,
control signals):
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1. Right-click your custom HDL block and choose Create Core from HDL. The Libero SoC creates your
core and asks if you want to add bus interfaces.

2. Click Yes to open the Edit Core Definition dialog box and add bus interfaces. Add the bus interfaces as
necessary.

3. Click OK to continue.
Now your instance has a proper AMBA bus interface on it. You can manually connect it to the bus or let Auto
Connect find a compatible connection.
Some cores have bus interfaces that are instantiated during generation.

Certain bus definitions cannot be instantiated by a user. Typically these are the bus definitions that define a
hardwired connection and are specifically tied to a core/macro. They are still available in the catalog for you
to view their properties, but you will not be able to add them onto your own instances or components. These
bus definitions are grayed out in the Catalog.

A hardwired connection is a required silicon interconnect that must be present and specifically tied to a
core/macro. For example, when using the Real Time Counter in a Fusion design you must also connect it to
a Crystal Oscillator core.

Maximum masters allowed - Indicates how many masters are allowed on the bus.
Maximum slaves allowed - Indicates how many slaves are allowed on the bus.

Default value - indicates the value that the input signal will be tied to if unused. See Default tie-offs with bus
interfaces.

Required connection - Indicates if this bus interface must be connected for a legal design.

Adding or Modifying Bus Interfaces in SmartDesign

SmartDesign supports automatic creation of data driven configurators based on HDL generics/parameters.
You can add a bus interface from your HDL module or you can add it from the Catalog.

To add a bus interface using your custom HDL block:

If your block has all the necessary signals to interface with the AMBA bus protocol (such as address, data,
and control signals):
1. Right-click your custom HDL block and choose Create Core from HDL. The Libero SoC creates your
core and asks if you want to add bus interfaces.

2. Click Yes to open the Edit Core Definition dialog box and add bus interfaces. Add the bus interfaces as
necessary.

3. Click OK to continue.
Now your instance has a proper AMBA bus interface on it. You can manually connect it to the bus or let Auto
Connect find a compatible connection.
To add (or modify) a bus interface to your Component:

1. Right-click your Component and choose Edit Core Definition. The Edit Core Definition dialog box
opens, as shown in the figure below.
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EN Edit Core Definition - Bus Interfaces
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Module:  test_hdl_plus

#dd Bus Interface,., Remaove
—Bus Interfaces on this core: — —Configure bus interface details:
EIF_1 Bus interface (APE): @ [BIF_t
Map by Mame Prefisx I
Bus Definition Care
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Figure 27 - Edit Core Definition Dialog Box
2. Click Add Bus Interface. Select the bus interface you wish to add and click OK.
3. If necessary, edit the bus interface details.

4. Click Map by Name to map the signals automatically. Map By Name attempts to map any similar
signal names between the bus definition and pin names on the instance. During mapping, bus
definition signal names are prefixed with text entered in the Map by Name Prefix field.

5. Click OK to continue.
Bus Interface Details

Bus Interface: Name of bus interface. Edit as necessary.
Bus Definition: Specifies the name of the bus interface.
Role: Identifies the bus role (master or slave).

Vendor: Identifies the vendor for the bus interface.
Version: Identifies the version for the bus interface.

Configuration Parameters

Certain bus definitions contain user configurable parameters.
Parameter: Specifies the parameter name.
Value: Specifies the value you define for the parameter.

Consistent: Specifies whether a compatible bus interface must have the same value for this bus parameter.
If the bus interface has a different value for any parameters that are marked with consistent set to yes, this
bus interface will not be connectable.
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Signal Map Definition

The signal map of the bus interface specifies the pins on the instance that correspond to the bus definition
signals. The bus definition signals are shown on the left, under the Bus Interface Definition. This
information includes the name, direction and required properties of the signal.

The pins for your instance are shown in the columns under the Component Instance. The signal element is a
drop-down list of the pins that can be mapped for that definition signal. .

If the Req field of the signal definition is Yes, you must map it to a pin on your instance for this bus interface
to be considered legal. If it is No, you can leave it unmapped.

Bus Interfaces

When you add a bus interface the Edit Core Definition dialog box provides the following Microsemi SoC-
specific bus interfaces:

RTCXTL
This bus interface represents the hardwired connection needed between the Real Time Counter and the
Crystal Oscillator.

RTCVR

This bus interface represents the hardwired connection needed between the Real Time Counter and the
Voltage Regulator Power Supply Monitor.

InitCfg
This is the initialization and configuration interface that is generated as part of the Flash Memory Builder.

Any clients can be initialized from the Flash Memory as long as it can connect to this bus interface. This is
for pure initialization clients that do not require save-back to the Flash Memory.

InitCfgSave

This is the initialization and configuration interface that is generated as part of the Flash Memory Builder.
Any client can be initialized or saved-back to the Flash Memory as long as it can connect to this bus
interface. This is for clients that require initialization and save-back capabilities to the Flash Memory.

This interface is used to initiate the save-back procedure of the Flash Memory.
InitCfgAnalog
FlashDirect

This bus interface defines the set of signals that are required to interface directly to the Flash Memory. From
the Flash Memory, if you add a data storage client, this interface will be exported. Interfacing to this interface
enables direct access to the Flash Memory.

XTLOscClk

This interface represents the Crystal Oscillator clock.
RCOscClk

This interface represents the RC Oscillator clock.

DirectCore Bus Interfaces

When you add a bus interface the Edit Core Definition dialog box provides the following DirectCore bus
interfaces.

AHB

The AMBA AHB defines the set of signals for a component to connect to an AMBA AHB or AHBLite bus.
The bus interface that is defined in the system is a superset of the signals in the AHB and AHBLite protocol.
You can use the AHB bus interface in the bus definition catalog to connect your module to an AHB or
AHBLite bus.

Libero SoC User's Guide 55



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
= = when clicked. View the online help included with software to enable all linked content.
& Microsemi

APB

The AMBA APB defines the set of signals for a component to connect to an AMBA APB or APB3 bus. The
bus interface that is defined in the system is a superset of the signals in the APB and APB3 protocol. You
can use the APB bus interface in the bus definition catalog to connect your module to an APB or APB3 bus.

Syslinterface

The Sysinterface is the interface used between the CoreMP7 and CoreMP7Bridge cores.
DBGiInterface

This is the set of debug ports on the CoreMP7 core.
CPInterface

This is the co-processor interface on the CoreMP7 core.

Show/Hide Bus Interface Pins

Pins that are contained as part of a bus interface will automatically be filtered out of the display. These ports
are considered to be connected and used as part of a bus interface.

However, there are situations where you may wish to use the ports that are part of the bus interface as an
individual port, in this situation you can choose to expose the pin from the bus interface.

To Show/Hide pins in a Bus Interface:

1. Select a bus interface port, right-click, and choose Show/Hide BIF Pins. The Show/Hide Pins to
Expose dialog box appears (as shown below).

Pins to Expose - "APBmslavel5’ on ‘CoreAPB_O¢

PADDRS[23:0]
PWRITES
PEMABLES
PWDATAS[31:0]
PRDATAS1S[31:0]
PSELS1S

OEROEODOO

o (==

Figure 28 - Expose Driver Pin Dialog Box

2. Click the checkbox associated with the driver pin you want to show. Once the port is shown it appears
on the Canvas and is available for individual connection.

Note: If you have already connected the bus interface pin, then you will not be able to expose the non-
driver pins. They will be shown grayed out in the dialog. This is to prevent the pin from being
driven by two different sources.

To un-expose a driver pin, right-click the exposed port and choose Show/Hide BIF Pins and de-select the
pin.

Default Tie-offs with Bus Interfaces

Bus definitions can contain default values for each of the defined signals. These default values specify what
the signal should be tied to if it is mapped to an unconnected input pin on the instance.
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Bus definitions are specified as_required connection vs optional connection that defines the behavior of tie-
offs during SmartDesign generation.

Required bus interfaces - The signals that are not required to be mapped will be tied off if they are mapped
to an unconnected input pin.

Optional bus interfaces - All signals will be tied off if they are mapped to an unconnected input pin.

Tying Off (Disabling) Unused Bus Interfaces

Tying off (disabling) a bus interface sets all the input signals of the bus interface to the default value.
To tie off a bus interface, right-click the bus interface and select Tie Off.

This is useful if your core includes a bus interface you plan to use at a later time. You can tie off the bus
interface and it will be disabled in your design until you manually set one of the inputs.

Some bus interfaces are required; you cannot tie off a bus interface that is required. For example, the
Crystal Oscillator to RTC (RTCXTL) bus interface is a silicon interface and must be connected.

To enable your pin, right-click the pin and choose Clear Attribute.

Required vs. Optional Bus Interfaces

A required bus interface means that it must be connected for the design to be considered legal. These are
typically used to designate the silicon interconnects that must be present between certain cores. For

example, when using the Real Time Counter in a Fusion design you must also connect it up to a Crystal
Oscillator core.

An optional bus interface means that your design is still considered legal if it is left unconnected. However, it
may not functionally behave correctly.
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CoreAHBLite_0 Wﬂm
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Figure 29 - Required Unconnected, Optional Unconnected, and Connected Bus Interfaces

See Also
Canvas icons

Promoting Bus Interfaces to Top-level

To automatically connect a bus interface to a top-level port, select the bus interface, right-click, and choose
Promote To Top Level.

This automatically creates a top-level bus interface port of that name and connects the selected port to it. If
a bus interface port name already exists, a choice is given to either connect to the existing bus interface port
or to create a new bus interface port with a name <port name>_<i> where i = 1...n.

The signals that comprise the bus interface are also promoted.
Promoting a bus interface is a shortcut for creating a top-level port and connecting it to an instance pin.
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Reconfiguring a Component

To reconfigure a component used in a SmartDesign:
o In the Canvas, select the instance and double-click the instance to bring up the appropriate configurator, or the

HDL editor; or select the instance, right-click it, and choose Configure Component.

e Select the component in the Design Hierarchy tab and from the right-click menu select Open Component.

When the configurator is launched from the canvas, you cannot change the name of the component.

See Also
Desiqn state management

Replacing components

Fixing an Out-of-Date Instance

Any changes made to the component will be reflected in the instance with an exclamation mark when you
update the definition for the instance. An instance may be out-of-date with respect to its component for the
following reasons:

e If the component interface (ports) is different — after reconfiguration - from that of the instance
e If the component has been removed from the project
e If the component has been moved to a different VHDL library
e If the SmartDesign has just been imported
You can fix an out-of-date instance by:
e Replacing the component with a new component (as shown in the figure below)
e Updating with the latest component

P S .
e o

FMB_O
B INT_CLK INIT_DONE B
B SYS_RESET Rg’ . ’
. = INIT_POWWER_UP Configure
InitClient_InitCfgSave_hi [¥] Disatle

=B InitCfgCir_bif

. Delete

Replace Component for Instancels)., .

|

Update Instances) with Latest Component. ..

=¥~ Clear User Conneckions

Figure 30 - Right-Click Menu - Replace Component for this Instance

See Also
Desiqn state management

Reconfiguring components

Replacing components
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Replacing Component Version

Components of an instance on the Canvas can be replaced with another component and maintain
connections to all ports with the same name.

To replace a component in your design:

1. Select the component in the Design Hierarchy, right-click, and choose Replace Component Version.
The Replace Component for Instance dialog box appears (see figure below).

Ml Replace Component Yersion ﬂ E

Component: smarkfusion_project_MSS

Core Name Yendor Library ¥Yersion | Change to Yersion

M55 Actel SmartFusionM55 2.5.106 24,105 j

Help | Ok I Cancel |

Figure 31 - Replace Component Version Dialog Box
2. Select the version you want to replace it with and click OK.

Design State Management

When any component with instances in a SmartDesign design is changed, all instances of that component
detect the change.

If the change only affects the memory content, then your changes do not affect the component's behavior or
port interface and your SmartDesign design does not need to be updated.

If the change affects the behavior of the instantiated component, but the change does not affect the
component's port interface, then your design must be resynthesized, but the SmartDesign design does not
need to be updated.

If the port interface of the instantiated component is changed, then you must reconcile the new definition for
all instances of the component and resolve any mismatches. If a port is deleted, SmartDesign will remove
that port and clear all the connections to that port when you reconcile all instances. If a new port is added to
the component, instances of that component will contain the new port when you reconcile all instances.
The affected instances are identified in your SmartDesign design in the Grid and the Canvas with an
exclamation point. Right-click the instance and choose Update With Latest Component.

Note: For HDL modules that are instantiated into a SmartDesign design, if the modification
causes syntax errors, SmartDesign does not detect the port changes. The changes will be
recognized when the syntax errors are resolved.

Changing memory content

For certain cores such as Flash Memory, or FlexRAM it is possible to change the configuration such that
only the memory content used for programming is altered. In this case Project Manager (SoC) will only
invalidate your programming file, but your synthesis, compile, and place-and-route results will remain valid.

When you modify the memory content of a core such as RAM with Initialization that is used by a Flash
Memory core, the Flash Memory core indicates that one of its dependent components has changed and that
it needs to be regenerated. This indication will be shown in the Hierarchy or Files Tab \'@ .

RAM with Initialization core - You can modify the memory content without invalidating synthesis.

Flash Memory System Builder core - You can modify the following without invalidating synthesis:

e Modifying memory file or memory content for clients
e JTAG protection for Init Clients
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Design Rules Check

The Design Rules Check runs automatically when you generate your SmartDesign; the results appear in the
Reports tab. To view the results, from the Design menu, choose Reports.

e Status displays an icon to indicate if the message is an error or a warning (as shown in the figure
below). Error messages are shown with a small red sign and warning messages with a yellow
exclamation point.

¢ Message identifies the specific error/warning (see list below); click any message to see where it
appears on the Canvas

e Details provides information related to the Message

"« Libero - EADEMOVF TCA\stALIBERO_DEMOA IBEROD_DEMO. prjx*

Project  Fle Edit  Wew Design Help
~ ==
NEH2> 90
5] LIBERG_DEMO Reports
= LIBEROQ_DEMO reports
= LIBERO_DEMO o
LIBERO DEMO_DRC. DRC Report: LIBERO_DEMO
Status Message Details
& Hoating Criver | Floating output bus pin CoreGPIO_0:INT[31:0]
Q Undriven Pin Unconnected input pin CoreGPIO_0nGPIO_IN[31:0]
& Hoating Criver | Floating output bus pin CoreGPIO_0GPIC_QUT[31:0]
& Hoating Driver | Floating output bus pin CoreGPIO_0:GPIO_OE[31:0]
& Floating Driver | Flaatng output pin Corel JAR Tapb_0:TXRDY
& Hloating Driver | Flaatng output pin Corel JAR Tapb_0:RXRDY
A Hloating Driver | Floating output pin Corel JARTapb_0:PARITY _ERR
A Hloating Driver | Floating output pin Corel JAR Tapb_0:OVERFLOW
@ Undriven Fin Unconnected input pin CorelJAR Tapb_0:RX
A Hoating Criver | Floating output pin CorelUAR Tapb_0: T
A Hoating Criver | Floating output pin CorelUAR Tapb_0:FRAMING_ERR,
Fam: SmartFusion | | Die: AZF200M3F | |Plg: 484 FEGA | verilog
Figure 32 - Design Rules Check Results
Message Types:

Unused Instance - You must remove this instance or connect at least one output pin to the rest of the
design.

Out-of-date Instance - You must update the instance to reflect a change in the component referenced by
this instance; see Fixing an out-of-date instance.

Undriven Pin - To correct the error you must connect the pin to a driver or change the state, i.e. tie low
(GND) or tie high (VCC).

Floating Driver - You can mark the pin unused if it is not going to be used in the current design. Pins
marked unused are ignored by the Design Rules Check.

Unconnected Bus Interface - You must connect this bus interface to a compatible port because it is
required connection.

Required Bus Interface Connection — You must connect this bus interface before you can generate the
design. These are typically silicon connection rules.

Exceeded Allowable Instances for Core — Some IP cores can only be instantiated a certain number of

times for legal design. For example, there can only be one CortexM1 or CoreMP7 in a design because of
silicon rules. You must remove the extra instances.

Incompatible Family Configuration — The instance is not configured to work with this project’s Family
setting. Either it is not supported by this family or you need to re-instantiate the core.
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Incompatible Die Configuration — The instance is not configured to work with this project’s Die setting.
Either it is not supported or you need to reconfigure the Die configuration.

Incompatible ‘Debug’ Configuration — You must ensure your CoreMP7 and CoreMP7Bridge have the
same ‘Debug’ configuration. Reconfigure your instances so they are the same.

No RTL License, No Obfuscated License, No Evaluation License — You do not have the proper license
to generate this core. Contact Microsemi SoC to obtain the necessary license.

No Top level Ports - There are no ports on the top level. To auto-connect top-level ports, right-click the
Canvas and choose Auto-connect

Generating a SmartDesign Component

Before your SmartDesign component can be used by downstream processes, such as synthesis and
simulation, you must generate it.

Click the Generate button to generate a SmartDesign component.
This will generate a HDL file in the directory <libero_project>/components/<library>/<yourdesign>.

Note: The generated HDL file will be deleted when your SmartDesign design is modified and
saved to ensure synchronization between your SmartDesign component and its generated
HDL file.

Generating a SmartDesign component may fail if there are any DRC errors. DRC errors must be corrected

before you generate your SmartDesign design.

Generating a Datasheet (SmartFusion, IGLOOe, ProASIC3L, ProASIC3E, Fusion)

If your SmartDesign is the root design in your project, then a Memory Map / Datasheet that contains your
design information is produced.

Generating Firmware and Software IDE Workspace (SmartFusion, IGLOOe, ProASIC3L, ProASIC3E,
Fusion)

If your SmartDesign is the root design in your project, then any compatible firmware drivers for your
peripherals are generated to <project>/firmware.

The datasheet provides all the specifics of the generated firmware drivers.

SmartDesign Reference

SmartDesign Menu

Command Icon Function
Generate Component @ Generates the SmartDesign component
Auto Connect ) Auto-connects instances
Connection Mode -1 Toggles connection mode on or off

+
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Command Icon Function
Add Port o Opens the Add Port dialog box, adds a port to the

top SmartDesign component

QuickConnect

Opens the QuickConnect dialog box, enables you
to view, find and connect pins

Auto-Arrange Instances

Adds a port to the top of the SmartDesign

L
&+ | component
Route All Nets o | Re-routes your nets; useful if you are unsatisfied
o with the default display
Show/Hide Nets o D Enables you to show or hide nets on the Canvas

Show/Hide Net Names

Enables you to show or hide net names on the
Canvas

Zoom In &k Zooms in on the Canvas

Zoom Out ::k Zooms out on the Canvas

Zoom to Fit Zooms in or out to include all the elements on the
. Canvas in the view

Zoom Box Zooms in on the selected area

Enable/Disable Back
Background Grid

Toggle switch to enable or disable the
background grid display in the Canvas

Add Note

Adds text to your Canvas

Add Line

Enables you to add a line to the Canvas

Add Rectangle

O

Enables you to add a rectangle to the Canvas

SmartDesign Glossary

Term Description
BIF Abbreviation for bus interface.
bus An array of scalar ports or pins, where all scalars have a common base
name and have unique indexes in the bus.
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Term Description
Bus Defines the signals that comprise a bus interface. Includes which signals
Definition are present on a master, slave, or system interface, signal direction,

width, default value, etc. A bus definition is not specific to a logic or
design component but is a type or protocol.

Bus Interface | Logical grouping of ports or pins that represent a single functional
purpose. May contain both input and output, scalars or busses. A bus
interface is a specific mapping of a bus definition onto a component
instance.

Bus Interface | A connection between 2 or more compatible bus interfaces.
Net

Canvas Block diagram, connections represent data flow; enables you to connect
instances of components in your design.

Component | Design element with a specific functionality that is used as a building
block to create a SmartDesign core.

A component can be an HDL module, non-IP core generated from the
Catalog, SmartDesign core, Designer Block, or IP core. When you add a
component to your design, SmartDesign creates a specific instance of
that component.

Component | VHDL construct that refers to a specific component.
Declaration

Component | An individual port on a component definition.

Port

Driver A driver is the origin of a signal on a net. The input and slave BIF ports
of the top-level or the output and Master BIF ports from instances are
drivers.

Instance A specific reference to a component/module that you have added to
your design.

You may have multiple instances of a single component in your design.
For each specific instance, you usually will have custom connections
that differ from other instances of the same component.

Master Bus | The bus interface that initiates a transaction (such as a read or write) on
Interface a bus.

Net Connection between individual pins. Each net contains a single output
pin and one or more input pins, or one or more bi-directional pins. Pins
on the net must have the same width.

PAD The property of a port that must be connected to a design’s top level
port. PAD ports will eventually be assigned to a package pin. In
SmartDesign, these ports are automatically promoted to the top-level
and cannot be modified.

Pin An individual port on a specific instance of a component.
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Term

Description

Port

An individual connection point on a component or instance that allows
for an electrical signal to be received or sent. A port has a direction
(input, output, bi-directional) and may be referred to as a ‘scalar port’ to
indicate that only a single unit-level signal is involved. In contrast, a bus
interface on an instance may be considered as a non-scalar, composite
port.

A component port is defined on a component and an instance port (also
known as a ‘pin’) is part of a component instance.

Signal

A net or the electrical message carried on a net.

Slave Bus
Interface

Bus interface that terminates a transaction initiated by a master
interface.

System Bus
Interface

Interface that is neither master nor slave; enables specialized
connections to a bus.

Top Level
Port

An external interface connection to a component/module. Scalar if a 1-
bit port, bus if a multiple-bit port.

Canvas lcons

Hover your pointer over any icon in the SmartDesign Canvas view to display details.

Icon Description

Representation of an

instance in your design. An
instance is a component that

NGMUXBLK_0 4

CUH
L
=

GLB

Foy

has been added to your
SmartDesign component.
The name of the instance
appears at the top and the
name of the generic
component at the bottom.

The instance type is
indicated by an icon inside
the instance. There are
specific icons for instances
from SmartDesign, HDL, and
ViewDraw. The instance icon
at left indicates a Microsemi
SoC core.

CoreAHBLite_0

S, Bus instance; you can click
DNDLBOWOW and drag the end of a bus
DORRIRIRRRIR®O. instance to resize it; also, the
—
Fr 2z é E §| bus instance will resize
= E S based on the number of
T é instances that you connect

to it.
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Icon Description

’ Optional unconnected pin.
Required pins are red.

. Connected pin

o Pin with default Tie Off

Pin tied low

Pin tied high

Pin inverted

Pin marked as unused

Pin tied to constant
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Icon Description
Marme: CoreahbSram O Instance details. If there are
Instance of: CoreAhbSram less than twenty ports, they
Type: P are listed in the details.
Class: Reqular
Wendor: Actel
Library: DirectCore
Core Mame: CorefAhbSram
Mersion: 1.4.104

| Mumber of ports: 13

[Pin: [HCLk I
[pin:|[HrESETD [
[Pin: [HSEL i
[pin: | [HwRITE i
[Pin: [HREADYIN |1
[Pin: [HREADY lout
{ [pin: [HTRANS[1:0] [
I [pin: |[Hstze[z:0] [
[pin: [HwDaTAL31:0 |14
[Pin: | [HADDR[14:0] |1
[pin: [HRESP[1:0]  |[ouT
[pin: [HRDATAL31:0] |[ouT
[Pin: [AHBslave  |[sLavE

Bus Net details.
Bus Met: DataB[1:0]

DataB[1:0]
subtr_1_0 [DataB[1:0]

' Master bus interface icon. A

master is a bus interface that
initiates a transaction on a
bus interface net.

An unconnected master BIF
with REQUIRED connection
is red (shown at left).

A master BIF with
unconnected OPTIONAL
connection is gray.

66 Libero SoC User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error

when clicked. View the online help included with software to enable all linked content.

& Microsemi
Create and Verify Design

State:  Unconnected - required

*This pin is a required connection,
you must connect it for a valid design.

Icon Description
s R . -
. Master BIF details, showing
Mame: RTCYR_bif
name, role, and state.
Rale: master

The Pin Map shows the
Formal name of the pin
assigned by the component
(in this example,

Formal Actual RCCLKOUT) Qnd the Actual,
RTCPSMMATCH _|RTCPSMMATCH or representative name
_ assigned by the user
(CLKOUT).
Slave BIF (shown at left).
Unconnected slave icons
with REQUIRED connections
are red.
Unconnected slave icons
with OPTIONAL connections
are gray.
G 1 Slave BIF details, showing
HAmES ExtSeqCtrl_bif name, role, and state.
Rale: slave ’ ’
State: Unconnected
The Pin Map shows the
Foreval weral Formal name of the pin
ASSC_SEQIN ASSC_SEQIN[S:0] assigned by the component
ASSC_SEQIUMP  |ASSC_SEQIUMP (in this example,
ASSC_MODE A4SSC_XMODE RCCLKOUT) and the Actual,
ASSC_XTRIG ASSC_XTRIG or representative name
ASSC_DONE ASSC_DONE assigned by the user
ASSC_SEQOUT ASSC_SEQOUT[S:0] (CLKA).
ASSC_SEQCHANGE |ASSC_SEQCHANGE
ASSC_SAMPFLAG ASSC_SAMPFLAG

Master-slave bus interface
connection
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Name: [AHBmslavez Master-slave bus interface
Role:  |mirroredSlave connection details.
State: |Connected
Pin Map
Formal Actual
HADDR, HADDR_52[31:0]

HTRAMS | HTRANS_52[1:0]
HWRITE  ||[HWRITE_S2

HSIZE HS1ZE_52{2:0]
HWDATS | [HWDATA_S2[31:0]
HSELx HEL_S2

HROATA HRODATA_52[31:0]
HREADY  ||HREADY_S2
HMASTLOCK |HMASTLOCK_S2
HREADYOUT |HREADYOUT _52

HRESP HRESP_S2{1:0]
HELRST HEURST_52[2:0]
HPROT HPROT_52[3:0]

Groups of pins in an
instance.

Fully connected groups are
solid green.

Partially connected groups
are gray with a green outline.

Unconnected groups (no
connections) are gray with a
black outline.

A system BIF is the bus
interface that does not have
a simple input/output

relationship on both
master/slave.

This could include signals
that only drive the master
interface, or only drive the
slave interface, or drive both
the master and slave

interfaces.

4 ™ System BIF details, showing
Mame: InitCfgSave_bif name, role, and state.
Role: system
State: Connected The Pin Map shows the

Formal name of the pin
assigned by the component
Formal Actual (in this example,
CLIENTAYAIL:0 |rarmrd CLIENTAVAILX0), and the
Actual name assigned by the
- ~ user (in this example:
ramrd).

68 Libero SoC User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi
Create and Verify Design

Icon Description

Pad port icon; indicates a
hardwired chip-level pin

VHDL Special Types - Examples and meta.out File Format

The VHDL Special Types are:

e Integer

e Unsigned

e Array and Array of Arrays
e Record

The meta.out file format follows the examples.

Integer

-- Package Declaration
library IEEE;
use IEEE.std_logic_1164._all;
use IEEE.std_logic_arith.all;
package universal_pkg is
subtype integerl is integer range 0 to 127;
subtype integer2 is integer range 0 to 127;
end package universal_pkg;
--Entity Declaration
entity adder is

port (
D1 , D2 : in integerl;
D3 , D4 : in integer2;

int_outl : out integer range 0O to 255;
int_out2 : out integer range 0 to 255

);

end entity adder;

Meta.out file:

package universal_pkg

integer integerl [ 0 : 127 ]

integer integer2 [ 0 : 127 ]

end

entity adder

D1 integerl

D2 integerl

D3 integer2

D4 integer2

int_outl integer [ O : 255 ]

int_out2 integer [ O : 255 ]

end
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Unsigned

Entity declaration:

entity unsigned 2multiply_acc is

port( A : in unsigned(16 downto 0);
B : in unsigned(34 downto 0);
C : in unsigned(13 downto 0);
D : in unsigned(37 downto 0);
E : in unsigned(51 downto 0);
P : out unsigned(51 downto 0);
clk : in std_logic

);

end unsigned 2multiply_acc;

Meta.out file:

entity unsigned_2multiply_acc

A unsigned [ 16 - 0 ]

B unsigned [ 34 - 0 ]

C unsigned [ 13 - 0 ]

D unsigned [ 37 - 0 ]

E unsigned [ 51 : 0 ]

P unsigned [ 51 : 0 ]

End

Array and Array of Arrays

--Package Declaration
library IEEE;
use IEEE.std_logic_1164.all;
package array_package is
subtype ram_input is std_logic_vector(31 downto 0);
type ram_in is array(1 downto 0) of ram_input;
type ram_out is array(l downto 0) of ram_input;
end package array_package;
-- Entity Declaration
entity ram_inference is
port (
ram_init : in ram_in;
write_enable : in std_logic;
read_enable : in std_logic;
CLK : in std_logic;
write_address : in integer range 63 downto O;
read_address : in integer range 63 downto O;
read_data : out ram_out
):
end entity ram_inference;
Meta.out file:
package array_package
array_of_array ram_in [ 1 - 0 ]
end
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array_of _array ram_out [ 1 : 0 ]
end

end

entity ram_inference

ram_init[1] ram_in

ram_init[0] ram_in
write_address integer [ 63 : 0 ]
read_address integer [ 63 : 0 ]
read_data[1] ram_out
read_data[0] ram_out

end

Record

- Package Declaration
library I1EEE;
use IEEE.std_logic_1164._all;
use IEEE.std_logic_arith.all;
package record_pkg is
type arrayl is array(3 downto 0) of std_logic;
type array2 is array(3 downto 0) of std_logic_vector(3 downto 0);
type test is record
test_std_logic : std_logic;
test_std_logic_vector : std_logic_vector(l downto 0);
test_integer : integer range 0 to 127;
test_array : arrayl;
test_array_of _array : array2;
test_unsigned : unsigned(2 downto 0);
end record;
end package record_pkg;
-- Entity Declaration
entity MUX is
generic ( N : integer =1 );
port (
mux_inl, mux_in2 : in test;
sel_lines : in std_logic_vector(N-1 downto 0);
mux_out : out test;
mux_array : out arrayl
);
end entity MUX;
Meta.out file:
package record_pkg
array arrayl
end
array_of_array array2 [ 3 - 0 ]
end
record test
test_integer integer [ 0 : 127 ]
test_array arrayl
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end

end

entity MUX

mux_inl.test _std_logic test
mux_inl.test_std_logic_vector test
mux_inl.test_integer test
mux_inl.test _array test
mux_inl.test_array_of_array[0] test
mux_inl.test_array_of_array[l] test
mux_inl.test_array_of_array[2] test
mux_inl.test_array_of_array[3] test
mux_inl.test _unsigned test
mux_in2.test_std_logic test
mux_in2.test_std_logic_vector test
mux_in2.test_integer test
mux_in2.test_array test
mux_in2.test_array_of _array[0] test
mux_in2.test_array_of _array[l] test
mux_in2.test_array_of _array[2] test
mux_in2.test_array_of_array[3] test
mux_in2._test _unsigned test
mux_out.test _std_logic test
mux_out.test _std_logic_vector test
mux_out.test_integer test
mux_out.test array test
mux_out.test_array_ of _array[0] test
mux_out.test _array_ of _array[l] test
mux_out.test_array_ of _array[2] test
mux_out.test_array_of _array[3] test

mux_out.test _unsigned test
mux_array arrayl
end

meta.out File Format

MetaFile : MetaLibraryltem | MetaPackageList | MetaEntityList
MetaLibraryltem : library <lib_name>

MetaPackagelList : MetaPackageltem MetaPackageList

MetaPackageltem : package <package_name> MetaltemDeclarationList end

MetaltemDeclarationList: Metaltem MetaltemDeclarationList

Metaltem : (MetaRecordltem | MetaArrayOfArrayltem | MetalntegerType | MetaArrayltem)
Metalntegeritem : (MetalntegerType | MetalntegerWithoutType)

MetalntegerType : integer <integer_name> NumericRange

MetalntegerWithoutType : integer NumericRange

MetaUnsigneditem : unsigned <name> NumericRange

MetaArrayOfArrayltem : array_o

f_array < MetaArrayOfArrayName> Range [MetaArrayltem] end

MetaRecordltem : record <record_name> RecordltemList end

RecordltemList : Recordltem RecordltemList
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Recordltem : <Inst_name> (MetaArrayOfArrayName | Metalntegerltem | MetaUnsigneditem |
MetaSimpleArray)

MetaEnumuratedltem : enum <enum_name> ( ltem_name{,ltem_name})
Range : [ NumericRange | MetaEnumurateditem]

NumericRange : Isd : msd

MetaArrayltem :array <array_name> [<record_name>] end
MetaEntityList : entity <entity _name> MetaEntityltemList end
MetaEntityltemList : MetaEntityltem MetaEntityltemList

MetaEntityltem : (RecordEntityltemList | IntegerEntityltemList | ArrayEntityltemList |
ArrayOfArrayEntityltemList | UnsignedEntityltemList | BufferPortltemList)

RecordEntityltemList : RecordEntityltem RecordEntityltemList

RecordEntityltem : (RecordNormalltem | RecordArrayOfArrayltemList)
RecordNormalltem : <user_port_name>. Recordltem <record_name>
RecordArrayOfArrayltemList : <record_port_name>[index]. Recordltem <record_name>
BufferPortltemList : BufferPortltem BufferPortltemList

BufferPortltem : buffer <buffer_name>

IntegerEntityltemList : IntegerEntityltem IntegerEntityltemList

IntegerEntityltem : <user_port_name> ( MetalntegerType | MetalntegerWithoutType)
ArrayEntityltemList : ArrayEntityltem ArrayEntityltemList

ArrayEntityltem : <user_port_name> MetaArrayltem

ArrayOfArrayEntityltemList : ArrayOfArrayEntityltem ArrayOfArrayEntityltemList
ArrayOfArrayEntityltem : <port_name> < MetaArrayOfArrayName>
UnsignedEntityltemList : UnsignedEntityltem UnsignedEntityltemList
UnsignedEntityltem : <user_port_name> MetaUnsignedItem

Create Core from HDL

You can instantiate any HDL module and connect it to other blocks inside SmartDesign. However, there are
situations where you may want to extend your HDL module with more information before using it inside
SmartDesign.

¢ If you have an HDL module that contains configurable parameters or generics.

e If your HDL module is intended to connect to a processor subsystem and has implemented the
appropriate bus protocol, then you can add a bus interface to your HDL module so that it can easily
connect to the bus inside of SmartDesign.

To create a core from your HDL:

1. Import or create a new HDL source file; the HDL file appears in the Design Hierarchy.

2. Select the HDL file in the Design Hierarchy and click the HDL+ icon or right-click the HDL file and
choose Create Core from HDL.

The Edit Core Definition — Ports and Parameters dialog appears. It shows you which ports and
parameters were extracted from your HDL module.

3. Remove parameters that are not intended to be configurable by selecting them from the list and
clicking the X icon. Remove parameters that are used for internal variables, such as state machine
enumerations.

If you removed a parameter by accident, click Re-extract ports and parameters from HDL file to
reset the list so it matches your HDL module.
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MEdit Core Definition - Ports and Parameters

HDL: CiiDocuments and SettingsifarleyciDeskkophfarleyc_actelpritsoc_10spl_cc_hdlihdifyaPE_adder.y

Module: MyAPE_adder

Extracted Ports Extracted Parameters N
PCLE i |WIDTH
PRESETH SIZE
PADDR[4:0] APE_SIZE
PSEL FIFCO_EMABLE
PEMAELE COUNTER _EMNABLE
PWRITE

PROATA[7:0]
PYDATA[7:00]
PREADY
PSLYERR
TN_A[15:0]
N_E[15:0]
RESULT[15:0]
OWERFLOWY

Re-extract ports and parameters From HDL |

Help | AddEdit bus interfaces... I OF | Cancel |

Figure 33 - Edit Core Definition - Ports and Parameters Dialog Box
4. (Optional) Click Add/Edit Bus Interfaces to add bus interfaces to your core.

After you have specified the information, your HDL turns into an HDL+ icon in the Design Hierarchy. Click
and drag your HDL+ module from the Design Hierarchy to the Canvas.

If you added bus interfaces to your HDL+ core, then it will show up in your SmartDesign with a bus interface
pin that can be used to easily connect to the appropriate bus IP core.

If your HDL+ has configurable parameters then double-clicking the object on the Canvas invokes a
configuration dialog that enables you to set these values. On generation, the specific configuration values
per instance are written out to the SmartDesign netlist.

B, Configuring MyaAPE_Adder_0 (MyaPE_... [H[=] B3

[l Configuration
E i i
WIDTH: 18]
MyAPB_Adder_0
> PCLK RESULT[15:0] SIzE: 200
PRESETN CVERFLOW
IN_A[15:0] :
N B[ 15:0] : APE_SIZE: [1

#a

FIFQ_EMABLE: I o
COUNTER, _EMAEBLE: I 1]

15 L R NNy
Core APB_D Help | 0K I Cancel |
gw| =
4

Figure 34 - HDL+ Instance and Configuration Dialog Box
You can right-click the instance and choose Modify HDL to open the HDL file inside the text editor.

Edit Core Definition

You can edit your core definition after you created it by selecting your HDL+ module in the design hierarchy
and clicking the HDL+ icon.

Remove Core Definition

You may decide that you do not want or need the extended information on your HDL module. You can
convert it back to a regular HDL module. To do so, right-click the HDL+ in the Design Hierarchy and choose
Remove Core Definition. After removing your definition, your instances in your SmartDesign that were
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referencing this core must be updated. Right-click the instance and choose Replace Component for
Instance.

SmartDesign Testbench

SmartDesign Testbench is a GUI-based tool that enables you to design your testbench hierarchy. Use
SmartDesign Testbench to instantiate and connect stimulus cores or modules to drive your Root design.

You can create a SmartDesign Testbench by right-clicking a SmartDesign in the Design Hierarchy and
choosing Create Testbench > SmartDesign.

SmartDesign Testbench automatically instantiates the selected SmartDesign into the Canvas.

You can also double-click Create SmartDesign Testbench in the Design Flow window to add a new
SmartDesign testbench to your project.

New testbench files appear in the Stimulus Hierarchy.
SmartDesign Testbench automatically instantiates your root design into the Canvas.

You can instantiate your own stimulus HDL or simulation models into the SmartDesign Testbench Canvas
and connect them to your DUT (design under test). You can also instantiate Simulation Cores from the
Catalog. Simulation cores are basic cores that are useful for stimulus generation, such as driving clocks,
resets, and pulses.

Click the Simulation Mode checkbox in the Catalog to view available simulation cores.

Designing with HDL

Create HDL

Create HDL opens the HDL editor with a new VHDL or Verilog file. Your new HDL file is saved to your /hdl
directory; all modules created in the file appear in the Design Hierarchy.

You can use VHDL and Verilog to implement your design.

To create an HDL file:
1. Inthe Design Flow window, double-click Create HDL. The Create new HDL file dialog box opens.

2. Select your HDL Type. Choose whether or not to Initialize file with standard template to populate
your file with default headers and footers. The HDL Editor workspace opens.

3. Enter a Name. Do not enter a file extension; Libero SoC adds one for you. The filename must follow
Verilog or VHDL file naming conventions.

4. Click OK.
After creating your HDL file, click the Save button to save your file to the project .

Using the HDL Editor

The HDL Editor is a text editor designed for editing HDL source files. In addition to regular editing features,
the editor provides keyword highlighting, line numbering and a syntax checker.

You can have multiple files open at one time in the HDL Editor workspace. Click the tabs to move between
files.

Editing
Right-click inside the HDL Editor to open the Edit menu items. Available editing functions include cut, copy,

paste, Go to line, Comment/Uncomment Selection and Check HDL File. These features are also available in
the toolbar.

Saving

You must save your file to add it to your Libero SoC project. Select Save in the File menu, or click the Save
icon in the toolbar.

Printing
Print is available from the File menu and the toolbar.

Note: To avoid conflicts between changes made in your HDL files, Microsemi recommends that
you use one editor for all of your HDL edits.
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HDL Syntax Checker

To run the syntax checker:

In the Files list, double-click the HDL file to open it. Right-click in the body of the HDL editor and choose
Check HDL File.

The syntax checker parses the selected HDL file and looks for typographical mistakes and syntactical errors.
Warning and error messages for the HDL file appear in the Libero SoC Log Window.

Commenting Text

You can comment text as you type in the HDL Editor, or you can comment out blocks of text by selecting a
group of text and applying the Comment command.
To comment or uncomment out text:

1. Type your text.

2. Select the text.

3. Right-click inside the editor and choose Comment Selection or Uncomment Selection.

Find

In the File menu, choose Find and the Find dialog box appears below the Log/Message window. You can
search for a whole word or part of a word, with or without matching the case.

You can search for:
e Match Case
¢ Match whole word
e Regular Expression
The Find to Replace function is also supported.

Column Editing

Column Editing is supported. Press ALT+click to select a column of text to edit.

Importing HDL Source Files

To import an HDL source file:

1. Inthe Design Flow window, right-click Create HDL and choose Import Files. The Import Files window
appears.

2. Navigate to the drive/folder that contains the HDL file.
3. Select the file to import and click Open.

Mixed-HDL Support in Libero SoC

You must have ModelSim PE or SE to use mixed HDL in the Libero SoC. Also, you must have Synplify Pro
to synthesize a mixed-HDL design.

When you create a project, you must select a preferred language. The HDL files generated in the flow (such
as the post-layout netlist for simulation) are created in the preferred language.

The language used for simulation is the same language as the last compiled testbench. (E.g. if tb_top is in
verilog, <fam>.v is compiled.)

If your preferred language is Verilog, the post-synthesis and post-layout netlists are in Verilog 2001.

HDL Testbench

You can create a HDL Testbench by right-clicking a SmartDesign in the Design Hierarchy and choosing
Create Testbench > HDL.
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HDL Testbench automatically instantiates the selected SmartDesign into the Canvas.

You can also double-click Create HDL Testbench to open the Create New HDL Testbench dialog box. The
dialog box enables you to create a new testbench file and gives you the option to include standard testbench
content and your design data.

Set your HDL Type, specify a name, select the data options and click OK to create a new testbench.

Initialize file with standard template populates the new HDL file with basic headers and Clock/Reset
driver, as in the header of the example file below.

Instantiate Root Design includes your root design information in the new file. It includes architectural,
constant, signal, component, clock, and port information.

Set as Active Stimulus sets the HDL Testbench as the stimulus file to use for simulations.

EI Create Mew HDL Testhe

T

HOL Type

@ Verilog

Mame: |

Clock Period (ns) : 100

Initialize file with standard template
Instantiate Root Design
Set as Active Stimulus

Figure 35 - Create HDL Testbench Dialog Box
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2 —— Company: <Name>
3 -
4 —— File: hdl_testhench 1.vhd
5 —- File history:
B —— <Rewizion mmber>: <Datex: <L{CommEnts:
d - <Rewision mmmber>: <Date>: <{Comments>
8 - <Rewizion mmber>: <Date>: <L{Comments:
o __
10 -- Description:
11 —-
12 —- <Dezscription here>
15 —-
14 —— Targeted device: <Familw::SmartFusion> <Die::AZF2Z00M3F: <Package::434 FEGL-
15 —- Author: «<Name>
16 —-
1
18
19
20 library ieee;
2]l use ieee.std logic_ll6d.all;
2z
23 entity hdl testhench 1 is
24 end hdl_testbench 1;
25
286 architecture behavioral of hdl_testhench 1 is
27
Zg constant SY¥3CLE_PERIOD : time := 100 na:
29
30 gigmal SYSCLE : std logic := '0O';
3 signal N3YSBESET : std logic := '0':
32
33 component test mss
3 -— ports
35 port |
36 -- Inputs
37 TART 1 B¥D : im std_logic:
36 TART 0 FXD : im std_logic:
39 3PI_1 DI : im std_logic;
40 SPI_ 0 DI : im std logic;
41 MAC_CREDV : in std logic:
42 MAC FXER : in std_logic:
43 M3% PESET N : im std logic;
44 CLEL PAD : im std_logic;
45 CLEC_PAD : in std logic:
46 MAC FXD : in std_logic_wector(l downto 0);
47

Figure 36 - HDL Testbench Example - Standard Template and Root Design Enabled

Simulation and Verification

RTL Simulation

To perform pre-synthesis simulation, in the Stimulus Hierarchy right-click the testbench and choose
Simulate Pre-Synth Design > Run.

If you wish to perform pre-layout simulation, in the Design Flow Window, under Verify Pre-Synthesized
design, double-click Simulate.

The default tool for RTL simulation in Libero SoC is ModelSim ME.

ModelSimTM ME is a custom edition of ModelSim PE that is integrated into Libero SoC's design
environment. ModelSim for Microsemi is an OEM edition of Model Technology Incorporated’'s (MTI) tools.
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ModelSim for Microsemi supports VHDL or Verilog. It only works with Microsemi libraries and is supported
by Microsemi.

Other editions of ModelSim are supported by Libero SoC. To use other editions of ModelSim , simply do not
install ModelSim ME from the Libero SoC CD.

Note: ModelSim for Microsemi comes with its own online help and documentation. After starting
ModelSim, click the Help menu.

See the following topics for more information on simulation in Libero SoC:
e Simulation Options

e Selecting a Stimulus File for Simulation

e Selecting additional modules for simulation

e Performing Functional Simulation

Simulation Options
You can set a variety of simulation options for your project.

To set your simulation options:
1. From the Project menu, choose Project Settings.
2. Click the simulation option you wish to edit: DO file, Waveforms, or Vsim commands.
3. Click Close to save your settings.

e Use automatic Do file - Select to execute the wave.do or other specified Do file. Use the wave.do file
to customize the ModelSim Waveform window display settings.

e Simulation Run Time - Specify how long the simulation should run in nanoseconds. If the value is 0,
or if the field is empty, there will not be a run command included in the run.do file.

e Testbench module name - Specify the name of your testbench entity name. Default is “testbench,”
the value used by WaveFormer Pro.

e Top Level instance name - Default is <top_0>, the value used by WaveFormer Pro. The Libero SoC
replaces <top> with the actual top level macro when you run ModelSim.

e Generate VCD file - Select this checkbox to have ModelSim automatically generate a VCD file based
on the current simulation. VCD files can be used in SmartPower. For best results, we recommend that
a postlayout simulation be used to generate the VCD.

e VCD filename - Specify the name of the VCD file that will be automatically generated by ModelSim

e User defined DO file - Available if you opt not to use the automatic DO file. Input the path or browse
to your user-defined DO file.

e DO Command parameters - Text in this field is added to the DO command.

e Include DO file - Including a DO file enables you to customize the set of signal waveforms that will be
displayed in ModelSim.

e Display waveforms for - You can display signal waveforms for either the top-level testbench or for the
design under test. If you select top-level testbench then Libero SoC outputs the line ‘add wave
/testbench/*' in the DO file run.do. If you select DUT then Libero SoC outputs the line 'add wave
/testbench/*' in the run.do file.

e Log all signals in the design - Saves and logs all signals during simulation.

Vsim Commands

e SDF timing delays - Select Minimum, Typical, or Maximum timing delays in the back-annotated SDF
file.
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e Resolution: The default is family-specific, but you can customize it to fit your needs.
Some custom simulation resolutions may not work with your simulation library. For example,
simulation resolutions above 1 ps will cause errors if you are using ProASIC3 devices (the simulation
errors out because of an infinite zero-delay loop). Consult your simulation help for more information on
how to work with your simulation library and detect infinite zero-delay loops caused by high resolution

values.
Family Default Resolution

ProASIC3 1ps
IGLOO 1ps
SmartFusion and Fusion 1ps
SmartFusion2 1fs
IGLOO2 1ps
RTG4 1ps

e Additional options: Text entered in this field is added to the vsim command.

Simulation Libraries

e Verilog (or VHDL) library path - Enables you to choose the default library for your device, or to
specify your own library. Enter the full pathname of your own library to use it for simulation.

o Restore Defaults: Restores factory settings.

Selecting a Stimulus File for Simulation

Before running simulation, you must associate a testbench. If you attempt to run simulation without an
associated testbench, the Libero SoC Project Manager asks you to associate a testbench or open ModelSim
without a testbench.

To associate a stimulus:

1. Run simulation or in the Design Flow window under Verify Pre-Synthesized Design right-click
Simulate and choose Organize Input Files > Organize Stimulus Files. The Organize Stimulus Files
dialog box appears.

2. Associate your testbench(es):

In the Organize Stimulus Files dialog box, all the stimulus files in the current project appear in the
Source Files in the Project list box. Files already associated with the block appear in the Associated
Source Files list box.

In most cases you will only have one testbench associated with your block. However, if you want
simultaneous association of multiple testbench files for one simulation session, as in the case of
PCI cores, add multiple files to the Associated Source Files list.

To add a testbench: Select the testbench you want to associate with the block in the Source Files
in the Project list box and click Add to add it to the Associated Source Files list.

To remove a testbench: To remove or change the file(s) in the Associated Source Files list box,
select the file(s) and click Remove.

To order testbenches: Use the up and down arrows to define the order you want the testbenches
compiled. The top level-entity should be at the bottom of the list.

3.  When you are satisfied with the Associated Source Files list, click OK.

Selecting Additional Modules for Simulation
Libero SoC passes all the source files related to the top-level module to simulation .
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If you need additional modules in simulation, in the Design Flow window right-click Simulate and choose
Organize Input Files > Organize Source Files. The Organize Files for Simulation dialog box appears.
Select the HDL modules you wish to add from the Simulation Files in the Project list and click Add to add
them to the Associated Stimulus Files list

Performing Functional Simulation

To perform functional simulation:

1.
2.

6.

Create your testbench.
Right-click Simulate (in Design Flow window, Implement Design > Verify Post-Synthesis
Implementation > Simulate) and choose Organize Input Files > Organize Source Files from the
right-click menu.
In the Organize Files for Source dialog box, all the stimulus files in the current project appear in the
Source Files in the Project list box. Files already associated with the block appear in the Associated
Source Files list box.
In most cases you will only have one testbench associated with your block. However, if you want
simultaneous association of multiple testbench files for one simulation session, as in the case of
PCI cores, add multiple files to the Associated Source Files list.
To add a testbench: Select the testbench you want to associate with the block in the Source Files
in the Project list box and click Add to add it to the Associated Source Files list.

To remove a testbench: To remove or change the file(s) in the Associated Source Files list box,
select the file(s) and click Remove.
When you are satisfied with the Associated Simulation Files list, click OK.

To start ModelSim AE, right-click Simulate in the Design Hierarchy window and choose Open
Interactively.

ModelSim starts and compiles the appropriate source files. When the compilation completes, the
simulator runs for 1 us and the Wave window opens to display the simulation results.

Scroll in the Wave window to verify that the logic of your design functions as intended. Use the zoom
buttons to zoom in and out as necessary.

From the File menu, select Quit.

Performing DirectCore Functional Simulation

Libero SoC overwrites all the existing files of the Core when you import a DirectCore project (including
testbenches). Save copies of your project stimulus files with new names if you wish to keep them.

You must import a DirectCore BFM file into the Libero SoC in order to complete functional simulation (the
BFM is a stimulus file that you can edit to extend the testbench). VEC files are generated automatically from
the BFM when you run ModelSim.

The SoC Project Manager overwrites your BFM file if you re-import your project. Edit and save your BFM
outside the Libero SoC project to prevent losing your changes. After you re-import your DirectCore project,
you can import your modified BFM again.

To perform functional simulation of a DirectCore project:

1.
2.

Right-click a stitched module of the DirectCore project and select Set as root.

To start ModelSim AE, right-click Simulate in the Design Hierarchy window and choose Open
Interactively.

ModelSim starts and compiles the appropriate source files. When the compilation completes, the
simulator runs for 1 us and the Wave window opens to display the simulation results.

Scroll in the Wave window to verify that the logic of your design functions as intended. Use the zoom
buttons to zoom in and out as necessary.

From the File menu, select Quit.
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In the FPGA design world, constraint files are as important as design source files. Constraint files are used
throughout the FPGA design process to guide FPGA tools to achieve the timing and power requirements of
the design. For the synthesis step, SDC timing constraints set the performance goals whereas non-timing
FDC constraints guide the synthesis tool for optimization. For the Place-and-Route step, SDC timing
constraints guide the tool to achieve the timing requirements whereas Physical Design Constraints (PDC)
guide the tool for optimized placement and routing (Floorplanning). For Static Timing Analysis, SDC timing
constraints set the timing requirements and design-specific timing exceptions for static timing analysis.

Libero SoC provides the Constraint Manager as the cockpit to manage your design constraint needs. This is
a single centralized graphical interface for you to create, import, link, check, delete, edit design constraints
and associate the constraint files to design tools in the Libero SoC environment. The Constraint Manager
allows you to manage constraints for SynplifyPro synthesis, Libero SoC Place-and- Route and the
SmartTime Timing Analysis throughout the design process.

To enable the Constraint Manager in the Design Flow window, check the Enhanced Constraint Flow
checkbox in the pop-up window at the end of project creation.

Note: The Enhanced Constraint Flow option is available only for SmartFusion2, IGLOO2, RTG4.
| Mew Project Information @

Libero SoC v11.7 introduces an enhanced constraint flow aimed at simplifying the management of all constraints for your design:

* 140, timing, floor planning and netlist optimization constraints can be created, imported, edited, checked and organized in a single view,

* Tirning constraints can be entered using standard SDC format and the same set of constraints can be automatically applied to both Synopsys’
Synplify synthesis, Timing Driven Place and Route and Timing verification,

m

* & new SDC clock group constraint is also introduced and can be used to ease the specification of related and unrelated clocks.
* Tirning constraints for known hardware blocks and 1Ps can be derived automatically; examples of such constraints are:
©SERDES-EPCS, MSS/MHPMS and internal oscillator clock sources
oFabric CCCs generated clocks
oFabric CCCs clock sources
o CoreResetf false paths
oCoreConfigP false paths, min and max delay constraints
Note that this first release of the enhanced constraint flow has the following limitations:
* The block flow is not enabled

* The design separation methodalogy is not enabled i

Reemember my choice and do not show me again, [Use Classic Canstraink F\owﬂUse Enhanced Constraint Flow| ,

Figure 37 - New Project Information Dialog Box

Note: If you plan to always use the Enhanced Constraint Flow for your new projects and you don’t want to
be prompted to make a selection for Classic Constraint Flow versus Enhanced Constraint Flow every time
you create a new project, you may set your personal preferences in the Project > Preferences > Design
Flow dialog box as follows:

e  Check the box Use Enhanced Constraint Flow when creating a new project.

e Uncheck the box Show Classic/Enhanced Constraint Flow choice dialog when creating a new

project.
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G‘ Preferences M

Softw dat

o alre update Constraint flow
Leg window
Startup Use enhanced constraint flow when creating a new project.
}lrle::;miﬁ\ccess [”] Show dassicfenchanced constraint flow choice dialog when creating a new project.

editor

1P Cores Warn me when derived timing constraints generation override existing constraints (enhanced constraint flow).
Design Flow
Proxy Design flow rule checks

Warn me when Firmware application must be recompiled because of hardware configuration changes.

Warn me when I/Os are not all assigned and locked before programming data generation.

o) (ot ]

Figure 38 - Project > Preferences > Design Flow Dialog

Invocation of Constraint Manager From the Design Flow Window
After project creation, double-click Manage Constraints in the Design Flow window to open the Constraint

Manager.
| Constraink Manager & X | Reports & X | EMS_MDDR 5 X | M3_MDDR_top_derived_constraints.sde @ X | =
CIIO Attributes \/ Timing \/ Floor Flanner \/ Netlist Attributes D"" Constraints Tab
[ Mew ] [ Impart ] [ Link, ] [Edit with Constraint Editor V] [ Check V] [Derive Constraints] [ Help l  d )
- Svnthesis Flace and Route Timing Yerification 7
constraintyW3_MODR_top_derived_canstraints.sdc =
E)?\gs\gzlr:t\\gos;zzf‘scource\mytiming2.sdc E Con straints
ionstraint\myuserl.sdc File Order
File and Tool Association

Figure 39 - Constraint Manager

Libero SoC Design Flow

The Constraint Manager is Libero SoC's single centralized Graphical User Interface for managing
constraints files in the design flow.
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e : [ — %, Netlist Attributes FDC/NDC
| Post-Synthesis | .
— Simulation :< ___________ Place & Route Constraints
: (Optional) | | Derived Constraints SDC
___________ Place and Route +-_________ user2.sdc
: Post-Layout | I/0 PDC
o simulation K[ttt Floor Planning PDC
! Optional | iy Timi
'————{—p———}——~ | PR +\ [Timing Verification Constraints
Derived Constraints SDC
user3.sdc
A 4

Program and Debug Design

Generate Bitstream
Program Device
SmartDebug

v

Handoff for Firmware Dev.

Handoff for Production
Security Options

Handoff for Debugging

Figure 40 - Constraint Manager in Libero SoC Design Flow

Synthesis Constraints

The Constraint Manager manages these synthesis constraints and passes them to SynplifyPro:
e Synplify Netlist Constraint File (*.fdc)
e Compile Netlist Constraint File (*.ndc)
e SDC Timing Constraints (*.sdc)
e Derived Timing Constraints (*.sdc)

Synplify Netlist Constraints (*.fdc)

These are non-timing constraints that help SynplifyPro optimize the netlist. From the Constraint Manager
Netlist Attribute tab import (Netlist Attributes > Import) an existing FDC file or create a new FDC file in the
Text Editor (Netlist Attributes > New > Create New Synplify Netlist Constraint). After the FDC file is
created or imported, click the checkbox under synthesis to associate the FDC file with Synthesis.
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Compile Netlist Constraints (*.ndc)

These are non-timing constraints that help Libero SoC optimize the netlist by combining 1/Os with registers.

1/0s are combined with a register to achieve better clock-to-out or input-to-clock timing. From the Constraint
Manager Netlist Attribute tab import (Netlist Attributes > Import) an existing NDC file or create a new NDC
file in the Text Editor (Netlist Attributes > New > Create New Compile Netlist Constraint). After the NDC
file is created or imported, click the checkbox under synthesis to associate the NDC file with Synthesis.

SDC Timing Constraints (*.sdc)

These are timing constraints to guide SynplifyPro to optimize the netlist to meet the timing requirements of
the design. From the Constraint Manager Timing tab, import (Timing > Import) or create in the Text Editor
(Timing > New) a new SDC file. After the SDC file is created or imported, click the checkbox under
synthesis to associate the SDC file with Synthesis.

After the synthesis step, you may click Edit with Constraint Editor > Edit Synthesis Constraints to open
the Timing Constraints Editor to edit existing constraints or add new SDC constraints.

Derived Timing Constraints (*.sdc)

These are timing constraints LiberoSoC generates for IP cores used in your design. These IP cores,
available in the Catalog, are family/device-dependent. Once they are configured, generated and instantiated
in the design, the Constraint Manager can generate SDC timing constraints based on the configuration of
the IP core and the component SDC. From the Constraint Manager Timing tab, click Derive Constraints to
generate the Derived Timing Constraints (*.sdc). Click the *derived_constraints.sdc file to associate it with
synthesis.

Place and Route Constraints
The Constraint Manager manages these constraints for the Place-and-Route step:
e |/O PDC Constraints (*io.pdc)
e Floorplanning PDC Constraints (*fp.pdc)
e Timing SDC constraint file (*.sdc)

I/O PDC Constraints

These are /O Physical Design Constraints in an *io.pdc file. From the Constraint Manager 1/O Attribute tab,
you may import (I/O Attributes > Import) or create in the Text Editor (I/O Attributes > New) an *io.pdc file.

Click the checkbox under Place and Route to associate the file with Place and Route.

Floorplanning PDC Constraints

These are floorplanning Physical Design Constraints in a *fp.pdc file. From the Constraint Manager Floor
Planner tab, you may import (Floor Planner > Import) or create in the Text Editor (Floor Planner > New) a
*fp.pdc file. Click the checkbox under Place and Route to associate the file with Place and Route.

Timing SDC Constraint file (*.sdc)

These are timing constraint SDC files for Timing-driven Place and Route. From the Constraint Manager
Timing tab, you may import (Timing > Import) or create in the Text Editor (Timing > New) a timing SDC
file. Click the checkbox under Place and Route to associate the SDC file with Place and Route. This file is
passed to Timing-driven Place and Route (Place and Route > Configure Options > Timing Driven).

Timing Verifications Constraints

The Constraint Manager manages the SDC timing constraints for Libero SoC’s SmartTime, which is a
Timing Verifications/Static Timing analysis tool. SDC timing constraints provide the timing requirements (e.g.
create_clock and create_generated_clock) and design-specific timing exceptions (e.g. set_false_path and
set_multicycle_path) for Timing Analysis.

From the Constraint Manager Timing tab, you may import (Timing > Import) or create in the Text Editor
(Timing > New) a SDC timing file. Click the checkbox under Timing Verifications to associate the SDC
timing constraints file with Timing Verifications.
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Note: You may have the same set of SDC Timing Constraints for Synthesis, Place and Route and Timing
Verifications to start with in the first iteration of the design process. However, very often and particularly
when the design is not meeting timing requirements you may find it useful in subsequent iterations to have
different sets of Timing SDC files associated with different tools. Take for example; you may want to
change/modify the set of SDC timing constrains for Synthesis or Place and Route to guide the tool to focus
on a few critical paths. The set of SDC timing constraints associated with Timing Verifications can remain
unchanged.

The Constraint Manager lets you associate/dis-associate the constraint files with the different tools with a
mouse click.

Constraint Manager Components
The Constraint Manager has four tabs, each corresponding to a constraint type that Libero SoC supports:
e |/O Attributes
e Timing
e Floor Planner
¢ Netlist Attribute
Clicking the tabs displays the constraint file of that type managed in the Libero SoC project.

Constraint File and Tool Association
Each constraint file can be associated/dis-associated with a design tool by checking and unchecking the
checkbox corresponding to the tool and the constraint file. When associated with a tool, the constraint file is
passed to the tool for processing.

(110 Attributes \/ Tening '\/ Floor Planner 1/ Nefist Attributes |

New impart Link Edit with Constraint Editor |»| | Check - |Desive Constraints Help + |4
Synthesis Place and Route  Timing Verification
constraint\usersde [ Target ] S i 4
D:\2Work\Const_source'\mytiming2.sdc v 4

Figure 41 - Constraint File and Tool Association

Note: Libero SoC'’s Design Flow window displays the state the tool is in. A green check mark V indicates

successful completion. A warning icon indicates invalidation of the state because the input files for the
tool have changed since the last successful run. Association of a new constraint file with a tool or dis-
association of an existing constraint file with a tool invalidates the state of the tool with which the constraint
file is associated.

All Constraint files except Netlist Attributes can be opened, read and edited by Interactive Tools invoked
from the Constraint Manager directly. The Interactive Tools are:

e |/O Editor
e Chip Planner
e Constraint Editor
The file type, file extension, location, tool association and Interactive Tool (for editing) of the constraints are

listed below.
Constraint | Constraint | Location inside Project | Associated Interactive
Type File with Design Tool (For
Extension Tool Editing)
1/0 Attributes | PDC (*.pdc) Place and I/O Editor
<proj>\constraints\io\*.pdc | Route
PDC (*.pdc) Place and Chip
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Constraint | Constraint | Location inside Project | Associated Interactive
Type File with Design Tool (For
Extension Tool Editing)
Floorplanning <proj>\constraints\fp\*.pdc | Route Planner
Timing SDC (*.sdc) | <proj>\constraints\*.sdc Synthesis, Constraint
Place and Editor
Route, Timing
Verification
Netlist FDC (*.fdc) | <proj>\constraints\*.fdc Synthesis n/a
Attributes
NDC <proj>\constraints\*.ndc Synthesis n/a
(*.ndc)

User Actions on Constraint File
Right-click a Constraint File and drop-down menu items appear:

Set/Unset as Target — Set/Unset a constraint file as Target. A constraint file, when set as target,
receives and stores new constraints from the Interactive Tools: I/O Editor, Chip Planner, and
Constraint Editor. When a constraint is added, and then saved in the Interactive Tool, the constraint
file set as target is updated to store the new constraints added in the Interactive Tool. When no
constraint file is associated with a tool or no constraint file is set as target, the Constraint Manager
creates a new constraint file (user.sdc or user.pdc) to store the newly-added constraints from the
Interactive Tool and set the new constraint file as Target.
Note: Netlist Attribute constraint (*.fdc and *.ndc) file cannot be Set as Target. Only SDC (*.sdc)
and PDC (*.pdc) files can be Set as Target.
Open in Text Editor — Opens the selected Constraint File in Libero SoC’s Text Editor for Editing.
Clone — Save the selected constraint file with a new name. The original file remains intact.
Rename — Rename the selected constraint file to a new name. The original file is deleted.
Copy File Path — Copy the file path to the clipboard.
Delete from Project and Disk — Delete the file physically from Disk and Project.

Note: Deleting a constraint file associated with a tool invalidates the tool state in the Design Flow
Window.

Note: Using the Text Editor to change a constraint file associated with a tool invalidates the tool
state in the Design Flow Window.

Derive Constraints in Timing Tab

The Constraint Manager can generate timing constraints for IP cores used in your design. These IP cores,
available in the Catalog, are family/device-dependent. Once they are configured, generated and instantiated
in your design, the Constraint Manager can generate SDC timing constraints based on the configuration of
the IP core and the component SDC. A typical example of an IP core for which the Constraint Manager can
generate SDC timing constraints is the IP core for Clock Conditioning Circuitry (CCC).

To generate SDC timing constraints for IP cores:

1.
2.

Configure and generate the IP Core.

From the Constraint Manager's Timing tab, click Derive Constraints (Constraint Manager > Timing >
Derive Constraints).

The Constraint Manager generates the <root>_derived_constraints.sdc file and places it in the Timing
Tab along with other user SDC constraint file.

When prompted for a Yes or No on whether or not you want the Constraint Manager to
automatically associate the derived SDC file to Synthesis, Place and Route, and Timing Verification,
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click Yes to accept automatic association or No and then check or uncheck the appropriate checkbox
for tool association.

Note: Microsemi recommends the <root>_derived_constraints.sdc be always associated with all
three tools: Synthesis, Place and Route, and Verify Timing. Before running SynplifyPro Synthesis,
associate the <root>_derived_constraints.sdc file with Synthesis and Place and Route. This will
ensure that the design objects (such as nets and cells) in the <root>_derived_constraints.sdc file
are preserved during the synthesis step and the subsequent Place and Route step will not error out
because of design object mismatches between the post-synthesis netlist and the
<root>_derived_constraints.sdc file.

Note: Full hierarchical path names are used to identify design objects in the generated SDC file.

Note: The Derive Constraints button is available for HDL-based, SmartDesign-based, and System Builder-
based design flows. It is not available if the design source is EDIF/EDN.

Create New Constraints
From the Constraint Manager, create new constraints in one of two ways:
e Use the Text Editor
e Use Libero SoC'’s Interactive Tools
To create new constraints from the Constraint Manager using the Text Editor:
1. Select the Tab that corresponds to the type of constraint you want to create.
Click New.
When prompted, enter a file name to store the new constraint.
Enter the constraint in the Text Editor.
Click OK.

The Constraint file is saved and visible in the Constraint Manager in the tab you select:

a ks wn

e 1/O Attributes constraint file (<proj>\io\*.pdc) in the I/O Attributes tab
e Floorplanning constraints (<proj>\fp\*.pdc) in the Floor Planner tab
¢ Timing constraints (<proj>\constraints\*.sdc) in the Timing tab

6. (Optional) Double-click the constraint file in the Constraint Manager to open and add more constraints
to the file.
To create new constraints from the Constraint Manager using Interactive Tools:

Note: Netlist Attribute constraints cannot be created by an Interactive Tool. Netlist Attribute files can only be
created with a Text Editor.

Note: Except for timing constraints for Synthesis, the design needs to be in the post-synthesis state to
enable editing/creation of new constraints by the Interactive Tool.

Note: The *.pdc or *.sdc file the Constraint Manager creates is marked [Target]. This denotes that it is the
target file. A target file receives and stores new constraints from the Interactive Tool. When you have
multiple constraint files of the same type, you may select any one of them as target. When there are multiple
constraint files but none of them is set as target, or there are zero constraint files, Libero SoC creates a hew
file and set it as target to receive and store the new constraints created by the Interactive Tools.

1. Select the Tab that corresponds to the type of constraint you want to create.

Click Edit to open the Interactive Tools. The Interactive Tool that Libero SoC opens varies with the
constraint type:

e |/O Editor to edit/create /O Attribute Constraints
e Chip Planner to edit/create Floorplanning constraints
e Constraint Editor to edit/create Timing Constraints

3. Create the Constraints in the Interactive Tool. Click Commit and Save.

4. Check that Libero SoC creates these file to store the new constraints:
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e Constraints\io\user.pdc file when I/O constraints are added in 1/0 Editor.

e Constraints\fp\user.pdc file when floorplanning constraints are added in Chip
Planner.

e Constraints\user.sdc file when Timing Constraints are added in Constraint
Editor

Constraint File Order

When there are multiple constraint files of the same type associated with the same tool, use the Up and
Down arrow to arrange the order the constraint files are passed to the associated tool. Constraint file order
is important when there is a dependency between constraints files. When a floorplanning PDC file assigns a
macro to a region, the region must first be created and defined. If the PDC command for region creation and
macro assignment are in different PDC files, the order of the two PDC files is critical.

1. To move a constraint file up, select the file and click the Up arrow.

2. To move a constraint file down, select the file and click the Down arrow.

1/0 Attributes /" Timing \/” Floor Planner \/” Netiist Attributes "\

I Mew I I Import I I Link I IEdit with Constraint Editor v] [ Check v] [Derive Consh’aimsl [ Help I +
Synthesis Place and Route  Timing Verification | Mave U_p

constraint\usersdc 0 B

D:\2Work\Const_sourcelmytiming2.sdc 0 0

constraint\myuserl.sdc |:| D |:|

Figure 42 - Move constraint file Up or Down

Note: Changing the order of the constraint files associated with the same tool invalidates the state of that
tool.

Import a Constraint File

Use the Constraint Manager to import a constraint file into the Libero SoC project. When a constraint file is
imported, a local copy of the constraint file is created in the Libero Project.
To import a constraint file:

1. Click the Tab corresponding to the type of constraint file you want to import.

2. Click Import.

3. Navigate to the location of the constraint file.

4

Select the constraint file and click Open. A copy of the file is created and appears in Constraint
Manager in the tab you have selected.

Link a Constraint File

Use the Constraint Manager to link a constraint file into the Libero SoC project. When a constraint file is
linked, a file link rather than a copy is created from the Libero project to a file physically located and
maintained outside the Libero SoC project.
To link a constraint file:

1. Click the Tab corresponding to the type of constraint file you want to link.

2. Click Link.

3. Navigate to the location of the constraint file you want to link to.

4

Select the constraint file and click Open. A link of the file is created and appears in Constraint
Manager under the tab you have selected. The full path location of the file (outside the Libero SoC
project) is displayed.

Check a Constraint File
Use the Constraint Manager to check a constraint file.
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To check a constraint file:
1. Select the tab for the constraint type to check.
2. Click Check.
Note: I/O constraints, Floorplanning constraints, Timing constraints, and Netlist Attributes can be checked

only when the design is in the proper state. A pop-up message appears when the check is made and the
design state is not proper for checking.

# | Information @

1'0} Please run 'Synthesize' before executing Check Operation

- s

All constraint files associated with the tool are checked. Files not associated with a tool are not checked.

For Timing Constraints, select from the Check drop-down menu one of the following:
e Check Synthesis Constraints
e Check Place and Route Constraints
e Check Timing Verification Constraints

1/0 Attributes /" Timing \/" Floor Planner /" Netlist Attributes \

[ New ] ‘ Impart J I Link. ‘ IEd\twim Constraint Editor 'J { Check '] V[Derive Consbaintsl l He!p ] +

Synthesis Check Synthesis Constraints

constraintyM3_MDDR_top_derived_constraints.sdc
constraint\usersdc

constraint\mytiming.sdc
constraint\mytiming2.sdc [ Target |
constraint\sdfsadf.sdc

EE

Check Place And Route Cor\;traiﬂtjﬂ\s
i

Check Timing Verification Constrai

ooE
of
OOoR

oo

Figure 43 - Check Constraints
Check Synthesis Constraints checks only the constraint files associated with the Synthesis.
Check Place and Route Constraints checks only the constraint files associated with Place and Route

Check Timing Verification Constraints checks only the Constraint Files associated with Timing
Verification.

For the constraint files and tool association shown in the SDC file and Tool Association Figure below:
e Check Synthesis Constraints checks the following files:
e M3_MDDR_top_derived_constraints.sdc
e user.sdc
e mytiming2.sdc
e Check Place and Route Constraints checks the following files:
e M3_MDDR_top_derived_constraints.sdc
e mytiming.sdc
e mytiming2.sdc
e Check Timing Verification Constraints checks the following files:
e M3_MDDR_top_derived_constraints.sdc
e user.sdc
e mytiming.sdc
e mytiming2.sdc
Note: sdfsadf.sdc Constraint File is not checked because it is not associated with any tool.
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[ mew ][ mport ][ wunk | [Editwith ConstrantEditor [+] [ Check [+| [Derve Constrants] [ Heb 1
Synthesis Place and Route  Timing Verification

constraint\M3_MDDR_top_derived_constraints.sdc [l &1 =

constraintiusersde ¥ | =

censtraint\mytiming.sdc [E lE]

constraint\mytiming2.sdc [ Target] il =

constraint\sdfsadf.sdc Gl

Figure 44 - Timing Constraints SDC file and Tool Association
When a constraint file is checked, the Constraint Manager:
e Checks the SDC or PDC syntax.

e Compares the design objects (pins, cells, nets, ports) in the constraint file versus the design objects in
the netlist (RTL or post-layout ADL netlist). Any discrepancy (e.g. constraints on a design object which
does not exist in the netlist) are flagged as errors and reported in the *.log file or message window.

Check Result
If the check is successful, this message pops up.

.| Information ﬁ

If the check fails, this error message pops up.

’El Error Li_E-J

Constraint Check for Required Netlist Check Result Details
Type Tools Design State | Used for In
Before Design
Checks Objects
Checks
110 Place and Post- ADL Netlist | Libero Message
Constraints Route Synthesis Window
Floorplanning | Place and Post- ADL Netlist | Libero Message
Constraints Route Synthesis Window
Timing Synthesis Pre- RTL Netlist
Constraints Synthesis synthesis_sdc_check.log
Place and Post- ADL Netlist | placer_sdc_check.log
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Constraint Check for Required Netlist Check Result Details
Type Tools Design State | Used for In
Before Design
Checks Objects
Checks
Route Synthesis
Timing Post- ADL Netlist | timing_sdc_check.log
Verifications | Synthesis
Netlist Synthesis Pre- RTL Netlist | *cck.srr file
Attributes Synthesis
(*.fdc)
Netlist Synthesis Pre- RTL Netlist | Libero Log Window
Attributes Synthesis
(*.ndc)

Edit a Constraint File
The Edit button in the Constraint Manager allows you to:

e Create new constraint files. See To create new constraints from the Constraint Manager using the Text
Editor for details.

o Edit existing constraint files.
To edit a constraint file

Note: Netlist Attributes cannot be edited by an Interactive Tool. Use the Text Editor to edit the Netlist
Attribute constraint (*.fdc and *.ndc) files.

1. Select the tab for the constraint type to edit. An Interactive Tool is opened to make the edits.
2. Click Edit.

e All constraint files associated with the tool are edited. Files not associated with
the tool are not edited.

e When a constraint file is edited, the constraints in the file are read into the
Interactive Tool.

e Different Interactive Tools are used to edit different constraints/different files:

e |/O Editor to edit /O Attributes (<proj>\io\*.pdc). For
details, refer to the 1/0O Editor in Libero SoC Online
Help.

e Chip Planner to edit Floorplanning Constraints
(<proj>\fp\*.pdc). For details, refer to the Chip Planner
User's Guide (Chip Planner > Help > Reference
Manuals)

e Constraint Editor to edit Timing Constraints
(constraints\*.sdc). For details, refer to the Timing
Constraints Editor User’s Guide (Help > Constraints
Editor User’s Guide)

Note: I/O constraints, Floorplanning constraints, Timing constraints can be edited only when the design is in
the proper state. A message pops up if the file is edited when the design state is not proper for edits. If, for
example, you open the Constraints Editor (Constraint Manager > Edit) to edit timing constraints when the
design state is not post-synthesis, a pop-up message appears.
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5. Information 28

:] Flease run 'Synthesize' before executing Edit Operation

A

3. For Timing Constraints, click one of the following to edit from the Edit with Constraint Editor drop-down

menu.
e Edit Synthesis Constraints
e Edit Place and Route Constraints
e Edit Timing Verification Constraints
| Reports & x | streage @ x | ConstraintManager & X | usersic @ X | testficfdc & X | M3.MDDR_top_cckem & X | 5
10 Attributes \/ Timing \/ Floor Planner \/ Nefist Attributes '\
[ mew |[ mpert |[ unk | [EditwithconstraintEditor [v] [ check [+| [Derve constaints| [ hep | +

Edit Synthesis Constraints Timing Verification

constraint\user.sdc [ Target] Edit Place And Route Constraints
D:\2Work\Const_source\mytiming2.sdc Edit Timing Verification Constraints

Figure 45 - Edit Drop-down Menu
For the constraint files and tool association shown in the Timing Constraint File and Tool Association below:
e Edit Synthesis Constraints reads the following files into the Constraint Editor:
e user.sdc
e myuserl.sdc
o Edit Place and Route Constraints reads the following files into the Constraint Editor:
e user.sdc
e mytiming2.sdc
e myuserl.sdc
e Edit Timing Verification Constraints reads the following files into the Constraint Editor:
e user.sdc
e mytiming2.sdc
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Synthesis Place and Route  Timing Verification
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D:\2Work'\Const_source\mytiming2.sdc =
constraint\myuserl.sde 0

Figure 46 - Timing Constraint File and Tool Association
4. Edit the constraint in the Interactive Tool, save and exit.
5. The edited constraint is written back to the original constraint file when the tool exits.

Refer to the Timing Constraints Editor User’'s Guide (Help > Constraints Editor User’s Guide) for details on
how to enter/modify timing constraints.

Note: When a constraint file is edited inside an Interactive Tool, the Constraint Manager is disabled until the
Interactive Tool is closed.

Note: Making changes to a constraint file invalidates the state of the tool with which the constraint file is
associated. For instance, if Place and Route has successfully completed with user.sdc as the associated
constraint file, then making changes to user.sdc invalidates Place and Route. The green checkmark
(denoting successful completion) next to Place and Route turns into a warning icon when the tool is

invalidated.
v S Synthesize
4 | Verify Post-Synthesis Implementation
. Simulate
*_| Configure Flash*Freeze
i ﬁ:; Place and Route

4 b Verify Post Layout Implementation
*_| Generate Back Annotated Files
. Simulate
(4 Verify Timing
ﬁl Werify Power

Figure 47 - Place and Route Invalidation

Timing Constraints Editor

The Timing Constraints Editor enables you to create, view, and edit timing constraints. This editor includes

powerful visual dialogs that guide you toward capturing your timing requirements and timing exceptions
quickly and correctly.
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# Constraints
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% Clock - — -
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=

Figure 48 - Constraints Editor
The Constraints Editor window is divided into a Constraint Browser, Constraint List, and a Constraint Adder.

Constraints Browser
The Constraint Browser categorizes constraints based on three types of Constraints:

e Requirements — General constraints to meet the design’s timing requirements and specifications.
Examples are clock constraints and generated clock constraints.

e Exceptions — Constraints on certain timing paths for special considerations by SmartTime. Examples
are false path constraints and multicycle path constraints.

e Advanced — Special timing constraints such as clock latency and clock groups

Constraints List

This is a spreadsheet-like list of the constraints with detailed values and parameters of the constraint
displayed in individual cells. You may click on individual cells of the spreadsheet to change the values of the
constraint parameters.

Constraints Adder

This is the first row of the spreadsheet-like constraint list. There are 2 ways of adding a constraint from this
row. User can right click on the row, and select Add Constraint to add a constraint of the same type to the
Constraint List. This method will invoke the specific add constraint dialog.

Alternatively, user can select a cell by clicking in it. Then follow by double-clicking and start typing text. This
method of creating a constraint is targeted at the experienced user who knows the design well, and need not
rely on the dialog box for guidance.

You can perform the following tasks in the Constraints View:
e Select a constraint type from the Constraint Browser and create or edit the constraint.
e Add a new constraint and check the syntax.
e Right-click a constraint in the Constraints List to edit or delete.
e Use the first row to create a constraint (as described above), and add it to the main table (list)

Constraint Icons

Across the top of the Constraint Editor is a list of icons you can click to add constraints. Tooltips are
available to identify the constraints.

Icon Name

Add Clock Constraint
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Icon

Name

Add Generated Clock Constraint

Add Input Delay Constraint

Add Output Delay Constraint

Add Maximum Delay Constraint

1

Add Minimum Delay Constraint

oz

Add Multicycle Path Constraint

5

Add False Path Constraint

Add Disable Timing Constraint

g

3

Add Clock Source Latency

1

Add Clock to Clock Uncertainty

Adding Constraints

The Constraints Editor provides four ways to add Constraints. The Add Constraints dialog box appears
when you add constraints in one of the following four ways:

e Click the Add Constraint icon. Example: Click to add False Path Constraints.
e From the Constraints Browser, choose the type of Constraints to add. Example: False Path
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| # Reguisernents T Synban From Through

[ | ¥ Clock

| ‘Generated Clock
Input Dilay

=

Chck: within this: row to add & constrant.

| L4 *aot_pins { Q5L 1] o _poms (=10 =]
| Outpat Delay |

| Extermal Check

| Clock To Out

1

~

# Exceptions b
¥ Mine Dielay

| Min Delay

|, xmieran L3 :

| 4 Advanced | AddFabe Path comstraint |

| Disable Tiening E i

| Clock Sousce Latency
Clock Uncerainity -

s " J v (A M -

13
E ! - " =

e Choose False Path from the Constraints drop-down menu (Constraints > False Path).

" | Clock... RG]

Constraint Generated Clock... T

Input Delay..

4 q Cuutput Delay.,
1 Esternal Check...

Clock To Out... Click within this row b0 594 & constraint

Mux Delsy. v [oet_pins { QfsHELK ] [get_ports { qfs1}]
kdin Delay...

Multicycle...
False Path...

Syntax From Through

L 8|

Disable Timing...
Clock Source Latency:..
Clock-to-clock Uncertainty...

Clock Groups...
CIOCE SOUrCeE Latency
Clock Uncertainity
Clock Groups

. =

i m ] 4 ] | 3

¢ Right-click the first row and choose Add False Path Constraint.
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See Also
Set Clock Constraints

Set Generated Clock Constraints

Set Input Delay Constraints

Set Output Delay Constraints

Set External Check Constraints

Set Clock to Out Constraints

Set False Path Constraints

Set Multicycle Path Constraints

Set Minimum Delay Constraints

Set Maximum Delay Constraints

Set Disable Timing Constraint

Set Clock to Clock Uncertainty Constraint

Set Clock Source Latency Constraint

Set Clock Groups Constraint

Set Clock Constraints

Adding a clock constraint is the most effective way to constrain and verify the timing behavior of a sequential
design. Use clock constraints to meet your performance goals.

To set a clock constraint, open the Create Clock Constraint dialog box in one of the following four ways:

From the Constraints Browser, choose Clock.
fin

Double-click the Add Clock Constraint icon

Choose Clock from the Constraints drop-down menu (Constraints > Clock).

Right-click the first row or any other row (if they exist) in the Clock Constraints Table and choose Add
Clock Constraint.
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The Create Clock Constraint dialog box appears.

i Create Clock Constraint (2 [t

Clock Name : Clock Source : - Q

——— Period: ns — M o Frequency: Mhz

e—— Offset: ———dja— Duty cyde : ———f
0.000 ns 50,0000 %

Comment :

'
‘

Figure 49 - Create Clock Constraint Dialog Box
Clock Name
Specifies the name of the clock constraint.

Clock Source

Select the pin to use as clock source. You can click the Browse button to display the Select Source Pins for
Clock Constraint Dialog Box.

P -
7 Select Source Pins for Clock Constraint | 2

Spedify pins :- @ by explidtlist () by keyword and wildcard

Available Pirs: Assigned Pins:

=
=
=]
»

m

[kt

EN All

Filter available pins :

Pin Type : |Input Ports - ok )
i it ) [ conc_]

Figure 50 - Select Source Pin for Clock Constraint Dialog Box
The Pin Type options are:
e Input Ports
e All Pins
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e All Nets

Use the Select Source Pin for Clock Constraint dialog box to display a list of source pins from which you can
choose. By default, it displays the Input Ports of the design.

To choose other pin types in the design as clock source pins, click the drop-down and choose Input Ports,
All Pins, or All Nets. To display a subset of the displayed clock source pins, you can create and apply a
filter. The default filter is * (wild-card for all).

Click OK to save these dialog box settings.

Period/Frequency

Specifies the Period in nanoseconds (ns) or Frequency in MegaHertz (MHz). When you edit the period, the
tool automatically updates the frequency value and vice versa. The frequency must be a positive real
number. Accuracy is up to 3 decimal places.

Starting Clock Edge Selector

Offset

Duty Cycle

Comment

Click the Up or Down arrow to use the rising or falling edge as the starting edge for the created clock.

Indicates the shift (in nanoseconds) of the first clock edge with respect to instant zero common to all clocks
in the design.

The offset value must be a positive real number. Accuracy is up to 2 decimal places. Default value is 0.

This number specifies the percentage of the overall period that the clock pulse is high. The duty cycle must
be a positive real number. Accuracy is up to 4 decimal places. Default value is 50%.

Enter a single line of text that describes the clock constraints purpose.

See Also
create clock (SDC)

Set Generated Clock Constraints

Use the generated clock constraint to define an internally generated clock for your design and verify its
timing behavior. Use generated clock constraints and clock constraints to meet your performance goals.

To set a generated clock constraint, open the Create Generated Clock Constraint dialog box in one of the
following four ways:

e From the Constraints Browser, choose Generated Clock.

e Double-click the Add Generated Clock Constraint icon
e Choose Generated Clock from the Constraints drop-down menu (Constraints > Generated Clock).

¢ Right-click any row in the Generated Clock Constraints Table and choose Add Generated Clock
Constraint.

The Create Generated Clock Constraint dialog box appears.
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Comment :
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Figure 51 - Create Generated Clock Constraint Dialog Box
Clock Pin

Select a Clock Pin to use as the generated clock source. To display a list of the available generated clock
source pins, click the Browse button. The Select Generated Clock Source dialog box appears.
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Cutout Ports

Figure 52 - Select Generated Clock Source Dialog Box

The Pin Type options for Generated Clock Source are:

e Output Ports

e All Register Output Pins

e AllPins

e All Nets
Click OK to save the dialog box settings.
Modify the Clock Name if necessary.

Reference Pin
Specify a Clock Reference. To display the list of available clock reference pins, click the Browse button. The
Select Generated Clock Reference dialog box appears.
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:
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Figure 53 - Select Generated Clock Reference Dialog Box
The Pin Type options for Generated Clock Reference are:
e Input Ports
e All Pins
Click OK to save the dialog box settings.

Generated Clock Name

Specifies the name of the Generated clock constraint. This field is required for virtual clocks when no clock
source is provided.

Generated Frequency
Specify the values to calculate the generated frequency: a multiplication factor and/or division factor (must
be positive integers) is applied to the reference clock to compute the generated clock.

Generated Waveform
Specify whether the generated waveform is the same or inverted with respect to the reference waveform.
Click OK.

Phase
This field is primarily used to report the information captured from the CCC configuration process, and when
constraint is auto-generated. Meaningful phase values are: 0, 45, 90, 135, 180, 225, 270, and 315. This field

is used to report the information captured from the CCC configuration process, and when the constraint is
auto-generated.

PLL Output
This field refers to the CCC GL0/1/2/3 output that is fed back to the PLL (in the CCC). This field is primarily

used to report the information captured from the CCC configuration process, and when constraint is auto-
generated.

PLL Feedback
This field refers to the manner in which the GL/0/1/2/3 output signal of the CCC is connected to the PLL's

FBCLK input. This field is primarily used to report the information captured from the CCC configuration
process, and when constraint is auto-generated.

Comment
Enter a single line of text that describes the generated clock constraints purpose.
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Specifying Generated Clock Constraints
Select Generated Clock Source

Set an Input Delay Constraint
Use the input delay constraint to define the arrival time of an input relative to a clock.

To specify an input delay constraint, open the Add Input Delay Constraint dialog box in one of the following
four ways:

e From the Constraints Browser, choose Input Delay.

e Double-click the Add Input Delay Constraint icon
e Choose Input Delay from the Constraints drop-down menu (Constraints > Input Delay).
¢ Right-click any row in the Input Delay Constraints Table and choose Add Input Delay Constraint.

The Add Input Delay Constraint dialog box appears.

B Add Input Delay Constraint IM

FPGA

Clock Hame = T

Use same value for min and max
Madmum Delay: _— »
Minimum Delay: s | | :
- por 2ate(0) Datai1)
Comment :

nep | [_ox J[ concel |

Figure 54 - Add Input Delay Constraint Dialog Box

The Input Delay Dialog Box enables you to enter an input delay constraint by specifying the timing budget
outside the FPGA. You can enter the Maximum Delay, the Minimum Delay, or both.

Input Port

Specify the Input Port or click the browse button next to Input Port to display the Select Ports for Input Delay
dialog box. You can select multiple input ports on which to apply the input delay constraint.
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Figure 55 - Select Ports for Input Delay Dialog Box

There is only 1 Pin Type available for Input Delay: Input Ports.
Clock Name

Specifies the clock reference to which the specified input delay is based.

Clock edge
Select rising or falling as the launching edge of the clock.
Use same value for min and max

Specifies that the minimum input delay uses the same value as the maximum input delay.

Maximum Delay

Specifies that the delay refers to the longest path arriving at the specified input.

Minimum Delay

Specifies that the delay refers to the shortest path arriving at the specified input.

Comment
Enter a one-line comment for this constraint.

See Also
set_input_delay (SDC)

Set an Output Delay Constraint

Use the output delay constraints to define the output delay of an output relative to a clock.
To specify an output delay constraint, open the Add Output Delay Constraint Dialog box in one of the

following four ways:
e From the Constraints Browser, choose Output Delay.

e Double-click the Add Output Delay Constraint icon

e Choose Output Delay from the Constraints drop-down menu (Constraints > Output Delay).
e Right-click any row in the Output Delay Constraints Table and choose Add Output Delay Constraint.

The Add Output Delay Constraint dialog box appears.
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Figure 56 - Add Output Delay Constraint Dialog Box

The Output Delay dialog box enables you to enter an output delay constraint by specifying the timing budget
outside the FPGA. You can enter the Maximum Delay, the Minimum Delay, or both.

Enter the name of the Output Port or click the browse button to display the Select Ports for Output Delay
dialog box.
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Figure 57 - Output Delay Dialog Box
There is only 1 Pin Type available for Output Delay: Output Ports
Output Port

Specifies a list of output ports in the current design to which the constraint is assigned. You can select
multiple output ports to apply the output delay constraints.

Clock Name
Specifies the clock reference to which the specified output delay is related.
Clock edge Selector
Use the Up or Down arrow to select the rising or falling edge as the launching edge of the clock.
Use Same Value for Min and Max
Check this checkbox to use the same delay value for Min and Max delay.
Maximum Delay

Specifies the delay in nanoseconds for the longest path from the specified output to the captured edge. This
represents a combinational path delay to a register outside the current design plus the library setup time.

Minimum Delay

Specifies the delay in nanoseconds for the shortest path from the specified output to the captured edge. This
represents a combinational path delay to a register outside the current design plus the library hold time.

Comment
Enter a one-line comment for the constraint.
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See Also
set _output delay (SDC)

Set an External Check Constraint
Use the Add External Check Constraint to specify the timing budget inside the FPGA.

To specify an External Check constraint, open the Add External Check Constraint dialog box in one of the
following three ways:

e From the Constraints Browser, choose External Check.
e Choose External Check from the Constraints drop-down menu (Constraints > External Check).

¢ Right-click any row in the External Check Constraints Table and choose Add External Check
Constraint.

The Add External Check Constraint dialog box appears.

i) Add Extemnal Chack Constraint L

FPGA

ClockName: | 05C_of1_Reosc, » |

e /

Dt
Pmﬂ#ﬂl} (1)

L e | Lo [ concel

Figure 58 - Add External Check Constraint Dialog Box

Input Port

Specify the Input Port or click the browse button next to Input Port to display the Select Ports for External
Check dialog box. You can select multiple input ports on which to apply the External Check constraint.
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Figure 59 - Select Ports for External Check Dialog Box

Clock Name

Specifies the clock reference to which the specified External Check is related.
Hold

Specifies the external hold time requirement in nanoseconds for the specified input ports.
Setup

Specifies the external setup time requirement in nanoseconds for the specified input ports.
Comment

Enter a one-line comment for this constraint.

See Also
set_external check

Set Clock To Out Constraint
Enter a clock to output constraint by specifying the timing budget inside the FPGA.

To specify a Clock to Out constraint, open the Add Clock to Out Constraint Dialog box in one of the following
three ways:

e From the Constraints Browser, choose Clock to Out.
e Choose Clock to Out from the Constraints drop-down menu (Constraints > Clock to Out).
¢ Right-click any row of the Clock To Out Constraints Table and choose Add Clock to Out Constraint.

The Add Clock To Out Constraint dialog appears.
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Figure 60 - Add Clock to Out Constraint Dialog Box

Specify the Output Port or click the browse button to display the Select Ports for Clock to Output dialog box.
You can select multiple output ports on which to apply the Clock to Out constraint.

Click the browse button next to Output Port to open the Select Ports for Clock To Output dialog box.
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Figure 61 - Select Ports for Clock To Output Dialog Box
Clock Name
Specifies the clock reference to which the specified Clock to Out delay is related.
Maximum Delay

Specifies the delay in nanoseconds for the longest path from the specified output to the captured edge. This
represents a combinational path delay to a register outside the current design plus the library setup time.

Minimum Delay

Specifies the delay in nanoseconds for the shortest path from the specified output to the captured edge. This
represents a combinational path delay to a register outside the current design plus the library hold time.

Comment
Enter a one-line comment for this constraint.

See Also
set clock to ouput

Set a Maximum Delay Constraint

Set the options in the Maximum Delay Constraint dialog box to relax or to tighten the original clock constraint
requirement on specific paths.

SmartTime automatically derives the individual maximum delay targets from clock waveforms and port input
or output delays. So the maximum delay constraint is a timing exception. This constraint overrides the
default single cycle timing relationship for one or more timing paths. This constraint also overrides a multiple
cycle path constraint.

Note: When the same timing path has more than one timing exception constraint, SmartTime honors the
timing constraint with the highest precedence and ignores the other timing exceptions according to the order
of precedence shown.

Timing Exception Constraints Order of Precedence
set_disable_timing 1
set_false_path 2
set_maximum_delay/set_minimum_delay 3
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Timing Exception Constraints Order of Precedence

set_multicycle_path 4

Note: The set_maximum_delay_constraint has a higher precedence over set_multicycle_path constraint and
therefore the former overrides the latter when both constraints are set on the same timing path.

To set a Maximum Delay constraint, open the Set Maximum Delay Constraint Dialog box in one of the
following four ways:

e From the Constraints Browser, choose Max Delay.

e Double-click the Add Max Delay Constraint icon
e Choose Max Delay from the Constraints drop-down menu (Constraints > Max Delay).

e From the Max Delay Constraints Table, right-click any row and choose Add Maximum Delay
Constraint.

The Set Maximum Delay Constraint dialog box appears.

s (5™ M
1] Set Maximum Delay Constraint (e &..ﬂ

Maximum delay @ 0,000 ns

From :

Through =

To:

Comment :

Figure 62 - Set Maximum Delay Constraint Dialog Box
Maximum Delay

Specifies a floating point number in nanoseconds that represents the required maximum delay value for
specified paths.

If the path starting point is on a sequential device, SmartTime includes clock skew in the computed delay.
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If the path starting point has an input delay specified, SmartTime adds that delay value to the path delay.

If the path ending point is on a sequential device, SmartTime includes clock skew and library setup time in
the computed delay.

If the ending point has an output delay specified, SmartTime adds that delay to the path delay.
Source/From Pins

Specifies the starting points for max delay constraint path. A valid timing starting point is a clock, a primary
input, an inout port, or a clock pin of a sequential cell.

To specify the Source pins(s), click on the Browse button to open the Select Source Pins for Max Delay
Constraint dialog box.

E
| Select Source Pins for Max Delay Constraint m

Spedify pins :- @ by explictlist ) by keyword and wildcard

Available Pins: Assigned Pins:

CLKD_PAD
FCCC_0/GLO
05C_0/1 RCOSC_25_50MHZ/CLKOUT

Add Al

Remave

Remove All

Filter available pins : Help

Pin Ty -
in Type oK

Input Ports
All Register Clock Pins Cancel

Figure 63 - Select Source Pins for Max Delay Constraint Dialog Box
The Pin Type options for Source Pins are:
e Clock Pins
e Input Ports
e All Register Clock Pins
Through Pins
Specifies the through pins in the specified path for the Maximum Delay constraint.

To specify the Through pin(s), click on the browse button next to the “Through” field to open the Select
Through Pins for Max Delay Constraint dialog box.
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Figure 64 - Select Through Pins for Max Delay Constraint Dialog Box
The available Pin Type options are:

e All Ports

e All Pins

e All Nets

e All Instances
Destination/To Pins

Specifies the ending points for maximum delay constraint. A valid timing ending point is a clock, a primary
output, an inout port, or a data pin of a sequential cell.

To specify the Destination pin(s), click on the browse button next to the “To” field to open the Select
Destination Pins for Max Delay Constraint dialog box.
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Figure 65 - Select Destination Pins for Max Delay Constraint Dialog Box
The available Pin Type options are:
e Clock Pins
e Output Ports
e All Register Data Pins

Comment

Enter a one-line comment for the constraint.

See Also
Timing Exceptions Overview

Set a Minimum Delay Constraint

Set the options in the Mimimum Delay Constraint dialog box to relax or to tighten the original clock constraint
requirement on specific paths.

SmartTime automatically derives the individual minimum delay targets from clock waveforms and port input
or output delays. So the minimum delay constraint is a timing exception. This constraint overrides the default
single cycle timing relationship for one or more timing paths. This constraint also overrides a multiple cycle
path constraint.

Note: When the same timing path has more than one timing exception constraint, SmartTime honors the
timing constraint with the highest precedence and ignores the other timing exceptions according to the order
of precedence shown.

Timing Exception Constraints Order of Precedence

set_disable_timing 1
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Timing Exception Constraints Order of Precedence
set_false_path 2
set_maximum_delay/set_minimum_delay 3
set_multicycle_path 4

Note: The set_maximum_delay_constraint has a higher precedence over set_multicycle_path constraint and
therefore the former overrides the latter when both constraints are set on the same timing path.

To set a Minimum Delay constraint, open the Set Minimum Delay Constraint dialog box in one of the
following four ways:

e From the Constraints Browser, choose Min Delay.
%
e Double-click the Add Min Delay Constraint icon =
e Choose Min Delay from the Constraints drop-down menu (Constraints > Min Delay).

¢ Right click on any row in the Min Delay Constraints Table and select Add Minimum Delay Constraint.

The Set Minimum Delay Constraint dialog box appears.

] Set Minimum Delay Constraint =
Minimum delay : IG.IJEHZII ns
From :

To:

Figure 66 - Set Minimum Delay Constraint Dialog Box

Minimum Delay

Specifies a floating point number in nanoseconds that represents the required minimum delay value for
specified paths.

If the path starting point is on a sequential device, SmartTime includes clock skew in the computed delay.
If the path starting point has an input delay specified, SmartTime adds that delay value to the path delay.
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If the path ending point is on a sequential device, SmartTime includes clock skew and library setup time in
the computed delay.

If the ending point has an output delay specified, SmartTime adds that delay to the path delay.
Source Pins/From

Specifies the starting point for minimum delay constraint. A valid timing starting point is a clock, a primary
input, an input port, or a clock pin of a sequential cell.

Click the browse button next to the “From” field to open the Select Source Pins for Min Delay Constraint
dialog box.

2] Select Source Pins for Min Delay Constraint =

Specify pins :- @ by explicitlist ) by keyword and wildcard

Avalable Pins: Assigned Pins:
CLKO_PAD ' '

FCCC_0/GLD
0SC_0/1 RCOSC_25_SOMHZ/CLKOUT

Figure 67 - Select Source Pins for Min Delay Constraint Dialog Box
The available Pin Type options are:
e Clock Pins
e Input Ports
e All Register Clock Pins
Through Pins
Specifies the through points for the Minimum Delay constraint.

Click the browse button next to the “Through” field to open the Select the Through Pins for Min Delay dialog
box.
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Figure 68 - Select the Through Pins for Min Delay Dialog Box
The available Pin Type options are:
e All Ports
e All Pins
e All Nets
e All Instances
Destination Pins

Specifies the ending points for minimum delay constraint. A valid timing ending point is a clock, a primary
output, or a data pin of a sequential cell.

Click the browse button next to the “To” field to open the Select the Destination Pins for Min Delay
Constraint dialog box.
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Figure 69 - Select the Destination Pins for Min Delay Constraint Dialog Box
The available Pin Type options are:
e Clock Pins
e Output Ports
e All Register Data Pins
Comment
Enter a one-line comment for the Constraint.

See Also

Timing Exceptions Overview
Specifying Minimum Delay Constraints
set_min_delay (SDC)

Set a Multicycle Constraint
Set the options in the Set Multicycle Constraint dialog box to specify paths that take multiple clock cycles in
the current design.

Setting the multiple-cycle path constraint overrides the single-cycle timing relationships (the default)
between sequential elements by specifying the number of cycles (two or more) that the data path must have
for setup or hold checks.

Note: The false path information always takes precedence over multiple cycle path information. A specific
maximum delay constraint overrides a general multiple cycle path constraint.

To set a multicycle constraint, open the Set Multicycle Constraint dialog box in one of the following four
ways:
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e From the Constraints Browser, choose Multicycle.
n
e Double-click the Add Multicycle Constraint icon
e Choose Multicycle from the Constraints drop-down menu (Constraints > Multicycle).

¢ Right-click any row in the Multicycle Constraints Table and choose Add Multicycle Path Constraint.

The Set Multicycle Constraint dialog box appears.

[ 57 Set Multicycle Constraint |9 it
Spedfy multipber(s) for : Setup Chedk only @ Setup and Hold Chedks
Setup Path Multipler : Hold Path Multipher: 0
S = — e iz
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Mew tHodo |
held edge

From :
Through =
To:
Comment :
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Figure 70 - Set Multicycle Constraint Dialog Box

Setup Check Only
Check this box to apply multiple clock cycle timing consideration for Setup Check only.

Setup and Hold Checks
Check this box to apply multiple clock cycle timing consideration for both Setup and Hold Checks.

Setup Path Multiplier
Specifies an integer value that represents the number of clock cycles (more than one) the data path must
have for a setup check.

Hold Path Multiplier
Specifies an integer value that represents the number of clock cycles (more than one) the data path must
have for a Hold check.
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Source Pins/From Pins

Specifies the starting points for the multiple cycle path. A valid starting point is a clock, a primary input, an
inout port, or the clock pin of a sequential cell.

Click the browse button next to the “From” field to open the Select Source Pins for Multicycle Constraint
dialog box.

T Select Source Pins for Multicycle Constraint | % ]

Spedfy pins :- @ by explidtlist () by keyword and wildcard

Available Pins: Assigned Pins:

CLKD_PAD
FCCC_0/GLO
0SC_0/1_RCOSC_25_SOMHZ/CLKOUT

Figure 71 - Select Source Pins for Multicycle Constraint Dialog Box

The available Pin Type options are:
e Clock Pins
e Input Ports
e All Register Clock Pins
Through Pins

Click the browse button next to the “Through” field to open the Select Through Pins for Multicycle Constraint
dialog box. The Select Through Pins for Multicycle Constraint dialog box appears.
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Figure 72 - Select Through Pins for Multicycle Constraint Dialog Box
The available Pin Type options are:
e All Ports
e All Pins
e All Nets
e ¢ Alinstances
Destination/To Pins

Click the browse button next to the “To” field to open the Select Destination Pins for Multicycle Constraint
dialog box.
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Figure 73 - Select Destination Pins for Multicycle Constraint Dialog Box
The available Pin Type options are:
e Clock Pins
e Output Ports
e All Register Data Pins
Comment
Enter a one-line comment for the constraint.

See Also
Specifying a Multicycle Constraint

Set a False Path Constraint

Set options in the Set False Path Constraint dialog box to define specific timing paths as false path.

This constraint removes timing requirements on these false paths so that they are not considered during the
timing analysis. The path starting points are the input ports or register clock pins and path ending points are
the register data pins or output ports. This constraint disables setup and hold checking for the specified
paths.

Note: When the same timing path has more than one timing exception constraint, SmartTime honors the
timing constraint with the highest precedence and ignores the other timing exceptions according to the order
of precedence shown below.

Timing Exception Constraints Order of Precedence

set_disable_timing 1
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set_false_path 2
set_maximum_delay/set_minimum_delay 3
set_multicycle_path 4

Note: The set_false_path constraint has the second highest precedence and always overrides the
set_multicycle_path constraints and set_maximum/minimum_delay constraints.

To set a false path constraint, open the Set False Path Constraint dialog box in one of the following four
ways:
e From the Constraints Browser, choose False Path.
_ .
e Double-click the Add False Path Constraint icon
e Choose False Path from the Constraints drop-down menu (Constraints > False Path).
¢ Right-click any row in the False Path Constraints Table and choose Add False Path Constraint.

The Set False Path Constraint dialog box appears.

| Set False Path Constraint M
From :
Through =
To:
Comment :
[ Help Ok Cancel

Figure 74 - Set False Path Constraint Dialog Box
Source/From Pins

To select the Source Pin(s), click the browse button next to the “From” field and open the Select Source Pins
for False Path Constraint dialog box.
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Figure 75 - Select Source Pins for False Path Constraint Dialog Box
The available options for Pin Type are:
e Clock Pins
e Input Ports
e All Register Clock Pins
Through Pins
Specifies a list of pins, ports, cells, or nets through which the false paths must pass.

To select the Through pin(s), click the browse button next to the “Through” field to open the Select Through
Pins for False Path Constraint dialog box.

Libero SoC User's Guide 125



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
OM- = when clicked. View the online help included with software to enable all linked content.
ICrOSeIni.

e
.| Select Through Pins for False Path Constraint =8

Spedify pins :- @) by explidtlist () by keyword and wildcard

Available Pins: Assigned Pins:
A -
CLK

CLKO_PAD

Figure 76 - Select Through Pins for False Path Constraint Dialog Box
The available options for Pin Type are:
e All Ports
e AllPins
e All Nets
e All Instances
Destination/To Pins

To select the Destination Pin(s), click the browse button next to the “To” field to open the Select Destination
Pins for False Path Constraint dialog box.
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Figure 77 - Select Destination Pins for False Path Constraint Dialog Box
The available options for Pin Type are:
e Clock Pins
e Output Ports
e All Register Data Pins
Comment
Enter a one-line comment for the constraint.

See Also
Specifying False Path Constraints

Set a Disable Timing Constraint
Use disable timing constraint to specify the timing arcs to be disabled for timing consideration.

Note: This constraint is for the Place and Route tool and the Verify Timing tool. It is ignored by the Synthesis
tool.

To specify a Disable Timing constraint, open the Set Constraint to Disable Timing Arcs dialog box in one of
the following four ways:

e From the Constraints Browser, choose Advanced > Disable Timing.

=
=
e Double-click the Add Disable Timing Constraint icon
e Choose Disable Timing from the Constraints drop-down menu (Constraints > Disable Timing).

¢ Right-click any row in the Disable Timing Constraints Table and choose Add Constraint to Disable
Timing.
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The Set Constraint to Disable Timing Arcs dialog box appears.
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Figure 78 - Set Constraint to Disable Timing Arcs Dialog Box

Instance Name
Specifies the instance name for which the disable timing arc constraint will be created.
Click the browse button next to the Instance Name field to open the Select instance to constrain dialog box.
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Figure 79 - Set Instance to Constrain Dialog Box

The Pin Type selection is limited to All Instances only.
Exclude All Timing Arcs in the Instance

This option enables you to exclude all timing arcs in the specified instance.

Specify Timing Arc to Exclude

This option enables you to specify the timing arc to exclude. In this case, you need to specify the from and to

ports:
From Port

Specifies the starting point for the timing arc.
To Port

Specifies the ending point for the timing arc.
Comment

Enter a one-line comment for the constraint.

Libero SoC User's Guide

129



NOTE: Links and cross-references in this PDF file may point to external files and generate an error

OM- f when clicked. View the online help included with software to enable all linked content.

Set Clock Source Latency Constraint

Use clock source latency constraint to specify the delay from the clock generation point to the clock
definition point in the design.

Clock source latency defines the delay between an external clock source and the definition pin of a clock. It
behaves much like an input delay constraint.

You can specify both an "early" delay and a "late" delay for this latency, providing an uncertainty which the
timing analyzer can use for propagating through its calculations. Rising and falling edges of the same clock
can have different latencies. If only one value is provided for the clock source latency, it is taken as the exact
latency value, for both rising and falling edges.

To specify a Clock Source Latency constraint, open the Set Clock Source Latency Constraint dialog box in
one of the following four ways:

e From the Constraints Browser, choose Clock Source Latency.
 Double-click the Clock Source Latency Constraint icon -

e Choose Clock Source Latency from the Constraints drop-down menu (Constraints > Advanced >
Clock Source Latency).

¢ Right-click any row of the Clock Latency Constraints Table and choose Add Clock Source Latency.
The Set Clock Source Latency Constraint dialog box appears.

| Set Clock Source Latency Constraint M

Clock Namme or Source: [ 'j [I]

Clock Source
Late Rise ns 9 LateFal ns
Early Rise s—W 1 % EaFal ns
v [
7%
7%
Clock Hame or Source éé
Faling same as rising || Early same as Late

Comment :

| tep | Lok J[ concal

Figure 80 - Set Clock Source Latency Constraint Dialog Box

To select the Clock Source, click on the browser button to open the Choose the Clock Source Pin dialog
box:

130

Libero SoC User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error

when clicked. View the online help included with software to enable all linked content.

Late Rise

Early Rise

Late Fall

Early Fall

& Microsemi

Libero SoC Constraint Management (Enhanced Constraint Flow)

37 Choase the Clock Source Pin |9

| CLKD_PAD
FCCC_0/GLO
0SC_0/1 RCOSC_25_S0MHZ/CLKOUT

Figure 81 - Choose the Clock Source Pin Dialog Box
The only choice available for Pin Type is Clock Pins.

Specifies the largest possible latency, in nanoseconds, of the rising clock edge at the clock port or pin
selected, with respect to its source. Negative values are acceptable, but may lead to overly optimistic
analysis.

Specifies the smallest possible latency, in nanoseconds, of the rising clock edge at the clock port or pin
selected, with respect to its source. Negative values are acceptable, but may lead to overly optimistic
analysis.

Specifies the largest possible latency, in nanoseconds, of the falling clock edge at the clock port or pin
selected, with respect to its source. Negative values are acceptable, but may lead to overly optimistic
analysis.

Specifies the smallest possible latency, in nanoseconds, of the falling clock edge at the clock port or pin
selected, with respect to its source. Negative values are acceptable, but may lead to overly optimistic
analysis.
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Clock Edges

Comment

Select the latency for the rising and falling edges:
Falling same as rising: Specifies that Rising and Falling clock edges have the same latency.

Early same as late: Specifies that the clock source latency should be considered as a single value, not a
range from "early" to “'late".

Enter a one-line comment to describe the clock source latency.

See Also
Specifying Clock Constraints
Set Clock Latency Constraint

Set Clock-to-Clock Uncertainty Constraint
Use the clock-to-clock uncertainty constraint to model tracking jitter between two clocks in your design.

To specify a Clock-to-Clock Uncertainty constraint, open the Set Clock-to-Clock Uncertainty Constraint
dialog box in one of the following four ways:

e From the Constraints Browser, choose Clock Uncertainty.
£
e Double-click the Clock-to-Clock Uncertainty icon

e Choose Clock-to-Clock Uncertainty from the Constraints drop-down menu (Constraints >
Advanced > Clock-to-Clock Uncertainty).

¢ Right-click any row in the Clock Uncertainty Constraints Table and choose Add Clock-to-Clock
Uncertainty.

The Set Clock-to-Clock Uncertainty Constraint dialog box appears.
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Figure 82 - Set Clock-to-Clock Uncertainty Dialog Box

From Clock
Specifies clock name as the uncertainty source.

To set the From Clock, click the browser button to open the Select Source Clock List for Clock-to-clock
Uncertainty dialog box.
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Figure 83 - Select Source Clock List for Clock-to-Clock Uncertainty Dialog Box

The Pin Type selection is for Clock Pins only.
Edge
This option enables you to select if the clock-to-clock uncertainty applies to rising, falling, or both edges.
To Clock
Specifies clock name as the uncertainty destination.
To set the To Clock, click the browser button to open the Select Destination Clock List for Clock-to-clock
Uncertainty Constraint dialog box.
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Figure 84 - Select Destination Clock List for Clock-to-Clock Uncertainty Constraint Dialog Box
Edge
This option enables you to select if the clock-to-clock uncertainty applies to rising, falling, or both edges.
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Uncertainty

Enter the time in nanoseconds that represents the amount of variation between two clock edges.
Use Uncertainty For

This option enables you select whether the uncertainty constraint applies to setup, hold, or all checks.
Comment

Enter a single line of text that describes this constraint.

To set the Destination Clock, click the browser button to open the Select Destination Clock List for Clock-to-
clock Uncertainty Constraint dialog box.
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Figure 85 - Select Destination Clock List for Clock-to-Clock Uncertainty Dialog Box
The Pin Type selection is for Clock Pins only.

See Also
Specifying Disable Timing Constraints

set _clock uncertainty

Set Clock Groups

To add or delete a Clock Group constraint, open the Add Clock Groups Constraint dialog box in one of three
ways:

e Select Clock Groups from the Constraints drop-down menu (Constraints > Clock Groups).
e Double-click Clock Groups in the Constraints Browser.
¢ Right-click any row in the Clock Groups Constraints Table and choose Add Clock Groups.
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Figure 86 - Add Clock Group Constraints Dialog Box
ClockGroupsName — Enter a name for the Clock Groups to be added.
Exclusive Flag - Choose one of the three clock group attributes for the clock group:

e Logically Exclusive - Use this setting for clocks that can exist physically on the device at the same
time but are logically exclusive (e.g., multiplexed clocks).

e Physically Exclusive - Use this setting for clocks that cannot exist physically on the device at the
same time (e.g., multiple clocks defined on the same pin).

e Asynchronous — Use this setting when there are valid timing paths between the two clock groups but
the two clocks do not have any frequency or phase relationship and therefore these timing paths can
be excluded from timing analysis.

Add Group — Click Add to open a dialog to add clocks to a clock group. Select the clocks from the Available
Pins list and click Add to move them to Assigned Pins list. Click OK.
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Figure 87 - Add Clocks For Clock Group Dialog Box

Delete Group — Delete the clocks from the Clock Group. Select the group of clock to be deleted and click
Delete Group. This will delete the clock group.

»

11N

7 Add Clock Groups Constraint | -
DlockGroupsiams
Ewchme Flag
Logally Exclusive -
Phiyscally Exclusne
Agyrchionous
iee_istrﬁaz

[ get_clocks | Cx1 cxa })

Figure 88 - Delete Group

See Also

set_clock _groups
list_clock_groups
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remove_clock groups

Select Destination Clock for Clock-to-clock Uncertainty Constraint Dialog Box

This dialog box opens when you select the browse button for Destination/To Clock for Clock-to-clock
Uncertainty Constraints dialog box.

Use this dialog box to select Clock Pins:
e By explicit list
e By keyword and wildcard
To open the Select Destination Clock dialog box, double-click Constraint > Advanced > Clock

Uncertainty. Click the browse button next to the To Clock field to select the Destination Clock Pin.

By Explicit List

This is the default. This mode stores the actual Clock Pin names. The following figure shows an example
dialog box for Select Destination Clock.

r
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Figure 89 - Select Destination Clock Pins for Clock-to-Clock Uncertainty Dialog Box — by Explicit List
Available Pins

The list box displays the available Clock Pins. If you change the filter value, the list box shows the available
pins based on the filter.

Use Add, Add All, to add Clock Pins from the Available Pins List or Remove, Remove All to delete Clock
Pins from the Assigned Pins list.

Filter Available Pins
Pin type — Specifies the filter on the available Clock Pins.
Filter

Specifies the filter based on which the Available Pins list shows the Clock Pin names. The default is *, which
is a wild-card match for all. You can specify any string value.
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By Keyword and Wildcard

This mode stores the filter only. It does not store the actual pin names. The constraints created using this
mode get exported with the SDC accessors (get_pins) and the wildcard filter.The following figure shows an
example dialog box for Select Destination Clock Pins by keyword and the *CCC* filter.

Specify pins :- (C) by explidtlist @ by keyword and wildcard

Resulting Pins :
M3_MDDR_0/CCC_0/GLO

Figure 90 - Select Destination Clock Pins for Clock-to-Clock Uncertainty Dialog Box — By Keyword and Wildcard

Pin Type
Specifies the filter on the available pins. The only valid selection is Clock Pins.

Filter
Specifies the filter based on which the Available Pins list shows the pin names. The default is *, which is a
wild-card match for all. You can specify any string value.

Resulting Pins
Displays pins from the available pins based on the filter.

Select Instance to Constrain Dialog Box
This dialog box appears when you click the browse button next to the Instance Name field in the Set
Constraint to Disable Timing Arcs Dialog Box.
The list box displays the available Pins. If you change the filter value, the list box shows the available pins
based on the filter.

Filter Available Pins
Pin type — Specifies the filter on the available Pin Types: All Instances is the only valid type.

Filter

Specifies the filter based on which the Available Pins list shows the Pin names. The default is *, which is a
wild-card match for all. You can specify any string value.
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Figure 91 - Select Instance to Constrain Dialog Box

Select Generated Clock Reference Dialog Box
Use this dialog box to find and choose the generated clock reference pin from the list of available pins.

To open the Select Select Generated Clock Reference dialog box (shown below) from the Constraints
Editor, open the Create Generated Clock Constraint Dialog Box dialog box and click the browse button for
the Reference Pin.
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Figure 92 - Select Generated Clock Reference Dialog Box
Filter Available Pins

To identify any other pins in the design as the generated master pin, under Filter available pins, for Pin
Type, select Input Ports or All Pins. You can also click filter the generated reference clock pin name in the
displayed list. The default filter is *, which is a wild-card match for all.

See Also

Specifying Generated Clock Constraints

Select Generated Clock Source Dialog Box
Use this dialog box to find and choose the generated clock source from the list of available pins.

To open the Select Generated Clock Source dialog box (shown below) from the Constraints Editor, open the
Create Generated Clock Constraint dialog box and click the browse button for the Clock Pin. The Selected
Generated Clock Source dialog box appears.
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Figure 93 - Selected Generated Clock Source Dialog Box
Filter Available Pins

Explicit clock pins for the design is the default value. To identify any other pins in the design as the
generated clock source pins, from the Pin Type pull-down list, select All Ports, All Pins, All Nets, or All
Register Output Pins. You can also filter the generated clock source pin name in the displayed list. The
default filter is *, which is a wild-card match for all.

See Also
Specifying Generated Clock Constraint

Select Ports Dialog Box

This dialog box appears when you click the browse button next to the Input Port field in the Set Input Delay
Dialog Box or the Output Port field in the Set Output Delay Dialog Box. It also applies to the Set External
Check & Set Clock To Output constraints.

The list box displays the available Pins. If you change the filter value, the list box shows the available pins
based on the filter.

Use this dialog box to select the Input or Output Port:
e By explicit list
e By keyword and wildcard

By Explicit List

This is the default. This mode stores the actual Input/Out Port names. The following figure shows an
example dialog box for the Select Input Port for Input Delay.
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Figure 94 - Select Input Port for Input Delay Dialog Box
Available Pins

The list box displays the available Pins. If you change the filter value, the list box shows the available pins
based on the filter.

Use Add, Add All, to add Pins from the Available Pins List or Remove, Remove All to delete Pins from the
Assigned Pins list.

Filter Available Pins

Pin type — Specifies the filter on the available Pin Types: Input Port is the only valid type for Input Delay and
Output Port is the only valid type for Output Delay.
Filter

Specifies the filter based on which the Available Pins list shows the Pin names. The default is *, which is a
wild-card match for all. You can specify any string value.

By Keyword and Wildcard

This mode stores the filter only. It does not store the actual pin names. The constraints created using this
mode get exported with the SDC accessors (get_ports) and the wildcard filter. The following figure shows an
example dialog box for Select Output Ports by keyword and the *DM* filter.
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Figure 95 - Select Ports for Output Delay Dialog Box — By Keyword and Wildcard

Pin Type
Specifies the filter on the available pins. The valid values are Input Ports for Input Delay and Output Ports for
Output Delay.

Filter
Specifies the filter based on which the Available Pins list shows the pin names. The default is *, which is a
wild-card match for all. You can specify any string value.

Available Pins
Displays pins from the Pin Type based on the filter.

Select Source Clock for Clock-to-clock Uncertainty Constraint Dialog Box

This dialog box opens when you click the browse button for Source/From Clock for Clock-to-clock
Uncertainty Constraints dialog box.

Use this dialog box to select Clock Pins:
e By explicit list
e By keyword and wildcard

To open the Select Source Clock dialog box, double-click Constraint > Advanced > Clock Uncertainty.
Click the browse button to select the source.

By Explicit List

This is the default. This mode stores the actual Clock Pin names. The following figure shows an example
dialog box for Select Source Clock List for Clock-to-Clock Uncertainty Constraint Dialog Box .
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Figure 96 - Select Source Clock List for Clock-to-Clock Uncertainty Constraint Dialog Box — By Explicit List

Available Pins

The list box displays the available Clock Pins. If you change the filter value, the list box shows the available

pins based on the filter.

Use Add, Add All, to add Clock Pins from the Available Pins List or Remove, Remove All to delete Clock

Pins from the Assigned Pins list.
Filter Available Pins

Pin type — Specifies the filter on the available Clock Pins.
Filter

Specifies the filter based on which the Available Pins list shows the Clock Pin names. The default is *, which

is a wild-card match for all. You can specify any string value.

By Keyword and Wildcard

This mode stores the filter only. It does not store the actual pin names. The constraints created using this
mode get exported with the SDC accessors (get_pins) and the wildcard filter.The following figure shows an
example dialog box for Select Source Clock Pins by keyword and the *CCC* filter.
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Figure 97 - Select Source Clock List for Clock-to-Clock Uncertainty Constraint Dialog Box — By Keyword and Wildcard
Pin Type
Specifies the filter on the available pins. The only valid selection is Clock Pins.
Filter

Specifies the filter based on which the Available Pins list shows the pin names. The default is *, which is a
wild-card match for all. You can specify any string value.

Resulting Pins
Displays pins from the available pins based on the filter.

Select Source or Destination Pins for Constraint Dialog Box

This dialog box opens when you select the browse button for Source/From, Intermediate/Through and
Destination/To pins for Timing Exception Constraints: False Path Constraints, Multicycle Path Constraints,
and Maximum/Minimum Delay Constraints.

Use this dialog box to select pins or ports:
e By explicit list
e By keyword and wildcard

To open the Select Source or Destination Pins for Constraint dialog box from the Constraints Editor, choose
Constraint > Timing Exception Constraint Name. Click the browse button to select the source.

By Explicit List
This is the default. This mode stores the actual pin names. The following figure shows an example dialog
box for Select Source Pins for Multicycle Constraint (specify by explicit list).

146 Libero SoC User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error

when clicked. View the online help included with software to enable all linked content.

& Microsemi

Libero SoC Constraint Management (Enhanced Constraint Flow)

Spedify pins :- @ by explidt list

i Select Source Pins for Multicycle Constraint ? P

by keyword and wildcard

Available Pins:

FCCC_0/GLO
05C_0/1_.RCOSC_25_50MHZ/CLKOUT

Filter available pins :

Assigned Pins:

Add All

:
1]
= E

[ heo ]

Pin Type : Clock Pins

- |

o« |

] |

~ J

Figure 98 - Select Source Pins for Multicycle Constraint Dialog Box (specify by explicit list)

Available Pins

The list box displays the available pins. If you change the filter value, the list box shows the available pins

based on the filter.

Click Add, Add All, Remove, and Remove All to add or delete pins from the Assigned Pins list.

Filter Available Pins

Pin Type — Specifies the filter on the available pins. You can specify Input Ports, Clock Pins, All Register

Clock Pins.
Filter

Specifies the filter based on which the Available Pins list shows the pin names. The default is *, which is a
wild-card match for all. You can specify any string value.

By Keyword and Wildcard

This mode stores the filter only. It does not store the actual pin names. The constraints created using this
mode get exported with the SDC accessors (get_ports, get_pins, etc.) and the wildcard filter.The following
figure shows an example dialog box for Select Source Pins for Multicycle Constraint (specified by keyword

and wildcard).
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Figure 99 - Select Source Pins for Multicycle Constraint Dialog Box (specified by keyword and wildcard)
Pin Type
Specifies the filter on the available pins. The source pins can be Clock Pins, Input Ports, All Register Clock

Pins. The default pin type is Clock Pins. The available Pin Type varies with Source Pins, Through Pins, and
Destination Pins.

Filter

Specifies the filter based on which the Available Pins list shows the pin names. The default is *, which is a
wild-card match for all. You can specify any string value.

Resulting Pins
Displays pins from the available pins based on the filter.

Select Source Pins for Clock Constraint Dialog Box
Use this dialog box to find and choose the clock source from the list of available pins.

To open the Select Source Pins for the Clock Constraint dialog box (shown below) from the Constraints
Editor, click the browse button to the right of the Clock source field in the Create Clock Constraint dialog
box.
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Figure 100 - Select Source Pins for Clock Constraint Dialog Box

Select a Pin

Displays all available pins.

Filter Available Objects

Explicit clock pins for the design is the default value. To identify any other pins in the design as clock pins,
under Filter available pins, for Pin Type, select Input Ports, All Pins, or All Nets. You can also filter the
clock source pin name in the displayed list. The default filter is *, which is a wild-card match for all.

See Also
Specifying Clock Constraints

Select Through Pins for Timing Exception Constraint Dialog Box

This dialog box opens when you select the Browse button for Intermediate/Through Pins for False Path,
Multicycle Path, Min/Max Delay Constraints dialog box.

Use this dialog box to select the Intermediate Pin:
e By explicit list
e By keyword and wildcard

To open the Select Through Pins dialog box, double-click Constraint > Exceptions > Max/Min Delay/False
Path/Multicycle Path. Click the browse button next to the To the Through field to select the
Intermediate/Through Pin.

By Explicit List

This is the default. This mode stores the actual Intermediate/Through Pin names. The following figure shows
an example dialog box for Select Through Pins for Multicycle Path Constraint.
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MDDR_ADDR A
MDDR_ADDR[0] e
MDDR_ADDR[10]
MDDR_ADDRI[11]
MDDR_ADDR[12]
MDDR_ADDRI[13]
MDDR_ADDR[14] Remave Al

RAMND AMNODME1

Filter available pins :
Pin Ty - All Ports
in Type or "’] [ ok
* Filter
o=

Figure 101 - Select Through Pins for Multicycle Path Constraint Dialog Box — By Explicit List
Available Pins

Remove

The list box displays the available Pins. If you change the filter value, the list box shows the available pins
based on the filter.

Use Add, Add All, to add Pins from the Available Pins List or Remove, Remove All to delete Pins from the
Assigned Pins list.

Filter Available Pins
Pin type — Specifies the filter on the available Pin Types: All Ports, All Nets, All Pins and All Instances.
Filter

Specifies the filter based on which the Available Pins list shows the Pin names. The default is *, which is a
wild-card match for all. You can specify any string value.

By Keyword and Wildcard

This mode stores the filter only. It does not store the actual pin names. The constraints created using this
mode get exported with the SDC accessors (get_pins) and the wildcard filter. The following figure shows an
example dialog box for Select Through Pins by keyword and the *DM* filter.
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- Multicycle Constraint

Spedfy pins :- () by explicitlist @ by keyword and wildcard

Resulting Pins :

| MDDR_DM_RDQS

| MDDR_DM_RDQS[0]
| MDDR_DM_RDQS[1]

Filter available pins :

Pin Type : All Ports

M=

Figure 102 - Select Through Pins for Multicycle Path Constraint Dialog Box — By Keyword and Wilcard

Pin Type
Specifies the filter on the available pins. The valid values are All Ports, All Nets, All Pins and All Instances.
Filter

Specifies the filter based on which the Available Pins list shows the pin names. The default is *, which is a
wild-card match for all. You can specify any string value.

Resulting Pins
Displays pins from the available pins based on the filter.

Implement Design in Enhanced Constraint Flow for SmartFusion2,
IGLOO2, and RTG4

Synthesize (Enhanced Constraint Flow)
Double-click Synthesize to run synthesis on your design with the default settings specified in the synthesis
tool.
If you want to run the synthesis tool interactively, right-click Synthesize and choose Open Interactively. If
you open your tool interactively, you must complete synthesis from within the synthesis tool.
The default synthesis tool included with Libero SoC is Synplify Pro ME. If you want to use a different
synthesis tool, you can change the settings in your Tool Profiles.

You can organize input synthesis source files via the Organize Source Files dialog box.
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Synthesize Options

Some families enable you to set or change synthesis configuration options for your synthesis tool. To do so,
in the Design Flow window, expand Implement Design, right-click Synthesize and choose Configure
Options. This opens the Synthesize Options dialog box.

Minimum number of asyndronous pins:

Minimum fanout of non-dodk nets to be kept on globals:
Mumber of global resources:

Maximum number of global nets that could be demoted to row-globals:

Minimum fanout of global nets that could be demoted to row-globals:

Optimizations

[7] Enable retiming
RAM optimized for: @ High speed

Additional options for SynplifyPro synthesis

Saript file: D:fsynthesize. td

set_option -run_prop_extract 1:
lset_upﬁnn -maxfan 10000;

Figure 103 - Synthesize Options Dialog Box

HDL Synthesis Language Settings

HDL Synthesis language options are no longer specified in this dialog box. Please refer to Project Settings:
Design Flow Options.
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Global Nets (Promotions and Demotion)

Use the following options to specify to the Synthesis tool the threshold value beyond which the Synthesis
tool promotes the pins to globals:

e Minimum number of clock pins — Specifies the threshold value for Clock pin promotion. The default
value is 2.

e Minimum number of asynchronous pins — Specifies the threshold value for Asynchronous pin
promotion. The default is 12 for all dies of SmartFusion2 and IGLOO2 families and RT4G150 die of the
RTG4 family. This option is not available for RT4G150_ES die.

e Minimum fanout of non-clock nets to be kept on globals — Specifies the threshold value for data
pin promotion to global resources. It is the minimum fanout of non-clock (data) nets to be kept on
globals (no demotion). The default is 5000 (must be between1000 and 200000 ).

e Number of global resources — This can be used to control number of Global resources you want to
use in your design. By default this displays the number of available global resources for the die you
have selected for the project and varies with different die sizes.

e Maximum number of global nets that could be demoted to row-globals — Specifies the maximum
number of global nets that could be demoted to row-globals. The default is 16 (must be between 0 to
50).

e Minimum fanout of global nets that could be demoted to row-globals — Specifies the minimum
fanout of global nets that could be demoted to row-global. It is undesirable to have high fanout nets
demoted using row globals because it may result in high skew. The default is 300. (Must be between
25 to 5000).1f you run out of global routing resources for your design, reduce this number (to allow
more globals to be demoted to Row Globals) or select a bigger die for your design.

Note: Hardwired connections to global resources, such as CCC hardwired connections to GB , 10 Hardwired
connections to GB, and so on, cannot be controlled by these options.

Optimizations

Enable retiming — Check this box to enable Retiming during synthesis. Retiming is the process of
automatically moving registers (register balancing) across combinational gates to improve timing, while
ensuring identical logic behavior. The default is no retiming during synthesis.

Use this option to guide the Synthesis tool to optimize RAMs to achieve your design goal.

e High speed — RAM Optimization is geared towards Speed. The resulting synthesized design achieves
better performance (higher speed) at the expense of more FPGA resources.

e Low power — RAM Optimization is geared towards Low Power. RAMS are inferred and configured to
ensure the lowest power consumption.

Additional options for Synplify Pro synthesis

Script File

Click the Browse .*** | button to navigate to a Synplify Tcl file that contains the Synplify Pro-specific options.
Libero passes the options in the Tcl file to Synplify Pro for processing.

Additional Options

Use this field to enter additional Synplify options. Put each additonal option on a separate line.

Note: Libero passes these additional options “as-is” to Synplify Pro for processing; no syntax checks are
performed. All of these options are set on the Active Implementation only.

The list of recommended Synthesis Tcl options below can be added or modified in the Tcl Script File or
Additional Options Editor.

Note: The options from the Additional Options Editor will always have priority over the Tcl Script file options
if they are same.

set_option -use_fsm_explorer 0/1

set_option -frequency 200.000000
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set_option -write_verilog 0/1
set_option -write_vhdl 0/1

set_option -resolve_multiple_driver 1/0
set_option -rw_check_on_ram 0/1
set_option -auto_constrain_io 0/1
set_option -run_prop_extract 1/0
set_option -default_enum_encoding default/onehot/sequential/gray
set_option -maxfan 30000

set_option -report_path 5000

set_option -update _models_cp 0/1
set_option -preserve_registers 1/0
set_option -continue_on_error 1/0
set_option -symbolic_fsm_compiler 1/0
set_option -compiler_compatible 0/1
set_option -resource_sharing 170
set_option -write_apr_constraint 1/0
set_option -dup 1/0

set_option -enable64bit 1/0

set_option -fanout_limit 50

set_option -frequency auto

set_option -hdl_define SLE_INIT=2
set_option -hdl_param -set "width=8"
set_option -looplimit 3000

set_option -fanout_guide 50

set_option -maxfan_hard 1/0

set_option -num_critical_paths 10
set_option -safe_case 0/1

Any additional options can be entered through the Script File or Additional Options Editor. All of these
options can be added and modified outside of Libero through interactive SynplifyPro.
Refer to the Synplify Pro Reference Manual for detailed information about the options and supported
families.

The following options are already set by Libero. Do not include them in the additional options field or Script
File:

add_file <*>

impl <*>

project_folder <*>

add_folder <*>

constraint_file <*>

project <*>

project_file <*>

open_file <*>

set_option —part

set_option -package

set_option -speed_grade

set_option -top_module

set_option -technology

set_option -opcond

set_option -vlog_std

set_option -vhdl12008

set_option -disable_io_insertion
set_option -async_globalthreshold
set_option -clock _globalthreshold
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set_option -globalthreshold
set_option -low_power_ram_decomp
set_option -retiming

Synplify Pro ME

Synplify Pro ME is the default synthesis tool for Libero SoC.

To run synthesis using Synplify Pro ME and default settings, right-click Synthesize and choose Run.
If you wish to use custom settings you must run synthesis interactively.

To run synthesis using Synplify Pro ME with custom settings:

1. If you have set Synplify as your default synthesis tool, right-click Synthesize in the Libero SoC Design
Flow and choose Open Interactively. Synplify starts and loads the appropriate design files, with a few
pre-set default values.

2. From Synplify’s Project menu, choose Implementation Options.
Set your specifications and click OK.

4. Deactivate synthesis of the defparam statement. The defparam statement is only for simulation tools
and is not intended for synthesis. Embed the defparam statement in between translate_on and

translate_off synthesis directives as follows :
/* synthesis translate off */
defparam MO_MEMORYFILE = "meminit.dat"

w

/*synthesis translate_on */
// rest of the code for synthesis

5. Click the RUN button. Synplify compiles and synthesizes the design into an EDIF, *.edn, file. Your
EDIF netlist is then automatically translated by the software into an HDL netlist. The resulting *edn and
*.vhd files are visible in the Files list, under Synthesis Files.

Should any errors appear after you click the Run button, you can edit the file using the Synplify editor.
Double-click the file name in the Synplify window showing the loaded design files. Any changes you
make are saved to your original design file in your project.

6. From the File menu, choose Exit to close Synplify. A dialog box asks you if you would like to save any
settings that you have made while in Synplify. Click Yes.

Note: See the Microsemi Attribute and Directive Summary in the Synplify online help for a list of
attributes related to Microsemi devices.

Note: To add a clock constraint in Synplify you must add "n:<net_name>" in your SDC file. If you
put the net_name only, it does not work.

Precision RTL

Libero SoC Classic Constraint Flow supports Precision RTL from Mentor Graphics. Libero SoC Enhanced
Constraint Flow does not support Precision RTL.

To run synthesis with Precision RTL default settings, set Precision RTL as the synthesis tool for your project
(as outlined below), right-click Synthesize and choose Run.

To run synthesis with custom settings, right-click Synthesize and choose Open Interactively. Precision
RTL opens and enables you to change settings before you run synthesis.

If your design is not ready for synthesis then Open does not appear in your right-click menu.

To set Precision RTL as the synthesis tool for your project:
1. From the Project menu, choose Tool Profiles. The Tool Profiles dialog box appears.
Click Synthesis to choose the synthesis tool profile.
Click the Add button. The Add Profile dialog box appears.
Enter a name. This is the name that appears in the Tool Profile dialog box.
In the Tool integration dropdown menu choose Precision RTL.
Enter the location of Precision RTL and any additional parameters.
Click OK.

No oM~

Libero SoC User's Guide 155



& Microsemi

NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

8. Select Precision RTL in the Tool Profile dialog box and click OK.
9. Double-click Synthesize in the Design Flow window to start Precision RTL and run synthesis.

Identify Debug Design

Libero SoC integrates the Identify RTL debugger tool. It enables you to probe and debug your FPGA design
directly in the source RTL. Use Identify software when the design behavior after programming is not in
accordance with the simulation results.

To open the Identify RTL debugger, in the Design Flow window under Debug Design double-click
Instrument Design.

Identify features:
e Instrument and debug your FPGA directly from RTL source code .
¢ Internal design visibility at full speed.

e Incremental iteration - Design changes are made to the device from the Identify environment using
incremental compile. You iterate in a fraction of the time it takes route the entire device.

e Debug and display results - You gather only the data you need using unique and complex triggering
mechanisms.

You must have both the Identify RTL Debugger and the Identify Instrumentor to run the debugging flow
outlined below.

To use the Identify Instrumentor and Debugger:

1. Create your source file (as usual) and run pre-synthesis simulation.

2. (Optional) Run through an entire flow (Synthesis - Compile - Place and Route - Generate a
Programming File) without starting Identify.

Right-click Synthesize and choose Open Interactively in Libero SoC to launch Synplify.
In Synplify, click Options > Configure Identify Launch to setup Identify.
In Synplify, create an Identify implementation; to do so, click Project > New Identify Implementation.

In the Implementations Options dialog, make sure the Implementation Results > Results Directory
points to a location under <libero project>\synthesis\, otherwise Libero SoC is unable to detect your
resulting EDN file

7. From the Instumentor Ul specify the sample clock, the breakpoints, and other signals to probe.
Synplify creates a new synthesis implementation. Synthesize the design.

8. In Libero SoC, select the edif netlist of the Identify implementation you want to use in the flow. Right-
click Compile and choose Organize Input Files > Organize Source Files and select the edif netlist
of your Identify implementation.

9. Run Compile, Place and Route and Generate a Programming File with the edif netlist you created with
the Identify implementation.

10. Double-click Identify Debug Design in the Design Flow window to launch the Identify Debugger.

o0k w

The Identify RTL Debugger, Synplify, and FlashPro must be synchronized in order to work properly. See the
Release Notes for more information on which versions of the tools work together.

Verify Post-Synthesis Implementation - Simulate

The steps for performing functional (post-synthesis) and timing (post-layout) simulation are nearly identical.
Functional simulation is performed before place-and-route and simulates only the functionality of the logic in
the design. Timing simulation is performed after the design has gone through place-and-route and uses
timing information based on the delays in the placed and routed designs.

To perform functional simulation:

1. If you have not done so, back-annotate your design and create your testbench.

2. Right-click Simulate (in Design Flow window, Implement Design > Verify Post-Synthesis
Implementation > Simulate) and choose Organize Input Files > Organize Source Files from the
right-click menu.
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In the Organize Files for Source dialog box, all the stimulus files in the current project appear in the
Source Files in the Project list box. Files already associated with the block appear in the Associated
Source Files list box.

In most cases you will only have one testbench associated with your block. However, if you want
simultaneous association of multiple testbench files for one simulation session, as in the case of PCI
cores, add multiple files to the Associated Source Files list.

To add a testbench: Select the testbench you want to associate with the block in the Source Files in
the Project list box and click Add to add it to the Associated Source Files list.

To remove a testbench: To remove or change the file(s) in the Associated Source Files list box,
select the file(s) and click Remove.

To order testbenches: Use the up and down arrows to define the order you want the testbenches
compiled. The top level-entity should be at the bottom of the list.

3. When you are satisfied with the Associated Simulation Files list, click OK.

4. To start ModelSim AE, right-click Simulate in the Design Hierarchy window and choose Open
Interactively. ModelSim starts and compiles the appropriate source files. When the compilation
completes, the simulator runs for 1 pus and the Wave window opens to display the simulation results.

5. Scroll in the Wave window to verify the logic works as intended. Use the cursor and zoom buttons to
zoom in and out and measure timing delays.

6. When you are done, from the File menu, choose Quit.

Compile Netlist (Enhanced Constraint Flow)

The Compile Netlist step appears in the Design Flow window for Enhanced Constraint Flow only when the
design source is EDIF (EDIF design flow). To enable the EDIF design flow, turn off the Enable Synthesis
option in the Project Settings > Design Flow page.

When the design source is HDL/SmartDesign, this Compile Netlist step is not available in the Design Flow
window.

Options

The Compile Netlist Options sets the threshold value for global resource promotion and demotion when
Place and Route is executed.

W] Complle N-eﬂist ...‘.I. s _'L‘_L x :

Global Promotion

Number of global resources: 8

Maximum number of global nets that could be demoted to row-globals: 16|

Minimum fanout of global nets that could be demoted to row-globals: 300

Minimum fanout of non-dock nets to be kept on globals: 5000

o] [ conee

Figure 104 - Compile Netlist Options Dialog Box

Number of global resources - The number of available global resources for the die is reported in this field.
The number varies with the die size you select for the Libero SoC project.
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The following options allow you to set the maximum/minimum values for promotion and demotion of global
routing resources.

Maximum Number of global nets that could be demoted to row-globals — Specifies the maximum
number of global nets that can be demoted to row-globals. The default is 16.

Minimum fanout of global nets that could be demoted to row-globals — Specifies the minimum fanout of
global nets that can be demoted to row-global. The default is 300. If you run out of global routing resources
for your design, reduce this number (to allow more globals to be demoted) or select a larger die for your
design.

Minimum fanout of non-clock nets to be kept on globals — Specifies the minimum fanout of non-clock
(data) nets to be kept on globals (no demotion). The default is 5000 (valid range is 1000 to 200000). If you

run out of global routing resources for your design, increase this number or select a larger die for your
design.

Configure Flash*Freeze

Opens the Flash*Freeze Hardware Settings dialog box. For more information on the Flash*Freeze mode for
SmartFusion2 see the SmartFusion2 Low Power User's Guide.

The fabric SRAMs can be put into a Suspend Mode or a Sleep Mode. This applies to both the Large SRAM
(LSRAM) instances of RAM1xK18 and the Micro SRAM (USRAM) instances of RAM64x18. These SRAMs
are grouped in rows in Libero® System-on-Chip (SoC) devices

URAM/LSRAM State
Sleep - Sets to Sleep; LSRAM and uSRAM contents are not retained.
Suspend - Sets to Suspend; LSRAM and uSRAM contents are retained.

MSS Clock Source

The lower the frequency the lower the power will be. But for some peripherals that can remain active (such
as SPI or MMUART), you may need a higher MSS clock frequency (such as to meet the baud rate for
MMUART).

Options are:
e On-Chip 1 MHz RC Oscillator
e On-Chip 50 MHz RC Oscillator

Resource Usage (SmartFusion2, IGLOO2, RTG4)
After layout, you can check the resource usage of your design.

From the Design menu, choose Reports (Design > Reports). Click <design_name>_layout_log.log to open
the log file.

The log file contains a Resource Usage report, which lists the type and percentage of resource used for
each resource type relative to the total resources available for the chip.

Type Used Total Percentage
4LUT 400 86184 0.46
DFF 300 86184 0.34
I/O Register 0 795 0.00
Logic Element 473 86184 0.55

4LUTs are 4-input Look-up Tables that can implement any combinational logic functions with up to four
inputs.
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The Logic Element is a logic unit in the fabric. It may contain a 4LUT, a DFF, or both. The number of Logic
Elements in the report includes all Logic Elements, regardless of whether they contain 4LUT only, DFF only,

or both.

Overlapping of Resource Reporting

The number of 4LUTs in the report are the total number used for your design, regardless of whether or not
they are combined with the DFFs. Similarly, the number of DFFs in the report are the total number used for
your design, regardless of whether or not they are combined with 4LUT's.

In the report above, there is a total of 473 Logic Elements (LES) used for the design.

300 of the 473 LEs have DFFs inside, which means 173 (473-300) of them have no DFFs in them. These
173 LEs are using only the 4LUTs portion of the LE.

400 of the 473 LEs have 4LUTs inside, which means 73 (473-400) of them have no 4LUTS in them. These
73 LEs are using only the DFF portion of the LE.

LEs using DFF Only = 473-400 =

73

LEs using 4LUTS only = 473-300=

173

246 (Total of LEs using 4LUTS ONLY or DFF
ONLY)

Report’'s Overlapped resource =

227 (LEs using both 4LUTS and DFF)

Total number of LEs used =

473

LE Using
DFF
Only
(73)

LE Using
ALUTS Only
(173)

The area where the two circles overlap represents the overlapped resources in the Resource Usage report.

Enhanced Constraint Flow in Implementation

Design State Invalidation — Enhanced Constraint Flow

The Libero SoC Design Flow window displays status icons to indicate the status of the design state. For any
status other than a successful run, the status icon is identified with a tooltip to give you additional

information.
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Status Tooltip Description Possible Causes
Icon
N/A Tool has not run | NEW state Tool has not run or it has been cleaned.
yet
'vi Tool Tool runs with no errors. PASS N/A
! successfully state.
runs.
‘,g Varies with the | Tool runs but with Warnings Varies with the tool (e.g., for the Compile Netlist step, not all I/Os
' tool. e.g. Not all have been assigned and locked).

I/0s have been
Assigned and

Locked
9 Tool Fails. Tool runs with no errors. Invalid command options or switches, invalid design objects, invalid
i design constraints.
Design State is | Tool state changes from PASS to | Since the last successful run, design source design files, constraint
l Out of Date. OUT OF DATE files or constraint file/tool association, constraint files order, tool
options, and/or project settings have changed.
x Timing Timing Verification runs Design fails Timing Analysis. Design has either set-up or hold time
Constraints successfully but the design fails | violations or both.
have not been to meet timing requirements.
met.

Constraints and Design Invalidation

A tool in the Design Flow changes from a PASS state (green check mark) to an OUT OF DATE state when a
source file or setting affecting the outcome of that tool has changed.

The out-of-date design state is identified by the
Sources and/or settings are defined as:

icon in the Design Flow window.

e HDL sources (for Synthesis), gate level netlist (for Compile), and Smart Design and System Builder
components

e Design Blocks (*.cxz files) — low-level design units which may have completed Place and Route and
re-used as components in a higher-level design

e Constraint files associated with a tool
e Upstream tools in the Design Flow:

o If the tool state of a Design Flow tool changes from PASS to OUT OF DATE,
the tool states of all the tools below it in the Design Flow, if already run and are
in PASS state, also change to OUT OF DATE with appropriate tooltips. For
example, if the Synthesis tool state changes from PASS to OUT OF DATE, the
tool states of Place and Route tool as well as all the tools below it in the
Design Flow change to OUT OF DATE.

o If a Design Flow tool is CLEANED, the tool states of all the tools below it in the
Design Flow, if already run, change from PASS to OUT OF DATE.

o If a Design Flow tool is rerun, the tool states of all the tools below it in the
Design Flow, if already run, are CLEANED.

e Tool Options
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choose Configure Options) are modified, the tool states of that tool and all
the other tools below it in the Design Flow, if already run, are changed to OUT
OF DATE with appropriate tooltips.

Project Settings:

o Device selection
o Device settings
o Design Flow
0 Analysis operating conditions
Setting Changed Applicable Note Design Flow New State of
Families Tools the Affected
Affected Design Flow
Tools
Family SmartFusion2, | Part# is | N/A since N/A
IGLOO2, changed | family cannot
RTG4 be changed
once aroot is
created
Die SmartFusion2, | Part# is | All CLEANED/NEW
IGLOO2, changed
RTG4
Package SmartFusion2, | Part#is | All CLEANED/NEW
IGLOO2, changed
RTG4
Speed SmartFusion2, | Part# is | All CLEANED/NEW
IGLOO2, changed
RTG4
Core Voltage SmartFusion2, | Part# is | All CLEANED/NEW
IGLOO2, changed
RTG4
Range SmartFusion2, | Part#is | All CLEANED/NEW
IGLOO2, changed
RTG4
Default /0O Technology SmartFusion2, Synthesize, OUT OF DATE
IGLOO2, and all tools
RTG4 below it
Reserve Pins for Probes | SmartFusion2, Place and OUT OF DATE
IGLOO2, Route, and all
RTG4 tools below it
Reserve Pins for SPI RTG4 Place and OUT OF DATE
Route, and all
tools below it
Reserve Pins for Device | SmartFusion2, Place and OUT OF DATE
Migration* IGLOO2, Route and all
RTG4 tools below it
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Setting Changed Applicable Note Design Flow New State of
Families Tools the Affected
Affected Design Flow
Tools
PLL Supply Voltage (V) | SmartFusion2, Verify Power, | OUT OF DATE
IGLOO2 Generate
FPGA Array
Data and all
other
“Program and
Debug
Design” tools
below it
Power On Reset Delay SmartFusion2 Generate OUT OF DATE
IGLOO2 FPGA Array
Data and all
other
“Program and
Debug
Design” tools
below it
System controller SmartFusion2, Generate OUT OF DATE
suspended mode IGLOO2 FPGA Array
Data and all
other
“Program and
Debug
Design” tools
below it
Preferred Language SmartFusion2, None N/A
IGLOO2,
RTG4
Enable synthesis SmartFusion2, All OUT OF DATE
IGLOO2,
RTG4
Synthesis gate level SmartFusion2, Synthesize CLEANED/NEW
netlist format IGLOO2,
RTG4
Design SmartFusion2 None N/A
methodology(standalone | and IGLOO2
initialization)
Reports(Maximum SmartFusion2, None N/A
number of high fanout IGLOO2,
nets to be displayed) RTG4
Abort flow if errors are SmartFusion2, None N/A

found in PDC

IGLOO2,
RTG4
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Setting Changed Applicable Note Design Flow New State of
Families Tools the Affected
Affected Design Flow
Tools
Abort flow if errors are SmartFusion2, None N/A
found in SDC IGLOO2,
RTG4
Temperature range(C) SmartFusion2, Verify Timing, | OUT OF DATE
IGLOO2, Post Layout
RTG4 Simulate, and
Verify Power
Core voltage range(V) SmartFusion2, Verify Timing, | OUT OF DATE
IGLOO2, Post Layout
RTG4 Simulate, and
Verify Power
Default I/0 voltage range | SmartFusion2, Verify Timing, | OUT OF DATE
IGLOO2, Post Layout
RTG4 Simulate, and
Verify Power
Radiation (krad) RTG4 Verify Timing, | OUT OF DATE
Post Layout
Simulate, and
Verify Power
Enable Single Event RTG4 Verify Timing, | OUT OF DATE
Transient mitigation Post Layout
Simulate,
Verify Power,
Generate
FPGA Array
Data and all
other
“Program and
Debug
Design” tools
below it

*These settings are set in the 1/O Attributes tab of the Constraints Manager, not in the Project
Settings.

Note: Cleaning a tool means the output files from that tool are deleted including log and report files,
and the tool’s state is changed to NEW.

Edit Constraints

Click the Edit with 1/O Editor/Chip Planner/Constraint Editor button to edit existing and add new
constraints. Except for the Netlist Attribute constraints (*.fdc and *.ndc) file, which cannot be edited by an
interactive tool, all other constraint types can be edited with an Interactive Tool. The *.fdc and *.ndc files can
be edited using the Libero SoC Text Editor.

The Interactive Tool to edit I/O Attributes is the 1/0 Editor. The Interactive Tool to edit Floorplanning
Constraints is the Chip Planner. The Interactive Tool to edit Timing Constraints is the Constraint Editor.

For Timing Constraints that can be associated to Synthesis, Place and Route, and Timing Verification, you
need to specify which group of constraint files you want the Constraint Editor to read and edit:
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e Edit Synthesis Constraints - reads associated Synthesis constraints to edit.
e Edit Place and Route Constraints - reads only the Place and Route associated constraints.
e Edit Timing Verification Constraints - reads only the Timing Verification associated constraints.

For the three SDC constraints files (a.sdc, b.sdc, and c.sdc, each with Tool Association as shown in the
table below) when the Constraint Editor opens, it reads the SDC file based on your selection and the
constraint file/tool association.

Synthesis Place and Route Timing Verification
a.sdc X X
b.sdc X X
c.sdc [target] X X X

e Edit Synthesis Constraints reads only the b.sdc and c.sdc when Constraint Editor opens.
e Edit Place and Route Constraints reads a.sdc, b.sdc and c.sdc when Constraint Editor opens.
e Edit Timing Verification Constraints reads a.sdc and c.sdc when Constraint Editor opens.

Constraints in the SDC constraint file that are read by the Constraint Editor and subsequently modified by
you will be written back to the SDC file when you save the edits and close the Constraint Editor.

When you add a new SDC constraint in the Constraint Editor, the new constraint is added to the c.sdc file,
because it is set as target. If no file is set as target, Libero SoC creates a new SDC file to store the new

constraint.

Constraint Type and Interactive Tool

Constraint Type

Interactive Tool

Design Tool the

Required Design

Constraints Editor

Place and Route
Timing Verification

For Editing Constraints File is | State Before
Associated Interactive Tool
Opens for Edit
I/O Constraints I/O Editor Place and Route Post-Synthesis
Tool
Floorplanning Chip Planner Place and Route Post-Synthesis
Constraints Tool
Timing Constraints | SmartTime Synthesis Tool Pre-Synthesis

Post-Synthesis
Post-Synthesis

Netlist Attributes
Synplify Netlist
Constraint (*.fdc)

Interactive Tool Not
Available Open the
Text Editor to edit.

Synthesis

Pre-Synthesis

Netlist Attributes
Compile Netlist
Constraint (*.ndc)

Interactive Tool Not
Available Open the
Text Editor to edit.

Synthesis

Pre-Synthesis

Note: If the design is not in the proper state when Edit with <Interactive tool> is invoked, a pop-up

message appears.
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# | Information (=)

-o'l Please run 'Synthesize' before executing Edit Operation
Note: When an interactive tool is opened for editing, the Constraint Manager is disabled. You need to close
the Interactive Tool to return to the Constraint Manager.

Check Constraints
When a constraint file is checked, the Constraint Checker:
e Checks the syntax

e Compares the design objects (pins, cells, nets, ports) in the constraint file versus the design objects in
the netlist (RTL or post-layout ADL netlist). Any discrepancy (e.g., constraints on a design object which
does not exist in the netlist) are flagged as errors and reported in the *_sdc.log file

Design State and Constraints Check

Constraints can be checked only when the design is in the right state. A pop-up message appears when the
check is made and the design flow has not reached the right state,

7| Information Iﬁ

."'.. = \..
[0" Please run 'Synthesize’ before executing Ched: Operation
k.~ 4

Constraint Check for Required Netlist Used Check Result
Type Tools Design State for Design

Before Objects

Checking Checks

I/O Constraints | Place and Post-Synthesis | ADL Netlist Reported in Libero
Route Log Window

Floorplanning Place and Post-Synthesis | ADL Netlist par_sdc.log
Constraints Route

Timing Synthesis Pre-Synthesis RTL Netlist synthesis_sdc.log
Constraints

Place and Post-Synthesis | ADL Netlist par_sdc.log

Route
Timing Post-Synthesis | ADL Netlist vt_sdc.log
Verification

Netlist FDC Check | Pre-Synthesis RTL Netlist Libero Message
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Constraint Check for Required Netlist Used Check Result
Type Tools Design State for Design
Before Objects
Checking Checks
Attributes Window
Netlist NDC Check | Pre-Synthesis RTL Netlist Reported in Libero
Attributes Log Window

Place and Route - SmartFusion2, IGLOO2, RTG4

To change your Place and Route settings:
Expand Implement Design, right-click Place and Route and choose Configure Options.

Timing-Driven

Timing-Driven Place and Route is selected by default. The primary goal of timing-driven Place and Route is
to meet timing constraints, specified by you or generated automatically. Timing-driven Place and Route
typically delivers better performance than Standard Place and Route.

If you do not select Timing-driven Place and Route, timing constraints are not considered by the software,
although a delay report based on delay constraints entered in SmartTime can still be generated for the
design.

Power-Driven

Select this option to run Power-Driven layout. The primary goal of power-driven layout is to reduce dynamic
power while still maintaining timing constraints.

High Effort Layout

Enable this option to optimize performance; layout runtime will increase if you select this option.
Repair Minimum Delay Violations

This option is enabled by default for SmartFusion2, IGLOO2, and RTG4 devices.

Enable this option to instruct the Router engine to repair Minimum Delay violations for Timing-Driven Place
and Route mode (Timing-Driven Place and Route option enabled). The Repair Minimum Delay Violations
option, when enabled, performs an additional route that attempts to repair paths that have minimum delay
and hold time violations. This is done by increasing the length of routing paths and inserting routing buffers
to add delay to the top 100 violating paths.

When this option is enabled, Libero adjusts the programmable delays through I/Os to meet hold time
requirements from input to registers. For register-to-register paths, Libero adds buffers.

Libero iteratively analyzes paths with negative minimum delay slacks (hold time violations) and chooses
suitable connections and locations to insert buffers. Not all paths can be repaired using this technique, but
many common cases will benefit.

Even when this option is enabled, Libero will not repair a connection or path which:
e s a hardwired, preserved, or global net
e Has a sink pin which is a clock pin
e Is violating a maximum delay constraint (that is, the maximum delay slack for the pin is negative)
e May cause the maximum delay requirement for the sink pin to be violated (setup violations)

166 Libero SoC User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi
Implement Design in Enhanced Constraint Flow for SmartFusion2, IGLOO2, and RTG4

e Has the sink and driver pins located in the same cluster

Typically, this option is enabled in conjunction with the Incremental Layout option when a design’s maximum
delay requirements have been satisfied.

Every effort is made to avoid creating max-delay timing violations on worst case paths.

Min Delay Repair produces a report in the implementation directory which lists all of the paths that were
considered.

If your design continues to have internal hold time violations, you may wish to rerun repair Minimum Delay
Violations (in conjunction with Incremental Layout). This will analyze additional paths if you originally had
more than 100 violating paths.

Incremental Layout

Choose Incremental Layout to use previous placement data as the initial placement for the next run. If a high
number of nets fail, relax constraints, remove tight placement constraints, deactivate timing-driven mode, or
select a bigger device and rerun Place and Route.

You can preserve portions of your design by employing Compile Points, which are RTL partitions of the
design that you define before synthesis. The synthesis tool treats each Compile Point as a block which
enables you to preserve its structure and timing characteristics. By executing Layout in Incremental Mode,
locations of previously-placed cells and the routing of previously-routed nets is preserved. Compile Points
make it easy for you to mark portions of a design as black boxes, and let you divide the design effort
between designers or teams. See the Synopsys FPGA Synthesis Pro ME User Guide for more information.

Use Multiple Pass

Check Multiple Pass to run multiple pass of Place and Route to get the best Layout result. Click Configure
to specify the criteria you want to use to determine the best layout result. For details, see Multiple Pass
Layout Configuration (SmartFusion2, IGLOO2, RTG4).

See Also
Mutiple Pass Layout Configuration (SmartFusion2, IGLOO2, RTG4)
extended run_lib - Libero SoC Only

Multiple Pass Layout Configuration (SmartFusion2, IGLOO2, RTG4)

Multiple Pass Layout attempts to improve layout quality by selecting from a greater number of Layout
results. This is done by running individual place and route multiple times with varying placement seeds and
measuring the best results with specified criteria.

e Before running Multiple Pass Layout, save your design.
e Multiple Pass Layout is supported by all families.

e Multiple Pass Layout saves your design file with the pass that has the best layout results. If you want
to preserve your existing design state, you should save your design file with a different name before
proceeding. To do this, from the File menu, choose Save As.

e Four types of reports (timing, maximum delay timing violations, minimum delay timing violations, and
power) for each pass are written to the working directory to assist you in later analysis:

e <root_module_name>_timing_r<runNum>_s<seedIndex>.rpt

e <root_module_name>_timing_violations_r<runNum>_s<seedIndex>.rpt

e <root_module_name>_timing_violations_min_r<runNum>_s<seedIndex>.rpt
e <root_module_name>_power_r<runNum>_s<seedIndex>.rpt

e <root_module_name>_iteration_summary.rpt provides additional details about
the saved files.

To configure your multiple pass options:
1. When running Layout, select Use Multiple Passes in the Layout Options dialog box.
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2. Click Configure. The Multi-Pass Configuration dialog box appears.

| Multi-Pass Configuration I. 2 ﬁf-]

Mumber of passes: 5

L

Start at seed index {1- 101): 11 %

Measurement:
) Slowest dodk
(71 Spedific dock CLE_ibufU0_IOINFF:Y

~1 Timing violations

Maximum delay @ Minimum delay
Selectb Total Megative Sladk
Stop on first pass without violations
@ Total power

o) [l

Figure 105 - Multi-Pass Configuration Dialog Box
3. Set the options and click OK.

Number of passes: Set the number of passes (iterations) using the slider. 1 is the minimum and 25 is the
maximum. The default is 5.

Start at seed index: Set the specific index into the array of random seeds which is to be the starting point
for the passes. If not specified, the default behavior is to continue from the last seed index that was used.

Measurement: Select the measurement criteria you want to compare layout results against.

e Slowest clock: Select to use the slowest clock frequency in the design in a given pass as the
performance reference for the layout pass.

e Specific clock: Select to use a specific clock frequency as the performance reference for all layout
passes.

Timing violations: This is the default. Select Timing Violations to use the pass that best meets the slack or
timing-violations constraints.

Note: You must enter your own timing constraints through SmartTime or SDC.

e Maximum delay: Select to examine timing violations (slacks) obtained from maximum delay analysis.
This is the default.

e Minimum delay: Select to examine timing violations (slacks) obtained from minimum delay analysis.
e Select by: Worst Slack or Total Negative Slack to specify the slack criteria.
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o When Worst Slack (default) is selected, the largest amount of negative slack
(or least amount of positive slack if all constraints are met) for each pass is
identified, and the largest value of all passes determines the best pass.

o When Total Negative Slack is selected, the sum of negative slacks from the
first 100 paths in the Timing Violations report for each pass is identified, and
the largest value of all the passes determines the best pass. If no negative
slacks exist for a pass, the worst slack is used to evaluate that pass.

e Stop on first pass without violations: Select to stop performing remaining
passes if all timing constraints have been met (when there are no negative
slacks reported in the timing violations report).

e Total power: Select to determine the best pass to be the one that has the lowest total power (static +
dynamic) of all layout passes.

Iteration Summary Report

The file <root_module>_iteration_summary.rpt records a summary of how the multiple pass run was invoked
either through the GUI or extended_run_lib Tcl script, with arguments for repeating each run. Each new run
appears with its own header in the Iteration Summary Report with fields RUN_NUMBER and INVOKED AS,
followed by a table containing Seed Index, corresponding Seed value, Comparison data, Report Analyzed,
and Saved Design information.

B e teten_pemariont 8 X Rt @ X | UwBuee § % maby R maly 8% maly 8 X x

Figure 106 - Iteration Summary Report

See Also

Place and Route - SmartFusion2, IGLOO2, RTG4
extended run_lib

Export Back Annotated Files
Libero SoC uses post-layout files for back-annotated timing simulation.
Post-layout files include:
e *ba.sdf - Standard Delay Format for back-annotation to the simulator.

e *ba.vivhd - Post-layout flattened netlist used exclusively for back-annotated timing simulation. May
contain low level macros not immediately recognizable to you; these were added by the software to
improve your design performance.

To generate a post-layout file, in the Design Flow window click Implement Design and double-click Export
Back Annotated Files.

If you wish to export the Back Annotated files with options that are different than the default, right-click
Export Back Annotated Files and choose Open Interactively.
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Generate Back Annotated Files - SmartFusion2, IGLOO2, and RTG4 Only
Generates Back Annotated files for your design.
Back Annotated files include:
e *ba.sdf - Standard Delay Format for back-annotation to the simulator.
e *ba.v/.vhd - Post-placement netlist used for back-annotated timing simulation.

To generate these files, in the Design Flow window click Implement Design and double-click Generate
Back Annotated Files.

Right-click Generate Back Annotated Files and choose Configure Options to open the Generate Back
Annotated Files Options dialog box.

Simulator Language Type - Set your simulator language type according to your design.

Timing: Export enhanced min delays for best case - Exports your enhanced min delays to include your
best-case timing results in your Back Annotated file.

Simulate - Opens ModelSim AE

The back-annotation functions are used to extract timing delays from your post layout data. These extracted
delays are put into a file to be used by your CAE package’s timing simulator. The default simulator for Libero
SoC is ModelSim AE. You can change your default simulator in your Tool Profile.

If you wish to perform pre-layout simulation: In the Design Flow Window, under Verify Pre-Synthesized
design, double-click Simulate.

To perform timing simulation:

1. If you have not done so, back-annotate your design and create your testbench.
2. Right-click Simulate (in Design Flow window, Implement Design > Verify Post-Synthesis

Implementation > Simulate) and choose Organize Input Files > Organize Source Files from the
right-click menu.

In the Organize Files for Source dialog box, all the stimulus files in the current project appear in the
Source Files in the Project list box. Files already associated with the block appear in the Associated
Source Files list box.

In most cases you will only have one testbench associated with your block. However, if you want
simultaneous association of multiple testbench files for one simulation session, as in the case of PCI
cores, add multiple files to the Associated Source Files list.

To add a testbench: Select the testbench you want to associate with the block in the Source Files in
the Project list box and click Add to add it to the Associated Source Files list.

To remove a testbench: To remove or change the file(s) in the Associated Source Files list box,
select the file(s) and click Remove.

To order testbenches: Use the up and down arrows to define the order you want the testbenches
compiled. The top level-entity should be at the bottom of the list.

3.  When you are satisfied with the Associated Simulation Files list, click OK.

4. To start ModelSim AE, right-click Simulate in the Design Hierarchy window and choose Open
Interactively. ModelSim starts and compiles the appropriate source files. When the compilation
completes, the simulator runs for 1 us and the Wave window opens to display the simulation results.

5. Scroll in the Wave window to verify the logic works as intended. Use the cursor and zoom buttons to
zoom in and out and measure timing delays. If you did not create a testbench with WaveFormer Pro,
you may get error messages with the vsim command if the instance names of your testbench do not
follow the same conventions as WaveFormer Pro. Ignore the error message and type the correct vsim
command.

6. When you are done, from the File menu, choose Quit.
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Verify Timing

Verify Timing Configuration

Use this dialog box to configure the ‘Verify Timing’ tool to generate a timing constraint coverage report and
detailed static timing analysis and violation reports based on different combinations of process speed,
operating voltage, and temperature.

For the timing and timing violation reports you can select:

e Max Delay Static Timing Analysis report based on Slow process, Low Voltage, and High Temperature
operating conditions.

e Min Delay Static Timing Analysis report based on Fast process, High Voltage, and Low Temperature
operating conditions.

e Max Delay Static Timing Analysis report based on Fast process, High Voltage, and Low Temperature
operating conditions.

e Min Delay Static Timing Analysis report based on Slow process, Low Voltage, and High Temperature
operating conditions.

The actual values for High/Low Voltage and High/Low Temperature shown in this configuration dialog box
are based on the operating conditions: COM, IND, MIL, TGradel/2, and/or custom settings as set in the
Project’s settings (Project > Project Settings > Analysis Operating Conditions). Refer to Project Settings >
Analysis Operating Conditions for the actual High/Low Voltage and High/Low Temperature values.

The following figures show examples of the Verify Timing Configuration configuration dialog box for various
operating conditions and report selections.

| B Verify Timing Configuration |i|é

‘ Tirming Reports
|
|

| Max delay analysis using Slow process at 1. 14V and 85C

(/] Min delay analysis using Fast process at 1,26V and 0C

I | Max delay analysis using Fast process at 1.26V and 0C

|
] Min delay analysis using Slow process at 1. 14V and 85C

Timing Violations Reports

V]| Max delay analysis using Slow process at 1. 14V and 85C
+| Min delay analysis using Fast process at 1. 26V and 0C
] Max delay analysis using Fast process at 1.26V and OC

| Min delay analysis using Slow process at 1. 14V and 85C

Constraints Coverage Reports

| Generate constraints coverage report

LS

Figure 107 - Temperature/Voltage Value for Operating Conditions: COM (Commercial)
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(VR Verily Tuming Conficniatin L2 3o |

Timing Reports
V] Max delay analysis using Slow process at 1. 14V and 100C

(¥ Min delay analysis using Fast process at 1,26V and -40C
(W] Max delay analysis using Fast process at 1,26V and -40C

7] Min delay analysis using Slow process at 1. 14V and 100C

Timing Violations Reports

(W] Max delay analysis using Slow process at 1. 14V and 100C
[¥] Min delay analysis using Fast process at 1. 26V and -40C

("] Max delay analysis using Fast process at 1.26V and -40C

"] Min delay analysis using Slow process at 1. 14V and 100C

Consfraints Coverage Reports
Zl Generate constraints coverage report

ok J[ concel |

LS -

Figure 108 - Temperature/Voltage Value for Operating Conditions: IND (Industrial)
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e

B Ve rify Timing Configuration [E|@
Timing Reports
V] Max delay analysis using Slow process at 1.14¥ and 125C
| Min delay analysis using Fast process at 1.26Y and 0C
Max delay analysis using Fast process at 1.26Y and OC

| Min delay analysis using Slow process ak 1. 14 and 125C

Tirning Yiodations Reports

| Max delay anahysis using Slow process at 1.14Y and 125C
V| Min delay analysis using Fast process at 1,264 and 0C

] Max delay analysis using Fast process at 1.26Y and 0C

| Min delay analysis using Slow process ak 1,14V and 125C

Constraints Coverags Reports

/| Gemerate constraints coverage report

[ ok ][ cancel |

Figure 109 - Temperature/Voltage value for CUSTOM Temperature (0°C to 125°C) and IND Voltage

Types of Timing Reports
From the Design Flow window > Verify Timing, you can generate the following types of reports:

Timing reports — These reports display timing information organized by clock domain. Four types of timing
reports are available. You can configure which reports to generate using the ‘Verify Timing’ configuration
dialog box (Design Flow > Verify Timing > Configure Options). The following reports can be generated:

Max Delay Static Timing Analysis report based on Slow process, Low Voltage and High Temperature
operating conditions.

<root>_max_timing_slow_<Ilv>_<ht>.xml (generated by default)

Min Delay Static Timing Analysis report based on Fast process, High Voltage and Low Temperature
operating conditions.

<root>_max_timing_fast_<hv>_<It>.xml

Max Delay Static Timing Analysis report based on Fast process, High Voltage and Low Temperature
operating conditions.

<root>_min_timing_fast_<hv>_<It>.xml (generated by default)

0 Min Delay Static Timing Analysis report based on Slow process, Low Voltage and High Temperature
operating conditions.

<root>_min_timing_slow_<Iv>_<ht>.xml

Timing violations reports — These reports display timing information organized by clock domain. Four
types of timing violations reports are available. You can configure which reports to generate using the ‘Verify
Timing’ configuration dialog (Design Flow > Verify Timing > Configure Options). The following reports
can be generated:
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¢ Max Delay Static Timing Analysis report based on Slow process, Low Voltage and High Temperature
operating conditions.

<root>_max_timing_slow_ violations_<Iv>_<ht>.xml (generated by default)

e Min Delay Static Timing Analysis report based on Fast process, High Voltage and Low Temperature
operating conditions.

<root>_max_timing_violations_fast_<hv>_<It>.xml

e Max Delay Static Timing Analysis report based on Fast process, High Voltage and Low Temperature
operating conditions.

<root>_min_timing_fast_ violations_<hv>_<It>.xml (generated by default)

e Min Delay Static Timing Analysis report based on Slow process, Low Voltage and High Temperature

operating conditions.
<root>_min_timing_slow_ violations_<Iv>_<ht>.xml

Constraints coverage report — This report displays the overall coverage of the timing constraints set on the

current design.
<root>_timing_constraints_coverage.xml (generated by default)

Combinational loop report — This report displays combinational loops found during initialization.
<root>_timing_combinational_loops.xml (always generated)

Note: The actual values for High/Low Voltage and High/Low Temperature shown in this configuration dialog
boxare based on the operating conditions: COM, IND, MIL, TGradel/2, and/or custom settings as set in the
Project’s settings (Project > Project Settings > Analysis Operating Conditions). Refer to Project
Settings > Analysis Operating Conditions for the actual High/Low Voltage and High/Low Temperature
values.

4 4 Verify Timing

V M3_MDDR_top_rmax_timing_slow_1.14Y_100C xml

X M3_MDDR_top_min_timing_fast_1.26W_-40C.xml

V M3_MDDR_top_ma:x_timing_fast_1.26Y_-40C.xml

? M3_MDDR_top_min_timing_slow_1.14Y_100C.xml

V M3_MDDR_top_max_timing_viclations_slow_1.14V_100C.xml
X M3_MDDR_top_min_timing_viclations_fast 1.26V_-40C.xml
? M3_MDDR_top_max_timing_viclations_fast_1.26V_-40C.xml
? M3_MDDR_top_min_timing_viclations_slow_1.14V_100C.xml
M3_MDDR_top_timing_constraints_coverage.xml
M3_MDDR_top_timing_combinational_loops.ml

Figure 110 - Reports Example

Icon Definition

| ’ Timing requirement met for this report

Timing report available for generation but has not been selected/configured for

x Timing requirement not met (violations) for this report
? generation
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SmartTime (Enhanced Constraint Flow)

SmartTime is the Libero SoC gate-level static timing analysis tool. With SmartTime, you can perform
complete timing analysis of your design to ensure that you meet all timing constraints and that your design
operates at the desired speed with the right amount of margin across all operating conditions.

Note: SmartTime in the Enhanced Constraint Flow has changed. See the Timing Constraints
Editor for help with creating and editing timing constraints in the Enhanced Constraints
Flow.

Static Timing Analysis (STA)

Static timing analysis (STA) offers an efficient technique for identifying timing violations in your design and
ensuring that it meets all your timing requirements. You can communicate timing requirements and timing
exceptions to the system by setting timing constraints. A static timing analysis tool will then check and report
setup and hold violations as well as violations on specific path requirements.

STA is particularly well suited for traditional synchronous designs. The main advantage of STA is that unlike
dynamic simulation, it does not require input vectors. It covers all possible paths in the design and does all
the above with relatively low run-time requirements.

The major disadvantage of STA is that the STA tools do not automatically detect false paths in their
algorithms as it reports all possible paths, including false paths, in the design. False paths are timing paths
in the design that do not propagate a signal. To get a true and useful timing analysis, you need to identify
those false paths, if any, as false path constraints to the STA tool and exclude them from timing
considerations.

Timing Constraints

SmartTime supports a range of timing constraints to provide useful analysis and efficient timing-driven
layout.

Timing Analysis
SmartTime provides a selection of analysis types that enable you to:
¢ Find the minimum clock period/highest frequency that does not result in a timing violations
¢ Identify paths with timing violations
¢ Analyze delays of paths that have no timing constraints
e Perform inter-clock domain timing verification
e Perform maximum and minimum delay analysis for setup and hold checks

To improve the accuracy of the results, SmartTime evaluates clock skew during timing analysis by
individually computing clock insertion delays for each register.

SmartTime checks the timing requirements for violations while evaluating timing exceptions (such as
multicycle or false paths).

SmartTime and Place and Route
Timing constraints impact analysis and place and route the same way. As a result, adding and editing your
timing constraints in SmartTime is the best way to achieve optimum performance.

SmartTime and Timing Reports

From SmartTime > Tools > Reports, the following report files can be generated:
e Timing Report (for both Max and Min Delay Analysis)
e Timing Violations Report (for both Max and Min Delay Analysis)
e Bottleneck Report
e Constraints Coverage Report
e Combinational Loop Report

SmartTime and Cross-Probing into Chip Planner

From SmartTime, you can select a design object and cross-probe the same design object in Chip Planner.
Design objects that can be cross-probed from SmartTime to Chip Planner include:
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e Timing Paths
Refer to the SmartTime User’s Guide for details (Libero SoC > Help > Reference Manual > SmartTime
User’s Guide).

SmartTime and Cross-Probing into Constraint Editor

From SmartTime, you can cross-probe into the Constraint Editor. Select a Timing Path in SmartTime’s
Analysis View and add a Timing Exception Constraint (False Path, Multicycle Path, Max Delay, Min Delay) .
The Constraint Editor reflects the newly added timing exception constraint.

Refer to the SmartTime for Libero In Enhanced Constraint Flow User’s Guide for details.

Verify Power
Right-click on the Verify Power command in the Design Flow window to see the following menu of options:

M Applications Places System @ o= kA

Project File Edit View Design Tools Help

Design Flow & W
countl6 a Q¢ @
Toal

- ¢ Create Design
- ¢ Constraints
¥ = » Implement Design
Vv 5 Synthesize
+H F Verify Post-Synthesis Implementation
*L| Configure Flash*Freeze
v ©5 Place and Route
F Edit Constraints
F Verify Post Layout Implementation
+'| Generate Back Annotated Files
Simulate
Verify Timing

& Open SmartTime
=- ¥ 1D Analyz Run
£¥ SSN AN Clean and Run Al

H

+- ¢ Program and D
5 b Handoff Desigr Open Interactively
¥ b Handoff Design  Clean hment
- ¢ Handoff Design 7
View Report
Help

Figure 111 - Verify Power right-click menu

Verify Power sub-commands

Run - Runs the default power analysis and produces a power report. This is also the behavior of a double-
click to Verify Power.

Clean and Run All - Identical to the sequence of commands "Clean" (see below) and "Run”
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Open interactively - Brings up the SmartPower for Libero SoC tool (see below)
Clean - Clears the history of any previous default power analysis, including deletion of any reports. The flow

task completion icon will also be cleared.

View Report - This sub-command is only available and visible if a report is available. When View Report is
invoked, the Report tab will be added to the Libero SoC GUI window, and the Power Report will be selected
and made visible.

SmartPower

SmartPower is the Microsemi SoC state-of-the-art power analysis tool. SmartPower enables you to globally
and in-depth visualize power consumption and potential power consumption problems within your design, so
you can make adjustments — when possible — to reduce power.

SmartPower provides a detailed and accurate way to analyze designs for Microsemi SoC FPGAs: from top-
level summaries to deep down specific functions within the design, such as gates, nets, I0s, memories,
clock domains, blocks, and power supply rails.

You can analyze the hierarchy of block instances and specific instances within a hierarchy, and each can be
broken down in different ways to show the respective power consumption of the component pieces.

SmartPower also analyses power by functional modes, such as Active, Flash*Freeze, Shutdown, Sleep, or
Static, depending on the specific FPGA family used. You can also create custom modes that may have been
created in the design. Custom modes can also be used for testing "what if" potential operating modes.

SmartPower has a very unique feature that enables you to create test scenario profiles. A profile enables
you to create sets of operational modes, so you can understand the average power consumed by this
combination of functional modes. An example may be a combination of Active, Sleep, and Flash*Freeze
modes — as would be used over time in an actual application.

SmartPower generates detailed hierarchical reports of the power consumption of a design for easy
evaluation. This enables you to locate the power consumption source and take appropriate action to reduce
the power if possible.

SmartPower supports use of files in the Value-Change Dump (VCD) format, as specified in the IEEE 1364
standard, generated by the simulation runs. Support for this format lets you generate switching activity
information from ModelSim or other simulators, and then utilize the switching activity-over-time results to
evaluate average and peak power consumption for your design.

See SmartPower For Libero SoC User Guide

IO Advisor (SmartFusion2, IGLOO2, and RTG4)

The 10 Advisor enables you to balance the timing and power consumption of the 10s in your design. For
output 10s, it offers suggestions on Output Drive and Slew values that meet (or get as close as possible to)
the timing requirements and generates the lowest power consumption. For Input 10s, it offers suggestions
on On-Die Termination (ODT) Impedance values (when the ODT Static is ON) that meet (or get as close as
possible to) the timing requirements and generates the lowest power consumption.

Timing data information is obtained from the Primary analysis scenario in SmartTime. Power data is
obtained from the Active Mode in SmartPower.

To open the 10 Advisor, from Libero SoC’s Design Flow window, right-click 10 Advisor and choose Open
Interactively (IO Advisor > Open Interactively) or double-click 10 Advisor.
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Figure 112 - 10 Advisor > Open Interactively

Introduction
The Introduction screen provides general information about the 10 Advisor.
The introduction screen provides the navigational panel for you to navigate to the following panels:
e Output Load panel — Displays the 10O load Power and Delay values for Outputs and Inouts.
e Output Drive and Slew panel — Displays the Output Drive and Slew for Outputs and Inouts.
e ODT & Schmitt Trigger — Displays the ODT Static (On/Off), the ODT Impedance value (Ohms) for
Inputs and Inouts and the Schmitt Trigger (On/Off)

All steps in the 10 Advisor are optional.
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The I0Advisor helps you reduce power consumption while meeting timing constraints.

Each soreen gives you access to modify individual 10 attributes and display the timing and power impact
of your changes. For output drive and slew, the IDAdvisor suggests the best parameter settings
to meat your power and timing goals.

All the steps in 10Advisor are optional.
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Figure 113 - 1O Advisor - Introduction

Output Load
The Output Load panel displays the load of all output/inout ports in your design.
The display is sorted by Initial or Current value and is selectable in the Sort By drop-down menu.

Tooltips are available for each cell of the Table. For output and inout ports, the tooltip displays the Port
Name, Macro Name, Instance Name and Package Pin. Inout ports are identified by a blue bubble icon.
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Figure 114 - 10 Advisor - Output Load Panel

Search and Regular Expressions

To search for a specific Port, enter the Port Name in the Port Name Search field and click Search. Regular
expressions are accepted for the search. All Port Names matching the regular expression are displayed.
The regular expression “FDDR*", for example, results in all the output ports beginning with FDDR in the Port
Name appearing in the display.
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Figure 115 - Search Field and Regular Expressions

Status Column
The icon in the Status Column displays the status of the Output Port.

Icon Status and Explanation

‘».f OK - The IO attributes match the suggestion in Output Drive and Slew Table.

Error — The Timing constraints for this 10 are not met in Output Drive and
Slew Table.

Information — you can improve the power and/or timing of the 10 by applying
the suggestion in Output Drive and Slew Table.

o
—

Column Display and Sorting

To hide or unhide a column, click on the drop-down menu of a column header and select Hide Column or
Unhide All Columns.

To sort the contents of a column, select the column header, and from the right-click menu, select Sort /A to
Z/Z to A/Sort Min to Max/Sort Max to Min as appropriate.

Set Output Load
To set the output load of a port, click the Port and click Set Output Load or edit the value in the Current
Output Load cell. Initial value remains unchanged.

Restore Initial Value

To restore a Port’s output load to the initial value, select the output port and click Restore Initial Value. The
current value changes to become the same value as the initial value.

Output Drive and Slew
The Output Drive and Slew page displays the Output Drive and Slew of all output/inout ports of your design.

The display can be sorted according to the initial, current or suggested values. To change the sorting, click
the Sort By drop-down menu to make your selection.
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Three values are displayed for Output Drive and Slew of each 10 output/inout port:
e Initial — This is the initial value when the 10 Advisor is launched.

e Current —This is the current value which reflects any changes you have made, including suggestions
you have accepted from the 10 Advisor.

e Suggested — This is the suggested value from the IO Advisor for optimum power and timing
performance.
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Figure 116 - 10 Advisor — Output Drive and Slew

How the Suggested Values Are Computed
The 10 Advisor provides suggestions for output drive and slew values according to the following criteria:

¢ When the user has set no output delay constraint for the port, the 10 Advisor suggests 10 attribute
values that generate the lowest power consumption.

¢ When the user has set an output delay constraint on the port, the 10 Advisor suggests 10 attribute
values that generates the lowest power consumption and positive timing slacks. If the slacks of all
attribute combinations are negative, the 10 Advisor suggests an attribute combination (Drive strength
and slew) that generates the least negative slack.

In this screen, you can change the drive strength and slew of the design output 1/Os. Select the out drive
and/or the slew current value cell. Click the cell to open the combo box. Choose the value you want from the
set of valid values. You can restore the initial values by clicking Restore Initial Value.

To make changes to multiple 1/0s, select multiple I/Os (Control+click), click Set Slew or Set Outdrive,
select the value, and click OK.

Apply Suggestion
To apply the suggested value to a single output port, select the output port and click Apply Suggestion.

To apply the suggested values to mulitple ports, select the multiple ports (Control+click) and click Apply
Suggestion.

Adjust ODT and Schmitt Trigger

This page allows you to set the Schmitt Trigger setting (On/Off), On-Die Termination (ODT) Static setting
(On/Off), and the ODT Impedance (in Ohms) to valid values for all Input/Inout IOs of your design. The 10
Advisor page instantly gives you the Power (in uW) and Delay (in ns) values when you make changes. If the
suggested values meet your design’s power and/or timing requirements, you can accept the suggestions
and continue with your design process.
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Figure 117 - 10 Advisor — Adjust ODT and Schmitt Trigger

Search and Regular Expressions

To search for a specific Port, enter the Port Name in the Port Name Search field and click Search. Regular
expressions are accepted for the search. All Port Names matching the regular expression are displayed.
The regular expression “RESET*”, for example, results in the input/inout ports with the port name beginning
with “RESET” appearing in the display.
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Figure 118 - Search Field and Regular Expressions

Status Column
The icon in the Status Column displays the status of the input/inout ports.

Icon Status and Explanation

v OK - The IO attributes match the suggestion in the Adjust ODT and Schmitt
Trigger Table.

Error — The Timing constraints for this 10 are not met in the Adjust ODT and
o Schmitt Trigger Table.

Information — you can improve the power and/or timing of the 10 by applying
0 the suggestion in the Adjust ODT and Schmitt Trigger Table.
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Column Display and Sorting

To hide or unhide a column, click on the drop-down menu of a column header and select Hide Column or
Unhide All Columns.

To sort the contents of a column, select the column header, and from the right-click menu, select Sort /A to
Z/Z to A/Sort Min to Max/Sort Max to Min as appropriate.

Set Schmitt Trigger

For 10 Standards that support the Schmitt Trigger, you can turn the Schmitt Trigger On or Off. Select the 10
and click Set Schmitt Trigger to toggle on or off. Your setting is displayed in the Schmitt Trigger column for
the 10.

Set ODT Static

For IO standards that support ODT static settings, you can turn the ODT Static On or Off according to your
board layout or design needs:

e On - The Termination resistor for impedance matching is located inside the chip.
e Off — The Terminator resistor for impedance matching is located on the printed circuit board.

To turn the ODT Static on or off, click to select the input/inout port and from the pull-down menu, toggle on
or off. You can also turn ODT Static on or off by clicking Set ODT Static and toggling on or off.

Set ODT Impedance (Ohm)

For each input/inout in your design, valid ODT Impedance values (in Ohms) are displayed for you to choose
from. Click to select the input/inout port and select one of the valid ODT impedance values from the pull-
down list in the ODT Impedance column. You can also click Set ODT Impedance to choose one of the valid
ODT impedance values. The Power and Delay values may vary when you change the ODT Impedance
(Ohm).

Note: When ODT_static is set to OFF, changing the ODT_Impedance value has no effect on the Power and
Delay values. The Power and Delay values change with ODT_Impedance value changes only when

ODT _static is set to ON.

Apply Suggestion
To apply the suggested value to a single input/inout port, select the port and click Apply Suggestion. To

apply the suggested values to mulitple ports, select the multiple ports (Control-click) and click Apply
Suggestion.

Restore Initial Value

To restore an input/inout port’s attribute values to the initial values, select the port and click Restore Initial
Value.The current value changes to the same value as the initial value.

Summary of Changes
This screen provides a summary of the timing and power changes you have made in the 10 Advisor.
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Figure 119 - 10 Advisor — Summary

You can save the summary by clicking Save Summary, selecting the save format (text or CSV), and clicking
OK.

To commit IO Attribute changes you have made to the database (the *io_pdc file), choose Save from the
File Menu (File > Save). Click OK in the dialog that appears.

Note: After saving the changes into the pdc file and database, the summary refreshes automatically and
shows the latest data as per the latest database.

Program and Debug

SmartFusion2 and IGLOO2 Programming Tutorials

SPI Programmming Tutorials

SPI Programming Tutorial Overview

SmartFusion2 and IGLOO2 devices can be programmed using multiple programming methods.

Refer to the Programming User Guide for your respective device for details on different programming
methods.

The following tutorials describe programming methods that involve the MSS/HPMS SPI_0 ports:
e Auto Programming
e In Application Programing (IAP) Tutorial
e Programming Recovery - Auto Update

Auto Programming

Auto programming uses the Microcontroller Subsystem SPI port (SPI_0) to fetch the bitstream from the
external SPI flash (pre-programmed) connected to the same port and then program the FPGA Fabric and
eNVM. The transaction between the System controller and the external SPI flash happens in SPI master
mode.

The SPI_0 port is enabled to operate as a SPI master at power-on reset or DEVRST_N assertion if the
FLASH_GOLDEN_N pin is pulled low. The Auto Programming can be protected in the Security Policy
Manager > Update Policy.
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1. Right-click Configure Security and Programming > Configure Security and choose Configure
Options (as shown in the figure below).

4 » Configure Security and Programming ...
# Configure User Programming Data =
B Configure Programming Recovery
& Configure Security _ =
@ Update eNVM Me Configure Options...
4 » Program Design Help
¥ Configure Bitstream
%% Generate Bitstream
% Run PROGRAM Action |

Figure 120 - Launch Security Policy Manager
2. In Security key mode select Enable customer security options.
3. In Security policies click the checkbox to enable Update Policy.
4. Click the Update Policy button and click to enable Auto Programming.

Auto programming uses a *.spi programming file. You must export a *.spi file using Export Bitstream (under
Handoff Design for Production).

Note: SPI file programming for Auto Programming, Auto Update (IAP), Programming Recovery, and IAP/ISP
Services currently can only program security once with the master file. Update files cannot update the
security settings. In addition, Programming Recovery, Silicon Signature, Firewall, and Tamper Macro can
only be programmed with the master file and cannot be updated.

DEVICE_INFO programming

When the DEVICE_INFO programming action is run with a STAPL file for SmartFusion2 and IGLOO2
devices, you will see the following message:

"Info: Algorithm Version, Programmer, Software Version, Programming Software, Programming Interface
Protocol, and Programming File Type information do not get programmed with Auto Programming, Auto
Update (IAP), Programming Recovery, or IAP/ISP Services and should be ignored.”

In Application Programming (IAP) Tutorial

In Application Programming (IAP) is a two-step process. In the first step, the intended bitstream is written to
an external SPI flash connected to SPI_0 port of MSS. In the second step, Cortex-M3(SmartFusion2) or
user logic in Fabric (IGLOO2) calls the IAP programming service of the system controller to program the
FPGA fabric and eNVM with the bitstream fetched from the external SPI flash.

In order to perform IAP, the required functional blocks must be configured by pre-programming the chip.

To enable SmartFusion2/IGLOO2 device for IAP, you must configure the following components in Libero
SoC:

e Source of application image: eSRAM, eNVM or DDR/SDR memories or Fabric
e Source of programming bitstream: MSS peripherals including SPI_0 port
e Interface between System Controller and Cortex-M3: COMM_BLK

To create a programming file with IAP configuration (SmartFusion2 steps shown):

1. Create a Libero SoC project targeting the desired SmartFusion2 device. Select SmartFusion2
Microcontroller. Click the checkbox to enable Use Design Tool and select the SmartFusion2
Microcontroller Subsystem (MSS). Click OK to continue. A dialog box appears to name your new
component.

2. Name the component IAP_Setup_MSS_0.
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3. Double-click IAP_Setup_MSS_0 to configure the blocks:

e ENVM stores the two step IAP application code.

e USB is the interface used to read the programming bitstream and download it to the External SPI
flash.

e MSS_CCC is the Cortex-M3 Clock

e RESET Controller is the Chip reset

e SPI_0is connected with External SPI flash

¢ MMUART_1 is the Host PC communication to get status
See the SmartFusion2 Microcontroller Subsystem User Guide section on How to Use Blocks for
details on how to configure them.

4. Click SmartDesign > Generate Component.

5. Complete the design flow up to Place and Route and export the firmware to enable the MSS
component.

6. Click Generate Bitstream or Export Bitstream to export a programming file you can use to program
your device.

Note: Libero SoC will error out if SP1_0 routs to the fabric instead of a package pin.

DEVICE_INFO programming
When the DEVICE_INFO programming action is run with a STAPL file for SmartFusion2 and IGLOO2
devices, you will see the following message:
"Info: Algorithm Version, Programmer, Software Version, Programming Software, Programming Interface
Protocol, and Programming File Type information do not get programmed with Auto Programming, Auto
Update (IAP), Programming Recovery, or IAP/ISP Services and should be ignored.”

Programming Recovery Tutorial

If programming recovery is enabled, SmartFusion2/IGLOO2 device automatically recovers from a power
failure during a programming operation. Programming recovery requires an external SPI flash to be
connected to the MSS SPI_0 port. The FPGA must be pre-programmed with the programming recovery
settings. Programming recovery settings define the location of the image and how to recovery will take
place.
For a blank device the image location is set to MSS SPI_0 port where an external SPI flash must be
connected.
Notes:
Programming Recovery cannot be updated with _UEK1 or _UEK2 programming files. Only the master
programming file can be used.
SPI file programming for Auto Programming, Auto Update (IAP), Programming Recovery, and IAP/ISP
Services currently can only program security once with the master file. Update files cannot update the
security settings. In addition, Programming Recovery, Silicon Signature, Firewall, and Tamper Macro can
only be programmed with the master file and cannot be updated.
To configure Programming Recovery:
1. Under Configure Security and Programming Options double-click Configure Programming
Recovery.
2. Select Enable Programming Recovery. If Auto update is selected then Design version is mandatory.
You must enter the design version in the Configure User Programming Data menu.
3. Check Enable Programming Recovery and set the SPI clock frequency and data transfer mode.
Refer to the table below for SPI data transfer options. For a blank device SPO and SPH are defaulted
to 1.
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Table 3 - SPI Signal Polarity Modes

SPO | SPH SPI Sample | Shift SPI SPI Select Between
Clock in Edge Edge | Selectin Frames
Idle Idle

0 0 Low Rising Falling | High Stays active until all the
frames set by frame

0 1 Low Falling Rising [ High counter have been
transmitted

1 0 High Falling Rising [ High

1 1 High Rising Falling | High

Note: SPO = SPI clock polarity; SPH = SPI clock phase

If Enable Auto Update is checked, Programming recovery is automatically enabled. In this scenario
when the device is powering up, it will be auto programmed with the bitstream stored in SPI_0 port if
the update SPI image design version is greater than the design version currently programmed in the

device.

& Microsemi
Program and Debug

During programming recovery, if there is a programming failure due to power failure, then the the

device will be recovered with the golden image.

Back Level protection - If you enable Back Level protection it provides bitstream replay protection.
The BACKLEVEL value limits the design versions that the device can update. So, only programming

bitstreams with DESIGNER > BACKLEVEL are allowed for programming
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[®"] Update Policy . ﬁ

Fabric update protection:

[Use FlashLock/UPK1 to unlock Erase/Write/Verify operations v]

eNVM update protection:

| Use FlashLock/UPK1 to unlock Write/Verify/Read operations - ]

[#] Back Level protection
0 Design version (number between 0 and 65535): 2
L Back Level version (number between 0 and 65535): 1

M\ [¥] Back Level Bypass

¥ D : : > ]
1 Bypass the Back Level check in the event of a recovery

caused by power failure during an update.
] 1AP/ISP Services

|| ITAG (use FlashLock/UPK1 to unlock)

|| sP1Slave (use FlashLock/UPK1 to unlock)

Disable access to the following programming features:
- Fabric (use FlashLock/UPK1 to unlock Erase/Write/Verify)
- eNVM (use FlashLock/UPK1 to unlock Write/Verify/Read)

: Help oK J [ Cancel

Figure 121 - Bypass Back Level Version Check

4. Inthe Update Policy dialog box click the checkbox to enable Back Level Protection, as shown in the
figure above. Note that in order to use Back Level Protection you must enter the Design version in the
Configure User Programming Data dialog box. By default the Back Level bypass is checked in order to
continue with programming recovery with current/golden image in the event of power failure. This
allows the golden SPI image to be programmed even if the design version is less than the backlevel
version without the need of a pass key.

Consider an instance where the device is programmed with a golden image first which has
DESIGNVER = 2 and BACKLEVEL = 1. Now you want to program the device with an update image
that has DESIGNVER = 3 and BACKLEVEL = 2. If the Back Level bypass is not checked and power
fails, the programming recovery will stop and the device will be left inoperable because the golden
image DESIGNVER is not greater than the BACKLEVEL of update image.

5. Export the SPI directory for Programming recovery. The flash device on the MSS SPI_0 port contains
a directory at address 0 with the information shown in the table below.

Offset Name Description

0 GOLDEN_IMAGE_ADDRESS[3:0] Contains the address where the
golden image starts

4 GOLDEN_IMAGE_DESIGNVER[1:0] | Contains the design version of the
golden image
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Offset Name Description

6 UPDATE_IMAGE_ADDRESS][3:0] Contains the address where the
update image starts

10 UPDATE_IMAGE_DESIGNVER][1:0] | Contains the design version of the
update image

6. Right-click Export Programming File and choose Configure Options.

7. In the Export Bitstream dialog box, click the checkbox to enable Export SPI directory for
programming recovery and click the Specify SPI Directory button.

8. Inthe SPI Directory dialog box enter the Design version and browse to the location of the Golden
SPI Image and/or Update SPI Image. You must enter the Address of the bitstream manually (as
shown in the figure below).

DEVICE_INFO programming

When the DEVICE_INFO programming action is run with a STAPL file for SmartFusion2 and IGLOO2
devices, you will see the following message:

"Info: Algorithm Version, Programmer, Software Version, Programming Software, Programming Interface
Protocol, and Programming File Type information do not get programmed with Auto Programming, Auto
Update (IAP), Programming Recovery, or IAP/ISP Services and should be ignored.”

SmartFusion2 Programming Tutorial

SmartFusion2 Programming Tutorial Overview

The SmartFusion2 Programming Tutorial describes the basic steps for SmartFusion2 programming.

Only the bold steps in the Design Flow window are required to complete and program your design. Note that
the bold steps are completed automatically if you use the Build button.

1. MSS Configuration - eNVM
eNVM configuration enables you to configure eNVM as a ROM so that it can be included in the
eNVM digest calculations.

Data Security Configuration controls which masters have access to which memory region within

the MSS.

2. Generate Bitstream

Generate bitstream for programming within Libero.

3. Edit Design Hardware Configuration

Configures Device I/O States During Programming.

4. Configure Security and Programming Options
e Security Policy Manager

o Configure Bitstream

e Update eNVM Memory Content

5. Program Design

Configure Actions/Procedures (sets programming options) and programs your device.

6. Handoff Design for Production

e Export Bitstream
e Export BSDL
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MSS Configuration - eNVM

eNVM Configuration

You must create a MSS to configure your eNVM. Use System Builder to configure your eNVM for IGLOO?2.
eNVM configuration enables you to configure eNVM as a ROM so that it can be included in the eNVM digest

calculations. To do so:
1. Open your MSS and double-click the eNVM block to open the eNVM configuration dialog box, as

shown in the figure below.

eN¥ii: Modify core - * E|
)
Awalable client tpes User Clients in eMNyM
iData Storage: Depth X
isanahzanoﬁ - ) Width |, ?Eall Page Initializati Lock Start
| ient Type Client Name o Ord Add
ther) | stat | End L 2t
Pages arl n
= 1 e Data Storage pragrarm EBE3E = 8 a a 511 N#A L]
Uzage Statistics
Awvalable Pages: 2032
Used Pages: 12
Fiee Pages: 1520
Optimize ok Cancel
Ready

Figure 122 - eNVM Configuration Dialog Box
The example design shown in the figure above already has a Data Storage Client.
2. Double-click the Data Storage Client to open the Modify Data Storage Client dialog box, as shown
in the figure below.
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Figure 123 - Modify Data Storage Client Dialog Box - Use as ROM Selected

todify Data Storage Client [‘S_<

Client name: | program |

el

Content:

O Memory File: |

Farmat:

(%) Mo content: {client is a placeholder)

Start address: 0

Size of word:

mI
I

bits
Murnber of words: 65536 {decimal}
Use as ROM
I Ok l ’ Cancel ]
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Click Use as ROM (as shown in the figure above) to configure the memory region as a ROM and
include the eNVM digest calculations.

Click OK in the Modify Data Storage Client dialog box to continue.

Double-click Serialization to open the Add Serialization Client dialog box (as shown in the figure
below) and reserve a client for serialization. Add your Client name and eNVM Start address and
Number of pages, as appropriate. You can configure the content of your serialization client in the
Serialization Client Editor, available from the Update eNVM Memory Content dialog box.

Add Serialization Client

i

Client name: ! ser_client| |
[ |

el (reserve memory)

Start address;

Mumber of pages (128 bytes per page); 1 |

« ] |

Cancel

Enable Data Security

Figure 124 - Add Serialization Client Dialog Box

Click OK in the Add Serialization Client dialog box to continue.
Click OK in the eNVM Configuration dialog box to return to the MSS.

The Data Security Configuration controls which masters have access to which memory region within the
MSS. To configure your data security:
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Double-click the Security block in the MSS to open the MSS Security Policies Configurator, as shown in
the figure below.

| MSS Security Palicies Configurator @@

MasterfSlave MSS to Fabric Memoty Map Configuration Registers

Master to Slaves ReadfWrite Access

Shaw Special + AHEZAHE
Sectors Imss]
ESRAMD eSRAML shiYMO [M52] FIC_0 DDR. Bridge
[rs0] [ms1] [Mz4] [Mse]
IC Bus [MM0 R R R - -

L) Read Read Read Read
D-BUS [MM1] R White R/ ke R White - - Wirite
SBUS[MMZ]  RW R R R
FIC_0 [MM4 R R R R R

0 [rma] Read Read Read Read
FIC_1 [MMS] Rt wirlte RW irite Rt wirlte R Retaf Wirite
HPOMA [MIM3] R R R R

ITE Read Read Read Read
MAC_M[MMa] R White R/ Write = White R = Write
FOMA[MMZ]  RW R R R R
USE [MME] R R - R R

To protect these advanced security bits with user pass key 1, you must configure the Security Policy Manager, specify user key set 1, and program the security
feature.

If the security programming feature is enabled for programming, then you must reprogram the security features if you modify the advanced security bits

o

Figure 125 - MSS Security Policies Configurator

Masters are listed on the left, and slaves are shown at the top. All masters have access to all slaves by
default; click to enable or disable Read/Write access for specific masters and slaves.

Restrict your master/slave Read/Write access according to your preference and click OK to continue.

Note: SPI file programming for Auto Programming, Auto Update (IAP), Programming Recovery, and IAP/ISP
Services currently can only program security once with the master file. Update files cannot update the
security settings. In addition, Programming Recovery, Silicon Signature, Firewall, and Tamper Macro can
only be programmed with the master file and cannot be updated.

Generate Bitstream - SmartFusion2, IGLOO2, and RTG4

Generates the bitstream for use with the Run PROGRAM Action tool.

The tool incorporates the Fabric design, eNVM configuration (if configured) and security settings (if
configured) to generate the bitstream file. You need to configure the bitstream before you generate the
bitstream. Right-click Generate Bitstream and choose Configure Options to open the Configure Bitstream
dialog box to select which components you wish to program. Only features that have been added to your
design are available for programming. For example, you cannot select eNVM for programming if you do not
have an eNVM in your design.

Modifications to the Fabric design, eNVM configuration, or security settings will invalidate this tool and
require regeneration of the bitstream file.

The Fabric programming data will only be regenerated if you make changes to the Fabric design, such as in
the Create Design, Create Constraints and Implement Design sections of the Design Flow window.

When the process is complete a green check appears next to the operation in the Design Flow window (as
shown in the figure below) and information messages appear in the Log window.
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74 ?I,:; Place and Route
4 » Edit Constraints
*= /O Constraints
(b Timing Constraints
E:' Floorplan Constraints
P Verify Post Layout Implementation
# Edit Design Hardware Configuration
» Configure Security and Programming Options
4 » Program Design
BB Generate Bitstream
®% Run PROGRAM Action

<

Figure 126 - Generate Bitstream (Complete)

See also
Configure Bitstream Dialog Box

Edit Design Hardware Configuration - Device I/O States During Programming

You can configure your FPGA 1/Os while the device is being programmed using Device I/O States During
Programming.

In the Design Flow window, expand Edit Design Hardware Configuration and double-click Device I/O
States During Programming.

The Device I/O States During Programming dialog box appears.

Click a value in the 1/0 State (Output Only) column to set your I/0O State options according to your
preference, as shown in the figure below.

Specify I/0 States During Programming g|
[ Laad From file. .. ] [ Save tofile... ] [[I5how BSR Details
A~
Port Hame Macro Cell Pin Humber 1/0 State [Output Only])
ARST_N ADLIB:INBUF k23 zZ .v
CLK ADLIB:INBUF AE2T 1
CLK_D ADLIB:INBUF T4 a
Laszt Kniown State
CLR ADLIB:INBUF A28
D ADLIB:INBUF AF25 d
2} ADLIB:OUTBUF AG2T d
a_0 ADLIB:OUTBUF AR2T d
RADDR[0] ADLIB:INBUF K25 d
RADDR[1] ADLIB:INBUF F30 d
RADDR[2] ADLIB:INBUF L23 d
WADDR[O] ADLIB:INBUF k24 d
WADDR[1] ADLIB:INBUF J26 d
WaDDR[2] ADLIB:INBUF H26 d
WD[0] ADLIB:INBUF Gao d
WEN ADLIB:INBUF Ha7 d
UMUSED UMUSED A27 d
UMUSED UMUSED AH2T d
UMUSED UMUSED )26 d 2
Ok ] [ Cancel

Figure 127 - Set I/O State
Bitstream Configuration

Expand Configure Security and Programming Options and double-click Bitstream Configuration to open the
Bitstream Configuration dialog box, as shown in the figure below.
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" | Configure Bitstream [ 2]

Progranm

pdated components only

@ Selected components

<O

\W| Fabric

Help - L OK ] | Cancel

Figure 128 - Configure Bitstream Dialog Box

You can program your Security, Fabric, eNVM or any combination.

Features (Security, Fabric, eNVM) are enabled for programming by default when you add them to your
design. If you manually disable a feature in this dialog box then you must re-enable it here if you want it
included during programming.

Update eNVM Memory Content (SmartFusion2 and IGLOO2)

Right-click Update eNVM Memory Content and choose Configure Options (eNVM Memory Content >
Configure Options) or double-click Update eNVM Memory Content to open the dialog box and modify
your eNVM content.

The Update eNVM Memory Content dialog box enables you to update your eNVM content for programming
without having to rerun Compile and Place and Route. It is useful if you have reserved space in the eNVM
configurator within the MSS for firmware development, for example. Use the Update eNVM Memory Content
dialog box when you have completed your firmware development and wish to incorporate your updated
firmware image file into the project.

Note: To disable a client for programming, you must modify the client and select “No Content (Client is a
placeholder and will not be programmed)”. The content from the memory file, serialization data file, or auto-
incremented serialization content will be preserved if you later decide to enable this client for programming.
Clients disabled for programming will not be included in the generated bitstream and will not be
programmed.
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Modify Data Storage Client

Double-click the Storage Client to open the Modify Data Storage Client dialog box.

Note: You cannot add, delete or rename a data storage client in the Modify Data Storage Client dialog box.
To make these changes, go to the eNVM configurator inside the MSS/HPMS Configurator or navigate to the
System Builder's Memory page (eNVM tab).

= " Loy IRl
| # | Modify Data Storage Client X
Chent name: my_data
MM

Content:

Memaory file:

Format: | Intel-Hex b
Use absolute addressing a
@ Content filled with 0s
Mo Content { Client is 2 placeholder and will not be programmed )

Start address: ox 0 s

Size of word: Bits

Number of Words: 512 {Decimal )
luseasroMm

[ Uze Content for Simulation

Help [TI[ Cancel

Figure 129 - Modify Data Storage Client Dialog Box
You have three options to specify the eNVM content:
e Import a Memory File
¢ Fill eNVM content with Zero's

e Assign No Content (eNVM as a Placeholder). The client will not be included in the programming
bitstream and will not be programmed

If you have completed Place and Route and you import a memory file for the eNVM content, you do not
have to rerun Compile or Place and Route. You can program or export your programming file directly.
Programming will generate a new programming file that includes your updated eNVM content.

You can also specify the start address where the data for that client starts, the word size and the number of
words to reserve for the data storage client.

Modify Serialization Client

Double-click the Serialization Client to open the Modify Serialization Client dialog box.
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Note: You cannot add, delete or rename a Serialization Client in the Modify Serialization Client dialog box.
Go to the eNVM configurator inside the MSS/HPMS Configurator or the System Builder Memory page
(eNVM tab) to make these changes.

1| Modify Serialization Client 7 _
Client name ]
e
Conftent
Content from file:

| @ Content auto incremented:
StartValue: Ox 0O StepValue: Ox 20 Madmum Vakee: Ox 20
Mo content (| Clent is a placeholder and will not be programmed )

Start address: 200 + (Hexadeomal )
Mumber of pages: 15 { 128 bytes per page )
Maximum devices to program: 20 { Decimal )

Figure 130 - Modify Serialization Client Dialog Box
You have three options to specify the eNVM content:
e Import a Memory File
¢ Increment values automatically
e Assign No Content (eNVM as a Placeholder). The client will not be included in the programming
bitstream and will not be programmed

If you have completed Place and Route and you import a memory file for the eNVM content, you do not
have to rerun Compile or Place and Route. You can program or export your programming file directly.
Programming will generate a new programming file that includes your updated eNVM content.

You can also specify the start address where the data for the Serialization Client starts, the number of pages
and the maximum number of devices you want to program serialization data into.

Setting a maximum number of devices to program for Serialization clients will generate a programming
bitstream file that has serialization content for the number of devices specified. The maximum number of
devices to program must match for all serialization clients. If the user would like to program a subset of the
devices during production programming, this can be done within the FlashPro Express tool, which allows
you to select a range of indices desired for programming for that serialization programming job session.
Refer to the FlashPro Express User's Guide for more information.

Program Design - Run PROGRAM Action

Expand Program Design and double-click Run PROGRAM Action to program your device with default
settings, as shown in the figure below.
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Tool -
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@ Configure Bitstream
v @ Generate Bitstream
i W% Run PROGRAM Action
4 » DebugDesign
:£3 Identify Debug Design -

Figure 131 - Program Device in the Design Flow Window
Right-click Run PROGRAM Action and choose from the following menu options:
e Clean and Run All - Cleans all tools, deletes all reports and output files and runs through
programming. All logs will be updated with new files.
e Clean - deletes only reports and output files associated with this tool; the other tool files and reports
are unaffected.

e Configure Actions/Procedures - Enables you to set the specific Action you wish to program. Select
your programming action from the dropdown menu.

Handoff Design for Production

In order to handoff your design for production you must export a programming file or generate a BSDL file.

See the Export Bitstream - SmartFusion2, IGLOO2, and RTG4 topic for complete instructions on how to
handoff your design for production.

You can also export your programming job.

Export BSDL File

Double-click Export BSDL File to generate a BSDL file for your project.

Right-click Export BSDL File and choose Clean and Run All to remove all data and output from tools run
previously and rerun the Design Flow up through this point.

Generate FPGA Array Data
The Generate FPGA Array Data tool generates database files used in downstream tools:
e *.db used for debugging FPGA Fabric in SmartDebug
e *map and *.dca files used for Programming

Right-click Generate FPGA Array Data in the Design Flow window and click Run to generate FPGA Array
Data. Before running this tool, the design should have completed the Place and Route step. If not, Libero
SoC runs implicitly the upstream tools (Synthesis, Compile Netlist, and Place and Route) before it generates
the FPGA Array Data.
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h

* Configure Hardware
I Prograrmming Connectivity and Interface
a. Configure Programmer
f&a) Device 'O States During Programming

4 » Configure Security and Programming Options

= Configure User Programming Data

m

{33 Configure Programming Recovery
& Configure Security

4 F Program Design
"’é Generate Bitstream
i Run PROGRAM Action

4 F Debug Design
i, Identify Debug Design
€ SmartDebug Design

4 | Handoff Design for Production
| Fxnort Ritstream
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-

Figure 132 - Design Flow Window — Generate FPGA Array Data

Note: Generate FPGA Array Data is the upstream tool for Export SmartDebug Data. Libero SoC implicitly
runs the Generate FPGA Array Data step (if not already completed) before it exports the SmartDebug data
files.

Update uPROM Memory Content - RTG4 Only

Use the Update uPROM Memory Content tool if you have reserved space in the uPROM Configurator and,
after Place and Route, you want to make changes to the uPROM clients. After you have updated the
uPROM Memory Content, there is no need to rerun Place and Route.

To update the uPROM Memory Content from the Design Flow Window:

1. Right-click Update uPROM Memory Content in the Design Flow window and choose Configure
Options.
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Figure 133 - Update uPROM Memory Content
2. When the uPROM Update Tool appears, right-click the Memory Client you want to update and choose

Edit.
W] UPROM Lipdate Teel (5 M
|
Sl Chii s i User dients in uPROM |

Ussge statisscs ChentMame  StartAddress  36-bitwords

Avalable memory] 36-tet words)o 10400 [i — |

Usodmemory( bt wordsl: 0 |

Free memory(Mstmends] s G900 |2 ey_cliene? I‘_ﬁ = 0
o

e

Figure 134 - uPROM Update Tool
The Edit Data Storage Client dialog box appears.
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) Content from file:
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Mumber of 36-bit words: 200

Use content for simulation

Figure 135 - Edit Data Storage Client Dialog Box
You can make the following changes to the uPROM client:
¢ Rename a Client
e Change the memory content, memory size and start address of the client
e Reverse your decision on whether or not to use Content for Simulation

Note: You cannot use the Update uPROM tool to add or delete a client. To add or delete a client, you must
use the uPROM Configurator to reconfigure your Clients and regenerate your uPROM component and your
design.

Update eNVM Memory Content (SmartFusion2 and IGLOO2)

Right-click Update eNVM Memory Content and choose Configure Options (eNVM Memory Content >
Configure Options) or double-click Update eNVM Memory Content to open the dialog box and modify
your eNVM content.

The Update eNVM Memory Content dialog box enables you to update your eNVM content for programming
without having to rerun Compile and Place and Route. It is useful if you have reserved space in the eNVM
configurator within the MSS for firmware development, for example. Use the Update eNVM Memory Content
dialog box when you have completed your firmware development and wish to incorporate your updated
firmware image file into the project.

Note: To disable a client for programming, you must modify the client and select “No Content (Client is a
placeholder and will not be programmed)”. The content from the memory file, serialization data file, or auto-
incremented serialization content will be preserved if you later decide to enable this client for programming.
Clients disabled for programming will not be included in the generated bitstream and will not be
programmed.

Modify Data Storage Client
Double-click the Storage Client to open the Modify Data Storage Client dialog box.
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Note: You cannot add, delete or rename a data storage client in the Modify Data Storage Client dialog box.

To make these changes, go to the eNVM configurator inside the MSS/HPMS Configurator or navigate to the
System Builder's Memory page (eNVM tab).

| 5 | Modify Data Sto age Client .Ep-i-

Chent name: my_data

| Lise absolute addressing e
@ Content filled with Os
Mo Content ( Client is a placeholder and will not be programmed )

Start address: 0x 0 s

Size of word: Bits

Mumber of Words: 512 (Decimal )
luseasrom )

[ Use Content for Simulation

Figure 136 - Modify Data Storage Client Dialog Box
You have three options to specify the eNVM content:
e Import a Memory File
¢ Fill eNVM content with Zero's

e Assign No Content (eNVM as a Placeholder). The client will not be included in the programming
bitstream and will not be programmed

If you have completed Place and Route and you import a memory file for the eNVM content, you do not
have to rerun Compile or Place and Route. You can program or export your programming file directly.
Programming will generate a new programming file that includes your updated eNVM content.

You can also specify the start address where the data for that client starts, the word size and the number of
words to reserve for the data storage client.

Modify Serialization Client
Double-click the Serialization Client to open the Modify Serialization Client dialog box.

Note: You cannot add, delete or rename a Serialization Client in the Modify Serialization Client dialog box.
Go to the eNVM configurator inside the MSS/HPMS Configurator or the System Builder Memory page
(eNVM tab) to make these changes.
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1| Modify Seralization Client

| @ Content auto incremented:
StartValue: Ox 0O StepValue: Ox 20 Madmum Vakee: Ox 20
Mo content (| Clent is a placeholder and will not be programmed )

Start address: 200 + (Hexadeomal )
Mumber of pages: 16 ( 128 bytes per page )
Maximum devices to program: 20 { Decimal )

Figure 137 - Modify Serialization Client Dialog Box
You have three options to specify the eNVM content:
e Import a Memory File
¢ Increment values automatically

e Assign No Content (eNVM as a Placeholder). The client will not be included in the programming
bitstream and will not be programmed

If you have completed Place and Route and you import a memory file for the eNVM content, you do not
have to rerun Compile or Place and Route. You can program or export your programming file directly.
Programming will generate a new programming file that includes your updated eNVM content.

You can also specify the start address where the data for the Serialization Client starts, the number of pages
and the maximum number of devices you want to program serialization data into.

Setting a maximum number of devices to program for Serialization clients will generate a programming
bitstream file that has serialization content for the number of devices specified. The maximum number of
devices to program must match for all serialization clients. If the user would like to program a subset of the
devices during production programming, this can be done within the FlashPro Express tool, which allows
you to select a range of indices desired for programming for that serialization programming job session.
Refer to the FlashPro Express User's Guide for more information.

Configure Hardware

Programming Connectivity and Interface - SmartFusion2, IGLOO2, and RTG4 Only

In the Libero SoC Design Flow window, expand Edit Design Hardware Configuration and double-click

Programming Connectivity and Interface to open the Programming Connectivity and Interface window.
The Programming Connectivity and Interface window displays the physical chain from TDI to TDO or SPI
Slave configuration.

The Programming Connectivity and Interface view enables the following actions:

e Select Programming Mode — Select JTAG or SPI Slave mode. SPI Slave mode is only supported by
FlashPro5.
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Construct Chain Automatically - Automatically construct the physical chain

Add Microsemi Device — Add a Microsemi Device to the chain

Add Non-Microsemi Device — Add a non-Microsemi Device to the chain

Add Microsemi Devices From Files — Add a Microsemi Device from a programming file
Delete Selected Device — Delete selected devices in the grid

Scan and Check Chain — Scan the physical chain connected to the programmer and check if it
matches the chain constructed in the grid

Zoom In — Zoom into the grid
Zoom Out — Zoom out of the grid

Hover Information

The device tooltip displays the following information if you hover your pointer over a device in the grid:

2700 }

Name - Editable field for a user-specified device name. If you have two or more identical devices in
your chain you can use this field to give them unique names.

Device - Device name.
File - Path to programming file.

Programming action — When a programming file is loaded, the user can select a programming action
for any device which is not the Libero design device.

IR Length - Device instruction length.

TCK - Maximum clock frequency in MHz to program a specific device; Libero uses this information to
ensure that the programmer operates at a frequency lower than the slowest device in the chain.

V250507 (2) c

T <2
k e
Marme: ImM25050T (2)
[Device: [ma2sosor |
File:

i
Programming action: i
[1r: 8
[Tk 10000000

Figure 138 - Device Information

Device Chain Details

The device within the chain has the following details:

Libero design device — Has a red circle within Microsemi logo. Libero design device cannot be
disabled.

Left/right arrow — Move device to left or right according to the physical chain.

Enable Device - Select to enable the device for programming; enabled devices are green, disabled
devices are gray.

Name - Displays your specified device name.
File - Path to programming file.
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Right-Click Properties

e Set as Libero Design Device - The user needs to set Libero design device when there are multiple
identical Libero design devices in the chain.

e Enable Device - Select to enable the device for programming; enabled devices are green, disabled
devices are gray.

e HIGH-Z - Sets disabled Microsemi SoC ProAsic3, IGLOO, Fusion, and SmartFusion devices in the
chain to HIGH-Z (tri-states all the I/Os) during chain programming of enabled Microsemi devices in the
daisy chain (Not supported for Libero SoC target design device )

e Configure Device — Ability to reconfigure the device (for a Libero SoC target device the dialog
appears but only the device name is editable)

e Load Programming File — Load programming file for selected device (Not supported for Libero SoC
target design device)

e Enable Serial - Select to enable serialization when you have loaded a serialization programming file
(not supported in software version 11.0)

e Serial Data - Opens the Serial Settings dialog box; enables you to set your serialization data.
e Select Program Procedure/Actions (Not supported for Libero SoC target design device):
e Actions - List of programming actions for your device.

e Procedures - Advanced option; enables you to customize the list of
recommended and optional procedures for the selected Action.

e Move Device Left/Right — Move device in the chain to left or right.

M25050T (2) Q

& 7DD

b Set As Libero Design Device
N s Configure Device...

Enable Device for Programming...
Load Programming File...

HIGH-Z...

Set Serial Data...

Select Program Procedure/Actions...
Move Device Right...

Figure 139 - Right-click Properties

Programmer Settings - SmartFusion2, IGLOO2, and RTG4 Only

In the Libero SoC Design Flow window, expand Edit Design Hardware Configuration and double-click
Programmer Settings to view the name, type, and port. The dialog box displays information about your
programmer if it is connected.
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Connected Programmer ﬁ

Programmer name: 30983
Programmer type: FlashPro4
Fort: ush30983 (USB 2.0)

Edit Programmer Settings...

Close

Figure 140 - Programmer Settings for Connected Programmer

Click Edit Programmer Settings to view the Programmer Settings dialog box. You can set specific voltage
and force TCK frequency values for your programmer in this dialog box.

Programmer Settings ﬁ

FlashPro | FlashPro Lite | FlashPro3 | FlashPro4

Sethp

[V]setvpn

[v]setvdd()

[¥]setVddp @25v (33w
["|Drive TRST

[]Force TCK Frequency

4 -

Default

[ ok ][ cancel ] Help

Figure 141 - Programmer Settings Dialog Box

The Programmer Settings dialog box includes setting options for FlashPro5/4/3/3X, FlashPro Lite and
FlashPro.

Set the TCK setting in your PDB/STAPL file by selecting the TCK frequency in the Programmer Settings
dialog box. TCK frequency limits by programmer:

e FlashPro supports 1-4 MHz
e FlashPro Lite is limited to 1, 2, or 4 MHz only.
e FlashPro5/4/3/3X supports 1-4 MHz.
TCK frequency limits by target device:
e SmartFusion2, IGLOO2, and RTG4 - 20MHz

During execution, the frequency set by the FREQUENCY statement in the PDB/STAPL file overrides the
TCK frequency setting selected by you in the Programmer Settings dialog box unless you also select the
Force TCK Frequency checkbox.

FlashPro Programmer Settings

Choose your programmer settings for FlashPro (see the above figure). If you choose to add the Force TCK
Frequency, select the appropriate MHz frequency. After you have made your selection(s), click OK.

Default Settings

e The Vpp, Vpn, Vdd(l), and Vddp options are checked (Vddp is set to 2.5V) to instruct the FlashPro
programmer(s) to supply Vpp, Vpn, Vdd(l) and Vddp.
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e The Driver TRST option is unchecked to instruct the FlashPro programmer(s) NOT to drive the TRST
pin.

e The Force TCK Frequency option is unchecked to instruct FlashPro to use the TCK frequency
specified by the Frequency statement in the STAPL file(s).

FlashPro Lite Programmer Settings

If you choose to add the Force TCK Frequency, select the appropriate MHz frequency. After you have made
your selection(s), click OK.

Default Settings

e The Vpp and Vpn options are checked to instruct the FlashPro Lite programmer(s) to supply Vpp and
Vpn.

e The Driver TRST option is unchecked to instruct the FlashPro Lite programmer(s) NOT to drive the
TRST pin.

e The Force TCK Frequency option is unchecked to instruct the FlashPro Lite to use the TCK frequency
specified by the Frequency statement in the STAPL file(s).

FlashPro5/4/3/3X Programmer Settings

For FlashPro5/4/3/3X, you can choose the Set Vpump setting or the Force TCK Frequency. If you choose
the Force TCK Frequency, select the appropriate MHz frequency. For FlashPro4/3X settings, you can switch
the TCK mode between Free running clock and Discrete clocking. After you have made your selections(s),
click OK.

Default Settings

e The Vpump option is checked to instruct the FlashPro5/4/3/3X programmer(s) to supply Vpump to the
device.

e The Force TCK Frequency option is unchecked to instruct the FlashPro5/4/3/3X to use the TCK
frequency specified by the Frequency statement in the PDB/STAPL file(s).

e FlashPro5/4/3/3X default TCK mode setting is Free running clock.

Device I/O States During Programming

In the Libero SoC Design Flow window expand Edit Design Hardware Configuration and double-click
Device I/O states during programming to specify the 1/O states prior to programming. In Libero SoC, this
feature is only available once Layout is completed.

The default state for all I/Os is Tri-state.

To specify I/0 statues during programming:

1. Sort the pins as desired by clicking any of the column headers to sort the entries by that header.
Select the I/Os you wish to modify (as shown in the figure below).

2. Setthe I/O Output state. You can set Basic 1/O settings if you want to use the default 1/0O settings for
your pins, or use Custom 1/O settings to customize the settings for each pin. See the Specifying I/O
States During Programming - I/O States and BSR Details help topic for more information on setting
your 1/O state and the corresponding pin values. Basic I/O state settings are:

e 1-1/O is set to drive out logic High
e 0-1I/O is set to drive out logic Low

e Last Known State: I/O is set to the last value that was driven out prior to entering the

programming mode, and then held at that value during programming

e 7 -Tri-State: I/O is tristated
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Specify I/0 States During Programming
Load from file. .. Save ko file... [™ show BSR Details
Port Hame Macro Cell Pin Humber 1/0 State [Output Only) j
BIST ADLIB:INBUF T2 1
BvPASS_I0 ADLIB:INBUF K1 1
CLK ADLIB:INBUF B1 1
ENOUT ADLIB:INBUF J16 1
LED ADLIB:OUTBUF M3 a
MONITOR[O] ADLIB:OUTBUF ES a
MOMITOR[] ADLIB:OUTBUF c7 d
MOMITOR[Z] ADLIB:OUTBUF k] d
MONITOR[3] ADLIB:OUTBUF D7 d
MONITOR[4] ADLIB:OUTBUF A1 d
OEa ADLIB:INBUF E4 d
OEb ADLIB:INBUF F1 d
O5C_EN ADLIB:INBUF K3 d
PAD[10] ADLIB:BIBUF_LYCMOS33U ME d
PAD[11] ADLIB:BIBUF_LYCMOS33D R? d
PAD[12] ADLIB:BIBUF_LYCMOS33U D11 d
PAD[13] ADLIB:BIBUF_LYCMOS33D c12 d
PAD[14] ADLIB:BIBUF_LYCMOS33U RE d LI
Help | OF I Cancel |

Figure 142 - 1/O States During Programming Window
6. Click OK to save your settings.

Note: 1/O States During programming will be used during programming or when exporting the
bitstream.

Configure Security and Programming Options

Configure User Programming Data
Sets your Design Version and Silicon Signature.
Design name is a read-only field that identifies your design.

Design Version (number between 0 and 65535) - Specifies the design version to be programmed to the
device. This field is also used for Back-level protection in Update Policy of the Security Policy Manager and
in Enable Auto Update in the Programming Recovery tool.

Silicon signature (max length is 8 HEX chars) - 32-bit user configurable silicon signature to be
programmed into the device. This field can be read from the device using the JTAG (IEEE 1149-1)
USERCODE instruction or by running the DEVICE INFO programming action.

| Configure User Programming Data &

Design name: sdl

Design version ( number between 0 and 65535): 2|

Silicon signature (max length is 8 HEX chars):

' Help OK l Cancel

Figure 143 - Configure User Programming Data Dialog Box
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Notes:
Programming Recovery cannot be updated with _UEK1 or _UEK2 programming files. Only the master
programming file can be used.
SPI file programming for Auto Programming, Auto Update (IAP), Programming Recovery, and IAP/ISP
Services currently can only program security once with the master file. Update files cannot update the
security settings. In addition, Programming Recovery, Silicon Signature, Firewall, and Tamper Macro can
only be programmed with the master file and cannot be updated.

Configure Programming Bitstream Settings (RTG4 Only)
From the Design Flow window, double-click Configure Programming Bitstream Settings or right-click
and choose Configure Options.

Tool
l:) Timing Constraints
%‘ Floorplan Constraints
# F Implement Design
= Synthesize
4 F Verity Post-Synthesis Implementation
B simulate
3 Compile
P Place and Route
4 F [Edit Constraints
= 1'0 Constraints
l‘:} Timing Constraints
E_' Floorplan Constraints
4 F Verify Post Layout Implementation
+L| Generate Back Annotated Files
B simulate
ﬂb_ Verify Timing
« ¥ Edit Design Hardware Configuration
B3l Device 1/0 States During Programming
I+l Programming Connectivity and Interface
& Programmer Settings
# F Configure Programming Oplions
,'t’.:?..??'.'!f.i.ﬂ.‘-."'.!:.!-!?:."—E.PE':!H.F!.'.'!'}.’.'.'.'.'.'."!H..D.’.‘F e e e e s
ﬁ Configure Programming Bitstream Settings il
4 F Program Design [
¥ Generate Bitstream
B Run PROGRAM Action
4 F Debug Design
& SrartDebug Design
4 F Handoff Design for Production
$€| Export Bitstream
+__n: Export Programming Job
=L | Export Pin Report |
*T] Export BSDL -

Design Fiow | Design Hierarchy | Stmulus Hierarchy | Catalog | Files |

Figure 144 - Configure Programming Bitstream Settings - Configure Options
The Programming Bitstream Settings dialog box appears for you to configure the Bitstream Settings.

208

Libero SoC User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error

when clicked. View the online help included with software to enable all linked content.

(=

E Programming Bitstream Settings

& Microsemi

Program and Debug

=)
Enable System Controller Suspend mode

Dizable JTAG interface

Dizable SPI interface
Disable Fabric Erase\Write fverify
Disable Probe Read/\Write

Disable Digest Check

Selected device options:

- System Controller Suspend mode is enabled and Fabric Erase Mirite Verify and TTAG interface are
dizabled when TRSTE is low during device power up, The uzer can exit System Controller Suspend
Mode and enable JTAG interface and Fabric Erase MiriteVerify by driving TRSTB high during device
pOWEr up.

- Disable Probe Read\Mirite,

- Disable all fabric reads, such as verify digest, read digest, or reading design information or
programming infarmation in DEVICE_INFQ.

o) oo ]

Figure 145 - Programming Bitstream Settings Dialog Box

Bitstream Settings

Enable System Controller Suspend Mode — Check this box to enable System Controller Suspend Mode

when TRSTB is low during device power up. You can exit System Controller Suspend Mode by driving

TRSTB high during device power up. By default, this selection is not checked.

Note: By default, when this options is selected, the JTAG interface will be disabled to ensure
proper hardening during System Controller Suspend Mode.

Disable JTAG Interface — Check this box to disable the JTAG interface when TRSTB is low during device

power up. You can enable the JTAG interface by driving TRSTB high during device power up. By default,

this selection is not checked.

Disable SPI Interface — Check this box to disable the SPI interface when TRSTB is low during device

power up. You can enable the SPI interface by driving TRSTB high during device power up. By default, this

selection is not checked.

Note: For this option to be available, you must reserve pins for SPI in the project settings of the
Libero project.

Note: If SPI and JTAG interface are disabled, the following settings will all be disabled for
selection.
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Disable Fabric Erase/Write/Verify - Check this box to disable Fabric Erase/Write/Verify when TRSTB is
low during device power up. You can enable Fabric Erase/Write/Verify by driving TRSTB high during device
power up. By default, this selection is not checked.

Disable Probe Read/Write — Check this box to disable Probe Read/Write when TRSTB is low during device
power up. You can enable Probe Read/Write by driving TRSTB high during device power up. By default, this
selection is not checked.

Note: For this option to be available, you must reserve pins for Probe in the project settings of the
Libero project.

Disable Digest Check — Check this box to disable all Fabric reads, such as verify digest, read digest, or
reading design or programming information in DEVICE_INFO when TRSTB is low during device power up.
You can enable Digest Check by driving TRSTB high during device power up.

Reset to default — Click to reset the Bitstream Settings to the default values.

Selected device options: This section provides a summary of the settings configured and informs the user
about the expected behavior of the device.

Configure Programming Recovery

The Programming Recovery dialog box enables you to set your Auto Update and Programming Recovery
options for programming.
Auto Update takes place during power-up and compares your Update SPI image Design Version against the
Design Version programmed in the device. It performs Auto Update programming on your SPI update Image
if:

e The device has been programmed AND

e The Update SPI image Design Version is greater than the Design Version on the device

Auto Recovery enables the device to automatically reprogram itself if there is a power failure during
programming.

Design version - The Design Version used for Auto Update Programming or for Backlevel protection within
the SPM update policy. This is a read-only field that must be configured within the tool Configure User
Programming Data.

Enable Auto Update - Click the checkbox to auto update the SPI update image at power up. Auto-update
occurs only when the SPI update image Design Version is greater than the Design Version already on the
device. When enabling Auto Update, Programming Recovery must also be enabled and this checkbox will
be disabled.

Enable Programming Recovery - Click the checkbox to enable programming recovery in the event of a
power failure during programming.

SPI clock frequency - Sets your SPI clock frequency. SPI is a full duplex, four-wire synchronous transfer
protocol that supports programmable clock polarity (SPO) and clock phase (SPH).The state of SPO and
SPH control bits decides the data transfer modes. See the SmartFusion2 Microcontroller Subsystem User's
Guide or the IGLOO2 High Performance Memory Subsystem User's Guide for more information.

SPI data transfer mode - Sets your SPI data transfer mode for SPO and SPH. The SPO control bit
determines the polarity of the clock and SPS defines the slave select behavior. SPS is hardcoded to b’'l and
cannot be changed. The SPH control bit determines the clock edge that captures the data. See the
SmartFusion2 Microcontroller Subsystem User's Guide or the IGLOO2 High Performance Memory
Subsystem User's Guide for more information.

Notes:

Programming Recovery cannot be updated with _UEK1 or _UEK2 programming files. Only the master
programming file can be used.

SPI file programming for Auto Programming, Auto Update (IAP), Programming Recovery, and IAP/ISP
Services currently can only program security once with the master file. Update files cannot update the
security settings. In addition, Programming Recovery, Silicon Signature, Firewall, and Tamper Macro can
only be programmed with the master file and cannot be updated.
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# | Configure Programming Recovery i

e Design version: 10
V| Enable Auto Update

Enable Programming Recovery

SPI clock frequency: |25.00 ¥ | MHz

SPI data transfer mode

SPS: 1 SPO: SPH:

o) (o

Figure 146 - Configure Programming Recovery Dialog Box
SPM - If Update Policy is enabled and Fabric/eNVM update are protected by UPK1:

Fabric update is disabled for Auto Programming, IAP/ISP services, Programming Recovery and Auto
update. FlashLock/UPKZ1 unlocking is only available for JTAG and SPI slave programming.

eNVM update is disabled for Auto Programming, IAP/ISP Services, Programming Recovery and Auto
Update. FlashLock/UPK1 unlocking is only available for JTAG and SPI Slave programming.

.

ﬁ Design version: 1

# | Configure Programming Recovery
ﬁ Enable Auto Update

Auto Programming is disabled for update in the Configure Security tool,

which prevents you from being able to perform Programming Recovery and Auto Update.
If Programming Recovery and Auto Update are desired,

then you should allow Auto Programming for updates.

SPS: SPO: v SPH: v
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Security Features Frequently Asked Questions

The following Frequently Asked Questions address the most common queries related to managing and
programming SmartFusion2 and IGLOO2 Security Features.

I have configured the Security Policy Manager and enabled security in my design but | do not want to
program my design with the Security Policy Manager features enabled. What do | do?

Go to Configure Bitstream and un-check Security.
What is programmed when | click Program Device?

All features configured in your design and enabled in the Configure Bitstream tool. Any features you have
configured (such as eNVM or Security) are enabled for programming by default.

When | click Program Device is the programming file encrypted?

All programming files are encrypted. To generate programming files encrypted with UEK1 or UEK2 you must
generate them from Export Bitstream for field updates.

Note: Once security is programmed, you must erase the security before attempting to reprogram
the security.
How do | generate encrypted programming files with User Encryption Key 1/2?
e Configure the Security Policy Manager and specify a User Key Set 1 and User Key Set 2 (User Key
Set 2 is available if you select Field Update Broadcast mode). Ensure the Security programming

feature is enabled in Configure Bitstream; it is enabled by default once you configure the Security
Policy Manager.

e Export Bitstream from Handoff Design for Production - <filename>_uek1.(stp/svf/spi/dat) and
<filename>_uek?2.(stp/svf/spi/dat) files are encrypted with UEK1 and UEK2 respectively. See Security
Programming File Descriptions below for more information on programming files.

What are Security Programming Files?
See the Security Programming Files topic for more information.

Security Programming Files
Export Bitstream (expand Handoff Design for Production in the Design Flow window) creates the following
files:

<filename>_master.(stp/svf/spi/dat) - Created when Enable custom security options is specified in the
Security Policy Manager. This is the master programming file; it includes all programming features enabled,
User Key Set 1, User Key Set 2 (optionally if specified), and your security policy settings.

<filename>_security_only_master.(stp/svf/spi/dat) — Created when Enable custom security options is
specified in the Security Policy Manager. Master security programming file; includes User Key Set 1, User
Key Set 2 (optionally if specified), and your security policy settings.

<filename>_uek1.(stp/svf/spi/dat) — Programming file encrypted with User Encryption Key 1 used for field
updates; includes all your features for programming except security .

<filename>_uek2.(stp/svf/spi/dat) — Programming file encrypted with User Encryption Key 2 used for field
updates; includes all your features for programming except security.

Configure Security

Security Policy Manager (SPM)

Expand Configure Security and Programming Options, double-click Configure Security to customize
the security settings in your design.

Use this dialog box to set your User Keys, Security Policies and Microsemi factory test mode access level.

Note: Microsemi enabled default bitstream encryption key modes are disabled after user security is
programmed.
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i Security Policy Manager
Security key mode Security policies
Bitstream encryption with default key [ Update Polkcy. . ] Fluse
@) Enable custom security options Db Bobey =
[ Key Mode Policy... | Fluse

User keys and Security policies protection Microsemi factory test mode access level

@ ‘Write-protect using FlashLodkUPK1 Allows Factory test mode sccess

& Protect Factory test mode access using FlashLockiUPKL
Permanently write-protect
Permanently protect Factory test mode access

User Key Set 1

Flashlock/UPK] (64 HEX chars): Ox  B470C4272TF4F04408 147162Ck SE6F21ICFMZ2CIAE ﬁ)
UEK1 (User Encryption Key 1) (64 HEX chars): Ox  ZF1S4CIEFZ19A1EASSE209SDEFCII02SCEBCIFIBSASEEDESSFSEZEDITZEL0190 W
] User Key Set 2

UPK2 (User Pass Key 2) (64 HEX chars): Ox  529AFTFSB4B2RO77C1 237267034 350053 STES6BI0EECEIS0 1F3ASI65696736 =
UEKZ (User Encryption Key 2) (64 HEX chars): Ox  B37AB7EZFC413A3480FS6397 78D 1EBTC17ACT 70BDECEGEDSTEECET 1664800063 W

Selected Security options:

User keys and Security Policies protection
Protect UEK1, UEK2, DPK and Security Policies using FlashLock/UPK1.
Disable Factory enabled default bstream encryption key modes
Microsemi factory test mode access level
Protect Microsemi factory test mode access wsing FlashLock/UPK1.

Figure 147 - Security Policy Manager Dialog Box
Security Key Mode

Bitstream encryption with default key - Encrypt bitstream files with Microsemi default key (pre-placed key
in silicon). When this option is selected, user keys, security and Microsemi factory test mode access level
configurations are disabled.

Enable custom security options - Enables you to set User Keys, Security Policies and Microsemi factory
test mode access level (see below for a description).

User keys and Security policies protection

Write-protect using FlashLock/UPK1 - Protect UEK1 (User Encryption Key 1), DPK (Debug Pass Key)
and Security Policies using FlashLock/ UPK1.

Note: UEK2 (User Encryption Key?) is protected by UPK2 (User Pass Key 2).

Permanently write-protect - Permanently protect UEK1 (User Encryption Key 1), UPK2 (User Pass Key 2),
UEK?2 (User Encryption Key 2), DPK (Debug Pass Key), Security Policies, and Microsemi factory test mode
access level. This setting, once programmed will not be modified in the device. Microsemi enabled default
bitstream encryption key modes are permanently disabled as well.

Note: When this option is selected, you cannot specify the FlashLock/UPK 1 and UPK2 (User Pass Key 2)
value, since the value cannot be used to unlock the corresponding protected features.

Microsemi Factory Test Mode Access Level

Protect factory test mode access using FlashLock/UPK1 - Protects access to Microsemi factory test
mode using Flashlock/ UPK1.

Permanently protect factory test mode access - Permanently locks access to Microsemi factory test
mode.

Note: When this option is selected, User Key Set 2 is permanently write-protected. Once programmed, User
Key Set 2 cannot be changed in the device. You can specify UEK2 (User Encryption Key 2). However, you
cannot specify UPK2 (User Pass Key 2), since the value cannot be used to unlock User Key Set 2.

Allow factory test mode access - Allows access to Microsemi factory test mode.
Security Policies

Update Policy - Sets your Fabric, eNVM and Back Level protections. See the Update Policy topic for more
information.

Note: If Update Policy is enabled and Fabric/eNVM update are protected by UPK1:

Fabric update is disabled for Auto Programming, IAP/ISP services, Programming Recovery and Auto
update. FlashLock/UPK1 unloading is only available for JTAG and SPI slave programming.
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eNVM update is disabled for Auto Programming, IAP/ISP Services, Programming Recovery and Auto
Update. FlashLock/UPKZ1 unlocking is only available for JTAG and SPI Slave programming.

See the following example.

B | Security Policy Manager @ |
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Lier Ky Set 2
= 2]
e
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Fabric update & dsabled for Aute Prograsming, L TSP Services, Programming Recovery and Aulo Lipdate. FashlackUPY | unfockirg s only avaldable for TTAS and SF] Slave programming.

&MV update & dsabled for Autn Programming, TARTSP Services, Programming Recovery and Autn Updabe, FlashlodgUPs | uniodang 5 onfy avalable for STAG and 551 Save prograsming

g o Cancel

Debug Policy - Enables and sets your Debug Pass Key and debug options. See the Debug Policy topic for
more information.
Key Mode Policy - Configures the key mode to enable or disable. See the Key Mode Policy topic for more
information.

Configuring User Keys
User Key Set 1 is required. User Key Set 1 includes FlashLock/UPK1 (User Pass Key 1) and UEK1 (User
Encryption Key 1).
User Key Set 2 is optional. User Key Set 2 includes UPK2 (User Pass Key 2) and UEK2 (User Encryption
Key 2).
Note that User Pass Key 2 (UPK2) protects only User Encryption Key 2 (UEK?2).

Update Policy

This dialog box enables you to specify components that can be updated in the field, and their field-update
protection parameters.
Choose your protection options from the drop-down menus; click the appropriate checkbox to set your
programming protection preferences.

Fabric update protection

e Use FlashLock/UPK1 to unlock Erase/Write/Verify operations- Select this option to require UPK1
to erase, write, or verify the Fabric.

Note: Fabric update is disabled for Auto Programming, IAP/ISP services, Programming Recovery and Auto
update. FlashLock/UPK1 unlocking is only available for JTAG and SPI slave.

e Updates allowed using UEK1 or UEK2; FlashLock/UPK1 is not required for updates - Encrypted
update is allowed with either UEK1 or UEK?2 (if enabled).

eNVM update protection
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e Use FlashLock/UPK1 to unlock Write/Verify/Read operations- Select this option to require UPK1 to
write, verify or read to the eNVM.
Note: eNVM update is disabled for Auto Programming, IAP/ISP Services, Programming Recovery and Auto
Update. FlashLock/UPKZ1 unlocking is only available for JTAG and SPI Slave programming.
e Updates allowed using UEK1 or UEK2; Flashlock/UPK1 is not required for updates - Encrypted
update is allowed with either UEK1 or UEK?2 (if enabled).
Back Level protection - When enabled, a design being loaded must be of a version higher than the Back
Level version value in the programmed device.

e Back Level Protection- Limits the design versions that the device can update. Only programming
bitstreams with Designer Version greater than the Back Level version are allowed for programming.

e Design version - Displays the current Design version (set in the Configure User Programming Data
tool). Back level uses the Design version value to determine which bitstreams are allowed for
programming.

e Back Level Bypass - If selected, design is programmed irrespective of Back Level version.

Note: Back Level Bypass should be set if you allow programming recover with recovery image lower than
the Back Level version selected. Alternatively, you should update the design version of the recovery image
so that it is always greater than the Back Level version. (Refer to the Configure Programming Recovery
section for details.)

Disable access to the following programming interfaces:

These settings protect the following programming interfaces:
e Auto Programming
e |AP/ISP services
e JTAG (use FlashLock to/UPK1 to unlock)
e SPI Slave (use FlashLock/UPK1 to unlock)

For more technical information on the Protect Programming Interface with Pass Key option see the
SmartFusion2 Programming User's Guide.

Note that when the Permanently write-protect option is selected for User keys and Security policies
protection in SPM, the dialog box informs you of features that are no longer reprogrammabile. In this case, if
Use FlashLock/UPK1 to unlock option is selected for Fabric/eNVM update protection then Fabric/eNVM will
be One Time Programmable.
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5| Update Policy @

Fabric update protection:

[Use FlashLock/UPK1 to unlock EraseWrite/Verify operations = ]
eNvM update protection:
[Use FlashLock/UPK1 ko unlock Write/verify/Read operations = ]

Back Level protection

0 Design version (number between 0 and 65535):

=rsion {number between 0 and 65535):

Back Level Bypass
Disable access to the Following programming interfaces:
Auto Programming
| IARJISP Services
| ITAG {use FlashLockfUPK1 ko unlock)
| SPI Slave (use FlashLockfUPK1 ta unlack)
Disable access to the Following programeming Features:

- Fabric {use FlashLock{UPK1 to unlock ErasefWrite/Verify)
- elvM (use FlashLockfUPK1 to unlock Write/verify/Read)

i OK I [ Cancel

Figure 148 - Update Policy Dialog Box

Debug Security Policy

Debug access to the embedded systems can be controlled via the customer Debug Policy.
Protect Embedded Debug with DPK (Debug Pass Key)
Restrict UJTAG access - Restricts access to UJTAG; DPK is required for access.

Restrict Cortex M3 debug (SmartFusion2 Only) - Restricts Cortex M3 debug/SoftConsole use; DPK is
required for debug.

SmartDebug access control
Access control available during debug mode.

Full Access (No restrictions to SmartDebug architecture; DPK is not required)- Enables full debug
access to eNVM, uSRAM, LSRAM, eSRAMO/1, DDRAM and Fabric probing.

No debug (Restrict read/write access to SmartDebug architecture; DPK is required for read/write
access) - Blocks all debug access to eNVM, uSRAM, LSRAM, eSRAMO0/1, DDRAM and Fabric probing.

DPK (Debug Pass Key) (length is 64 HEX characters)
Specify a Debug Pass Key to unlock features protected by DPK.

216 Libero SoC User's Guide



NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

Program and Debug

Restrict external Fabric/eNVM design digest check request via JTAG and SPI. Use FlashLock/UPK1
to allow digest check. - Protects design digest check request with FlashLock/UPK1.

Disable debug access through JTAG (1149.1). Use FlashLock/UPK1 to allow access. - Disables JTAG

(1149.1) test instructions.

5
5| Debug Security Polic [ﬁ
Dt Sty Foey aa e - - . —
Protect Embedded Debug with DPK {(Debug Pass Key)
D Restrict UTTAG access
[ Restrict Cortex M3 debug
SmartDebug access control:
[FuII access (Mo restrictions to SmartDebug architecture; DPK is not reguired) -
DPK {Debug Pass Key) (64 HEX chars)
o
|| Restrict external Fabric/eNVM design digest check request via JTAG and SP1. Use FlashLock/UPK1 to allow the digest check.
[ Disable debug access through JTAG (1149.1). Use FlashLodk/UPK1 to allow access.
k.

Figure 149 - Debug Security Policy Dialog Box

Key Mode Policy

Protect user encryption key modes with FlashLock/UPKZ1. If a key mode is disabled, then FlashLock/UPK1 is

required to program with that key mode.
Two key modes can be disabled:

e UEK1 (User Encryption Key 1)

e UEK2 (User Encryption Key 2)

If both key modes are disabled then device update is impossible. A warning message is displayed in this

case.

Note: If a key mode is disabled then the corresponding bitstream file will be disabled.
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" | Programming Key Mode Policy =
Disable Key Mode:

| UEK1 (User Encryption Key 1)

LUEKZ {User Encryption Key 2)

Help . OK Cancel

Figure 15